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 Introduction Familiarity with Microsoft Excel is a requirement for most jobs today. Workers in every office use Excel to track and report information. Sales reps track leads, prospects, commissions, and travel expenses in Excel. Workers on the factory floor log schedules and quality data in Excel. Excel is an amazingly flexible program. A new Excel worksheet offers a seemingly endless blank canvas of rows and columns where you can enter, summarize, and report data of any type. Charts and other data visualization tools can convert a page full of numbers to a visual snapshot. Pivot tables can summarize thousands of detailed records to a one-page summary in a few mouse clicks. If you’ve never opened Excel, or if you’ve used Excel only to neatly arrange lists in columns, this book will get you up to speed with the real-life skills needed to survive in a job that requires familiarity with Excel.
 
 Excel Comes in Many Flavors When a potential employer asks if you know Excel, you need to ask which version of Excel. There are a lot of products available that have Excel in the name, but offer a different subset of commands. • Excel 2010 is the most recent version of the full-featured Excel program. The full version of Excel is what you will find in use in most job environments. • Excel Starter is a new version of Excel that ships with new PCs. This free version of Excel offers the core Excel functionality, such as formatting, formulas, sorting, and filtering. It does not offer advanced commands such as pivot tables. Before 2010, the entry-level spreadsheet program from Microsoft was called Microsoft Works, and it created nonstandard spreadsheet files. The Excel Starter version of Excel can create true Excel files. If you create a file in Excel Starter and send it to someone with Excel 2010, the recipient will be able to open and use the file in Excel 2010. • Excel WebApp is a new browser-based version of Excel. Whereas the browser is great for displaying existing Excel worksheets, the Excel 2010 WebApp allows users to enter new data and formulas in an Excel workbook while online. Those users do not need to have Excel installed on their computers. Mobile workers today might use Excel WebApp to access their Excel data
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 while they are out of the office. You also might expect college students to use Excel WebApp to collaborate on group projects using this free version of Excel. • Excel 2007 is similar to Excel 2010. If you learned how to use Excel 2010 and begin work where the company uses Excel 2007, you will be able to transfer most of your skills. Some new features, such as sparklines, are missing. The File menu offers far fewer choices than the Excel 2010 File menu. (In Excel 2007, the word “File” was replaced with an Office logo inside a round circle in the top-left corner of the program. This was a bad idea and Microsoft went back to the word “File” in 2010.) For the most part, you should find yourself comfortable working in Excel 2007 using the knowledge that you learn about Excel 2010 using this book. • Excel 2003, Excel 2002, Excel 2000, and Excel 97 are collectively known as the legacy versions of Excel. Although the concepts of entering data and formulas in the worksheet are the same, the entire command structure is different in these versions of Excel. Instead of the intuitive Ribbon interface, you will find long text lists of commands organized on menus, such as File, Edit, View, Insert, and so on. Although the menu system is harder to learn, hundreds of millions of people originally learned about Excel using these menus. Nearly half of office computers are still hanging on to their legacy installations of Excel. Be prepared to have a steep learning curve as you try to find where the Excel 2010 commands are located in the old Excel menus.
 
 If this is your first experience with Excel, going to work in an office that is still using Excel 2003 is going to present some frustrations for you and the employer as you try to adjust to the older version of Excel. If the company is still using Excel 2003, it either means that they didn’t have the money to upgrade or that the people at the company are firmly entrenched with and know the old Excel very well. Be up front with your manager. Explain that you learned Excel using Excel 2010. That manager resisted upgrading to Excel 2010 because he or she didn’t want to take the time to get up the learning curve to learn the new Ribbon interface. As someone who learned on Excel 2010, it will be just as intimidating to learn where familiar commands are in the old Excel environment.
 
 This book allows you to customize your own learning experience. The step-by-step instructions in the book give you a solid foundation in using Excel 2010, and rich and varied online content, including video tutorials and audio sidebars.
 
 H ow Th i s B o o k I s O rg a n i ze d
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 How This Book Is Organized This book teaches you the important functions and uses for Microsoft Excel. You should be able to turn to any page and learn a task that will help you in your job using Excel. Additional content, such as video tutorials, demonstrate key concepts. Using Excel 2010 will teach you the following: • How to tell the difference between Excel 2010, Excel Starter, and Excel Web Apps. • How to use the Excel Ribbon Interface. • Faster ways to enter data in Excel. • Formatting your data in Excel. • Entering formulas to perform calculations in Excel. • Using Excel functions to perform special calculations such as loan payments. • How to sort your data so that you can see the earliest, latest, largest, or smallest items at the top of your report. • How to filter your data so that you can find records that match a certain value. • How to summarize data with subtotals or pivot tables. • Creating charts and other visualizations from your data. • Using Excel’s presentation layer to add pictures and diagrams to your reports. • Learn about the macro recorder so that you can start to build new commands in Excel. • Many other tips and tricks to make your use of Excel more efficient. The concepts in this book will allow you to get started by entering data and formulas in Excel. However, the later chapters on pivot tables and charting will provide you with enough advanced techniques to allow you to thrive in any job requiring Excel.
 
 4
 
 Introduction
 
 After you get up to speed with entering data and formulas in Excel, you might have a tendency to leave this book on the shelf. As your experience with Excel grows, you should come back to peruse the later chapters. Remember that there are usually five ways to accomplish every task in Excel. While you could successfully add subtotals to a data set using the formula skills from Chapter 5, “Using Formulas,” there is a good chance that using the Subtotal function from Chapter 9, “Subtotals and Grouping,” will allow you to accomplish the same task in a fraction of the time. Although you might not realize that you have a need for pivot tables at this moment, as you begin doing more tasks in Excel, it is likely that you will discover that Chapter 10, “Pivot Tables,” can dramatically simplify an otherwise tedious task. By revisiting this book once every few weeks, you may discover faster ways to solve real tasks that you encounter at work.
 
 Using This Book This book allows you to customize your own learning experience. The step-by-step instructions give you a solid foundation in using Excel 2010, and rich and varied online content, including video tutorials and audio sidebars, provide the following: • Demonstrations of step-by-step tasks covered in the book • Additional tips or information on a topic • Practical advice and suggestions • Direction for more advanced tasks not covered in the book Here’s a quick look at a few structural features designed to help you get the most out of this book. • Chapter objective—At the beginning of each chapter is a brief summary of topics addressed in that chapter. This objective enables you to quickly see what is covered. • Notes—Notes provide additional commentary or explanation that doesn’t fit neatly into the surrounding text. Notes give detailed explanations of how something works, alternative ways of performing a task, and other tidbits to get you on your way. • Tips—This element gives you shortcuts, workarounds, and ways to avoid pitfalls. • Cross-references—Many topics are connected to other topics in various ways. Cross-references help you link related information, no matter where that information appears in the book. When another section is related to one you are reading, a cross-reference directs you to a specific page in the book on which you can find the related information.
 
 S p e c i a l Fe a t u re s
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 Let Me Try It Tasks are presented in a step-by-step sequence so you can easily follow along.
 
 Show Me Video walks through tasks you’ve just got to see—including bonus advanced techniques.
 
 Tell Me More Audio delivers practical insights straight from the experts.
 
 Special Features More than just a book, your USING product integrates step-by-step video tutorials and valuable audio sidebars delivered through the free web edition that comes with every USING book. For the price of the book, you get online access anywhere with a web connection—no books to carry, content is updated as the technology changes, and you benefit from video and audio learning.
 
 About the USING Web Edition The web edition of every USING book is powered by Safari Books Online, allowing you to access the video tutorials and valuable audio sidebars. Plus, you can search the contents of the book, highlight text and attach a note to that text, print your notes and highlights in a custom summary, and cut and paste directly from Safari Books Online. To register this product and gain access to the free web edition and the audio and video files, go to quepublishing.com/using.
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 This chapter shows you how to customize the ways you interact with and see your work in Excel, both online and on paper.
 
 1
 
 Getting to Know the Excel Interface Customizing the Ribbon When Microsoft released the new Ribbon interface in Excel 2007, users couldn’t make changes to the tabs as they could the menus in legacy Excel. If there was a function you wanted quick access to in Excel 2007, you had to add it to the Quick Access toolbar. With the release of Excel 2010, Microsoft returned the capability to customize the Ribbon. You can modify the existing tabs or create your own.
 
 Removing Default Tabs and Groups You can customize the Ribbon by hiding tabs or removing groups you don’t think you need.
 
 LET ME TRY IT
 
 Hiding a Tab To hide a tab, follow these steps: 1. Right-click any tab and select Customize the Ribbon. 2. The list of existing tabs is on the right side of the Customize the Ribbon dialog (see Figure 1.1). 3. Unselect the tab(s) you want hidden from view and click OK.
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 Figure 1.1 Use the Customize the Ribbon dialog to make changes to the Ribbon.
 
 LET ME TRY IT
 
 Removing a Group You can’t customize the default groups, but you can remove them, making room for your own custom group. To remove a group, follow these steps: 1. Right-click any tab and select Customize the Ribbon. 2. The list of existing tabs is on the right side of the Customize the Ribbon dialog (refer to Figure 1.1). 3. Expand the tab containing the group you want to remove. 4. Select the group to remove and click Remove.
 
 If you remove a group and later decide you want it back, you have two choices: use the Reset option on the Customize the Ribbon dialog, or add the group using the steps from the section “Adding a New Group.”
 
 Creating a Custom Tab The default tabs and groups in Excel may not be the ones best for you or for a particular situation you are working in. You can insert a custom tab into the Main Tabs group or the Tool tabs group. After the tab has been added, you can add the groups and buttons most useful to you.
 
 Cu s to m i z i n g t h e R i b b o n
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 Inserting a New Tab To create a custom tab in Excel to which you can add groups and buttons that you find most useful, follow these steps: 1. Right-click any tab and select Customize the Ribbon. 2. Select where you want your tab to be from the list on the right side of the dialog. The new tab will be placed below your selection. 3. Click New Tab. Excel creates a new tab with a new group, both with (Custom) after the name. 4. Highlight the new group and click Rename to rename the group. 5. Highlight the new tab and click Rename to rename the tab.
 
 Adding a New Group Although not required, grouping similar buttons together can make them easier to find, especially if you’re helping someone else find a specific function. When you create a new tab, Excel automatically adds a new group for you, but you may need another group. A custom group is the only way to add buttons to a default tab. You can also add one of the predefined groups found on the default tabs. These predefined groups are located under the Main Tabs and Tool Tabs commands in the list on the left side of the dialog.
 
 LET ME TRY IT
 
 Adding a Group to an Existing Tab To add a custom group to an existing tab, follow these steps: 1. Right-click any tab and select Customize the Ribbon. 2. In the list on the right side of the dialog, navigate to where you want to add a new group. The new group will be placed below your selection. 3. Click New Group. Excel creates a new group. 4. Highlight the new group and click Rename to rename the group.
 
 Adding a New Button Excel won’t allow you to add a button to any of the default groups, but no such limitations exist for the custom groups you create.
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 LET ME TRY IT
 
 Adding a New Button to a Custom Group To add a new button to a custom group, follow these steps: 1. Right-click any tab and select Customize the Ribbon. 2. In the list on the right side of the dialog, navigate to the custom group where you want to add the new button. The new button will be placed below your selection, as shown in Figure 1.2.
 
 Figure 1.2 Select the command from the list on the left that you want to add to the selected group in the right list box.
 
 3. In the list on the left side of the dialog, find the button you want to add. 4. Click Add to add the button to the group.
 
 Minimizing the Ribbon If you’re working on a system with a small screen, the Ribbon probably takes up too much space. You can minimize the Ribbon, showing only the tab names, as shown in Figure 1.3.
 
 Cu s to m i z i n g t h e Q u i c k Acce s s To o l b a r
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 Figure 1.3 When you minimize the Ribbon, only the tab names are visible. To toggle the Ribbon between being minimized and normal, press Ctrl+F1 on the keyboard or click the up/down arrow by the Help button in the upper-right corner of the screen (see Figure 1.4).
 
 Figure 1.4 Click the arrow by the Help button to minimize the Ribbon. Click it again to make the Ribbon normal again.
 
 Customizing the Quick Access Toolbar The Quick Access toolbar is located in the upper-left corner of Excel, above the Ribbon. It is always visible, even when the Ribbon is minimized and, unlike the Ribbon, the commands aren’t dependent on what you are doing in Excel, such as working with a chart.
 
 Move the Quick Access Toolbar You can move the Quick Access toolbar below the Ribbon by right-clicking the toolbar and selecting Show Quick Access Toolbar Below the Ribbon, as shown in Figure 1.5.
 
 Figure 1.5 You can place the Quick Access toolbar above or below the Ribbon.
 
 Adding Commands to the Quick Access Toolbar Almost any command can be added to the toolbar, and you can also add some selections from within drop-downs.
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 You can customize the Quick Access toolbar in three ways: • Click the drop-down arrow on the right end of the toolbar and select from the predefined commands (see Figure 1.6).
 
 Figure 1.6 The drop-down on the toolbar offers some predefined commands you can use to customize your Quick Access toolbar
 
 • Right-click a button on the toolbar and select Customize Quick Access Toolbar to bring up the Customize the Quick Access Toolbar dialog shown in Figure 1.7.
 
 Figure 1.7 Customize the Quick Access toolbar through the Customize the Quick Access Toolbar dialog.
 
 Cu s to m i z i n g t h e Q u i c k Acce s s To o l b a r
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 • Right-click a command or drop-down item in the Ribbon, as shown in Figure 1.8. If the option Add to Quick Access Toolbar appears, select it to add the item to the toolbar
 
 Figure 1.8 If you see Add to Quick Access Toolbar when you right-click a Ribbon item, the command can be added to the Quick Access toolbar.
 
 SHOW ME
 
 Media 1.1—Adding a Command to the Quick Access
 
 Toolbar You can watch a free video of this task when you log on to my.safaribooksonline. com/9780132182287/media.
 
 LET ME TRY IT
 
 Adding a Command to the Quick Access Toolbar Follow these steps to add a command to the Quick Access toolbar: 1. Right-click a button on the toolbar and select Customize Quick Access Toolbar. 2. Navigate the list on the left side of the dialog box to find the command you want to add to the toolbar. 3. Select the Command and click Add to copy the command over to the Quick Access toolbar.
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 Customizing the Quick Access Toolbar for the Current Workbook You can add commands to the Quick Access toolbar that will appear only when a specific workbook is open. This can be especially useful if your workbook contains macros you want to activate with buttons.
 
 LET ME TRY IT
 
 Add a Macro Button That Appears Only in the Current Workbook Follow these steps to add a macro button to the Quick Access toolbar that only appears when the current workbook is open: 1. Right-click a button on the toolbar and select Customize Quick Access Toolbar. 2. Select the current workbook from the drop-down on the right side of the dialog, as shown in Figure 1.9.
 
 Figure 1.9 Select the workbook you want the custom button for.
 
 3. Select Macros from the drop-down on the left side of the dialog. 4. Select the macro you want to assign to the toolbar and click Add. 5. With the macro selected in the list on the right side of the dialog, click Modify.
 
 Dialog Launchers
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 6. Select a Symbol for the button and change the Display Name that will appear when the cursor hovers over the button. Click OK. 7. Your custom macro button will appear in the toolbar, as shown in Figure 1.10.
 
 Figure 1.10 Add a command that appears only with the current workbook.
 
 Removing Commands from the Quick Access Toolbar You can remove a command from the Quick Access toolbar in three ways: • Click the drop-down arrow on the right end of the toolbar and deselect the command from the list of predefined commands. • Right-click any button on the toolbar or Ribbon and select Customize Quick Access Toolbar to bring up the Customize the Quick Access Toolbar dialog. Select the command from the list on the right side of the dialog and click Remove. • Right-click the command button itself in the Quick Access toolbar and select Remove from Quick Access Toolbar.
 
 Dialog Launchers In legacy Excel, when you selected a menu option, such as File, Format Cells, a dialog would appear for you to interact with. With the Ribbon, many, but not all, of the options from the dialog appear on a Ribbon. It can be frustrating trying to find one of those missing commands. You can find the other commands that you knew were with it in legacy Excel, but it’s not in that group on the Ribbon. You could customize the Ribbon to show the command you are looking for, but there may be another way. Some groups on the Ribbon have a little extra image in the lower-right corner, as shown in Figure 1.11. Click that little arrow, and the dialog you were used to from legacy Excel will appear.
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 Figure 1.11 Interact with the dialogs you used in legacy Excel to avoid some of the frustration of hunting down hard-to-find or missing commands.
 
 Zoom The capability to zoom in and out on a sheet is an often-forgotten functionality in Excel. Instead, large fonts are used when designing a sheet; then the designer later wonders why problems occur, such as the validation text being too small to see. Instead of relying on font size to make text on the sheet larger, zoom in on the sheet. You can use three ways to change the zoom on a sheet: • View, Zoom—On the View tab, the Zoom group contains three options for zooming on a sheet: • Zoom—Brings up the Magnification dialog. • 100%—Sets the zoom to 100%. • Zoom to Selection—Zooms in on the selected range. • Wheel Mouse—While holding down the Ctrl key, use the scroll button on your mouse to zoom in and out. • Zoom Slider—In the lower-right corner of the Excel window is the Zoom Slider, shown in Figure 1.12. You can use the slider or the - and + buttons to change the zoom of the active sheet.
 
 Pa g e B re a k Pre v i e w
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 Figure 1.12 The Zoom Slider is a new way of zooming in and out on a sheet.
 
 Page Break Preview With Page Break Preview, you can see where columns and rows will break to print onto other pages. Dashed lines signify automatic breaks that Excel places based on settings, such as margins. Solid lines are manually set breaks.
 
 LET ME TRY IT
 
 Changing a Page’s Column Break Follow these steps to change the location of a column break: 1. Select Page Break Preview from the View tab. 2. Place your cursor over the blue column line you want to move until it becomes a double arrow, as shown in Figure 1.13.
 
 Figure 1.13 Place your cursor over the dashed blue line so it becomes a double arrow. 3. Hold down the left mouse button and move the blue line to where you want the column break to be. 4. Release the mouse button. The dashed blue line becomes a solid blue line, as shown in Figure 1.14.
 
 Figure 1.14 After you’ve moved the automatically set column break, it changes from a dashed line to the solid line of a manually set break.
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 Page Layout The Page Layout viewing mode is like an editable Print Preview—you can see what your page will look like when it prints out, but you can still enter data and make other changes. Columns and rows will move between pages as you adjust their widths or the margins of the page. You can also enter information directly into the header and footer of a page.
 
 LET ME TRY IT
 
 Inserting the Filename and Date into the Header Follow these steps to enter the filename in the left header and date in the right header while in Page Layout view mode: 1. Go to View, Page Layout. 2. Move your mouse to the top of the page where it says Click to Add Header. As you move your mouse left and right, the different parts of the header will be highlighted, as shown in Figure 1.15
 
 Figure 1.15 You can edit the header directly while in Page Layout mode.
 
 3. Click the left header field. 4. Go to Header & Footer Tools, Design and select File Name. The code for File Name, &[File], will be placed in the header field. 5. Click the right header field. 6. Go to Header & Footer Tools, Design, and select Current Date. The code for Current Date, &[Date], will be placed in the header field. 7. Click anywhere on your sheet to leave the header. The codes will update to show the actual filename and date (see Figure 1.16)
 
 Pa g e N u m b e r i n g
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 Figure 1.16 Insert the file name and date in the header.
 
 Page Numbering Page numbering is set up in the header or footer of a sheet. To access the Page Setup dialog, go to File, Print and click the Page Setup link at the bottom of the Settings or go to the Page Layout tab and click the dialog launcher in the lower right corner of the Page Setup group, circled in Figure 1.17. From the Page Setup dialog, select the Header/Footer tab. When you customize the header or footer, the options for inserting page numbering will be available.
 
 Figure 1.17 Use the dialog launcher (circled) to open the Page Setup dialog and access the Header/Footer dialog to insert page numbering.
 
 LET ME TRY IT
 
 Inserting Page of Pages Page Numbering To insert page numbering based on the total number of pages, follow these steps: 1. Go to Page Layout, Page Setup and click the dialog launcher in the lowerright corner of the group.
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 2. Select the Header/Footer tab from the Page Setup dialog. 3. Click Custom Header or Custom Footer. 4. From the Header or Footer dialog that appears, place your cursor in the section you want the page numbering to appear. 5. Click Insert Page Number, which is the second button. 6. Type “of” (space of space). 7. Click Insert Number of Pages, which is the third button. 8. Click OK twice
 
 Repeating Rows or Columns When Printing When you have a report that spans several pages, you probably want to repeat your row or column headers on all the pages.
 
 LET ME TRY IT
 
 Repeating a Header Row Follow these steps to have your header row repeat at the top of each printed page: 1. Go to Page Layout, Print Titles. 2. Click the Collapse Dialog button on the far right side of the Rows to Repeat at Top field. This minimizes the dialog and allows you to interact with the sheet. 3. Select the row(s) you want to repeat by clicking the numbered row header(s). 4. Click the button on the far right side of the Rows to Repeat at Top field to return to the dialog. 5. Click OK. The selected row(s) will now repeat at the top of each printed page.
 
 Freezing Panes If you’ve set up your data in a Table, Excel places the headers into the column headings when you scroll down the sheet, as shown in Figure 1.18. But normally, when you scroll through a sheet, your row and column headers disappear. This can be
 
 Fre e z i n g Pa n e s
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 inconvenient when you have a lot of data and need the identifying headers. With the Freeze Panes options, you can force the top rows, leftmost columns, or both to remain visible as you scroll around the sheet.
 
 Figure 1.18 Table column headers become part of the column headings so that they are always visible when you scroll down the sheet.
 
 Three options are available under Freeze Panes: • Freeze Panes—Rows and/or columns are frozen depending on the cell you have selected at the time. This option changes to Unfreeze Panes if any rows or columns are already frozen. • Freeze Top Row—Freezes the first visible row of the sheet. • Freeze First Column—Freezes the first visible column of the sheet.
 
 When using Freeze Top Row or Freeze First Column, the selection of one will automatically undo the selection of the other. So, if you want to freeze the top row and first column, you must use Freeze Panes.
 
 SHOW ME
 
 Media 1.2—Freezing Columns You can watch a free video of this task when you log on to my.safaribooksonline. com/9780132182287/media.
 
 LET ME TRY IT
 
 Freezing Columns and Rows at the Same Time To freeze columns and rows at the same time, follow these steps: 1. Select the leftmost and topmost cell that you do NOT want frozen.
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 2. On the View tab, select Freeze Panes, Freeze Panes.
 
 Working with Custom Views Custom Views allow you to save the way you have a workbook set up. The hidden rows and columns, filter settings, and print settings are all saved, making it easy to switch between Data Entry mode, which shows all your data, and a Presentation mode, which hides your calculation columns and rows.
 
 Custom views will not work if there’s a Table in the workbook.
 
 LET ME TRY IT
 
 Creating a Custom View of Filtered Data Follow these steps to create a custom view with a preset filter: 1. Select a cell in your data. 2. Go to Data, Filter. 3. Set up the filters the way you want them. 4. Go to View, Custom Views, and click Add. 5. Enter the name of the view in the Name field. 6. Deselect Print Settings if you do not want the print setup saved with the view. 7. The next time you want to view your data in this configuration, go to View, Custom Views, select the view from the list, and click Show.
 
 You may want to add an All Data view to quickly return to a clean sheet.
 
 A r r a n gi n g Wi n d ows
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 Arranging Windows Excel offers two methods for viewing data side by side In the Window group on the View tab, Arrange All opens the Arrange Windows dialog, allowing you to arrange all the current windows in a Tiled, Horizontal, Vertical, or Cascade View. In Excel 2007, View Side by Side was introduced to users. It provides a quick way of viewing two windows horizontally. You can then select Synchronous Scrolling to lock the scrollbars together and move the data on both sheets at the same time.
 
 Inserting Rows & Columns To insert a new row or column within an existing dataset, select the row or column where you want the insert to go and go to Home, Cells. From the Insert drop-down select to Insert Sheet Rows or Insert Sheet Columns. For a shortcut, you can rightclick on the row or column header and select Insert, as shown in Figure 1.19.
 
 Figure 1.19 To insert a new row 10, right-click on the row header (the 10) and select Insert from the menu. The current row 10 and all the data after it will shift down.
 
 If you don’t have the entire row or column selected, Excel will display the Insert dialog, prompting you to specify whether you want to shift the selected cells right or down, or if you want to insert an entire row or column.
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 Inserting a Row To insert a new row within an existing dataset, follow these steps. To insert the row through the Ribbon options, start at step 3, else continue to step 1 to insert a row using the right-click option. 1. Right-click over the row number’s header where you want to insert a blank row. In Figure 1.19, a blank row will be inserted in row 10, so the cursor is placed over the header 10. 2. Select Insert. The new row is inserted and the existing data moved down. 3. To insert a row through the Ribbon options, select a cell in the row where you want a new blank row to be inserted. 4. Go to Home, Cells, Insert and select Insert Sheet Rows. The new row is inserted and the existing data moved down.
 
 Renaming a Sheet To rename the active sheet, go to Home, Cells, Format and select Rename Sheet from the drop-down. Excel will select the current sheet name in the sheet’s tab and you can then type in the new name. You can also rename a sheet by right-clicking on a sheet’s tab and selecting Rename.
 
 Moving or Copying Sheets You can reorganize sheets within the current workbook or move them to a new workbook using the Move or Copy Sheet option found under Home, Cells, Format. The dialog can also be accessed by right-clicking on a sheet tab, as shown in Figure 1.20.
 
 Figure 1.20 Use the Move or Copy dialog, quickly accessed by right-clicking on a sheet tab, to move or copy sheets within a workbook or to a new workbook.
 
 C h a n g e M u l t i p l e Wo r k s h e e t s a t O n e Ti m e
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 Within the Workbook To move or copy the active sheet to a new location within the same workbook using the Move or Copy dialog, make sure the To Book field is the current workbook. If you’re making a copy of the sheet, check the Create a Copy box. Then, in the Before Sheet dialog, select the sheet you want the active sheet to be placed in front of (to the left of ). You can also reorganize the sheets in a workbook by clicking and dragging the sheet’s tab to a new location. If you want to copy the sheet, hold down the Ctrl key as you move the sheet tab.
 
 Between Workbooks To move or copy a sheet to another workbook, the second workbook must already be open. Then, using the Move or Copy dialog, select the workbook to move or copy the sheet to from the To Book field. If you’re making a copy of the sheet, check the Create a Copy box. In the Before Sheet dialog, select the sheet you want the active sheet to be placed in front of (to the left of ). When you move or copy a sheet from one workbook to another, any formulas on that sheet linked to the original workbook will remain linked.
 
 LET ME TRY IT
 
 Copying a Sheet to a New Workbook To copy a sheet to a new workbook, follow these steps: 1. Open both workbooks. 2. Go to the sheet you want to copy. 3. Go to Home, Cells, Format, Move or Copy. The Move or Copy dialog appears. 4. In the To Book field, select the workbook to copy the sheet to. 5. Check the Create a Copy button. 6. Select the sheet you want to copy the sheet in front of (to the left of ). 7. Click OK.
 
 Change Multiple Worksheets at One Time You can change the exact same range on multiple sheets at a time by grouping the sheets and making the change to one of the sheets. For example, you can enter the
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 word “Sales” in A1 of all the selected sheets. Or you can apply a bold format to cell C2 in a group of sheets. To group sheets together, select one sheet that will be in the group, then, while holding down the Ctrl key, select the other sheets. To ungroup the sheets, either select a sheet not in the group, or right-click on any sheet tab in the group and select Ungroup Sheets.
 
 LET ME TRY IT
 
 Changing Multiple Sheets To make a change to multiple sheets by just changing one sheet, follow these steps: 1. Go to one of the sheets you need to change. 2. While holding down the Ctrl key, select the sheet tabs of the other sheets you want to make the same change to. This will group the sheets together. 3. Make the changes to the active sheet. 4. To ungroup the sheets, select a sheet not in the group, or right-click on a sheet tab and select Ungroup Sheets.
 
 Setting Workbook and Sheet Protection Depending on what part of a workbook you want to protect from changes, you should protect the workbook or the worksheet.
 
 Setting Workbook Protection Protecting a workbook prevents users from adding, deleting or moving sheets. It can also prevent the user from resizing the workbook, though you can still resize the Excel window. To protect a workbook, go to Review, Protect Workbook. There are two options available: • Structure—Prevents users from adding, deleting, hiding, unhiding, moving, renaming, inserting or copying sheets. • Windows—Prevents the user from moving or resizing windows of the workbook. If you want, you can also enter a password. You will have to enter it twice.
 
 R e ce n t D o c u m e n t s
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 Setting Sheet Protection Protecting a sheet prevents users from changing the content of locked cells. By default, all cells have the locked option selected and you purposefully unlock them. Sheet protection must be applied to each sheet individually. To protect a sheet, go to Home, Format, Protect Sheet. The Protect Sheet dialog will appear from which you can select what actions a user can do to the sheet. You can also enter a password. You will have to enter it twice.
 
 Unlocking Cells While a sheet is still unprotected, you can unlock specific cells so that when the sheet is protected, users can still enter information in the cells you want. To change the protection of selected cells, go to Home, Cells, Format, Format Cells. In the Format Cells dialog, go to the Protection tab and unselect the Locked option.
 
 Recent Documents Under File, Recent, you can see the last several workbooks that were opened. The number of workbooks listed is an option set under File, Options, Advanced, Display, Show This Number of Recent Documents. To the right of each listed workbook is a stickpin. The pin is gray when not in use, but select a pin and it will change color, direction, and be moved to the top section of the list, as shown in Figure 1.21. A workbook with a colored pin is stuck—that is, the workbook will not be removed from the list of recent documents until you unstick it by clicking the pin again.
 
 Figure 1.21 You can stick the workbooks you use often and place them at the top for easy opening.
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 Saving as PDF Even with the ease of sharing workbooks using Excel Web Apps, PDFs are still a great option because they don’t require a connection to the Internet, and users don’t have access to your workbook. You can create a PDF from within Excel simply by saving your workbook. PDF is now a file type in the Save as Type drop-down of the Save As dialog. After you select the Save as Type, you can choose from a variety of options, as shown in Figure 1.22.
 
 Figure 1.22 You can choose from a variety of options when saving your workbook as a PDF.
 
 Opening Templates Templates are a great way for keeping data in a uniform design. You could simply design your workbook and re-use it as needed, but if you accidentally save data before you have renamed the file your blank workbook is no longer clean. When using a template, there’s no risk of saving data in the template because you are working with a copy of the original file, not the file itself. There are two possible meanings to the words “opening a template.” Depending on what you want to do with the template, the methods for opening the file differ: • Open a template copy for creating a new workbook. • Double-click the file from its saved location. • Right-click the file and select New. • Go to File, New, and select the template from the list of templates. If the template isn’t listed, select New from Existing and browse to the template.
 
 Tro u b l e s h o o t i n g E xce l O p t i o n s
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 • Open the template original to make changes. • Right-click the file and select Open. • Go to File, Open.
 
 Troubleshooting Excel Options Nothing is more frustrating than opening Excel and finding out something strange has happened to the way Excel works. Table 1.1 reviews possible scenarios and the settings under File, Options that could be the source of the problem. Table 1.1 Possible Situations and Solutions Situation
 
 Check This Setting
 
 The minitoolbar is missing or you need to hide the minitoolbar.
 
 General, User Interface Options, Show Mini Toolbar on Selection
 
 Column headings A, B, C have been replaced with 1, 2, 3.
 
 Formulas, Working with Formulas, R1C1 Reference Style
 
 You are unable to drag cell contents; the Fill handle is gone.
 
 Advanced, Editing Options, Enable Fill Handle, and Cell Drag-and-Drop
 
 You are unable to edit directly in a cell; you can edit only in the formula bar.
 
 Advanced, Editing Options, Allow Editing Directly in Cells
 
 AutoComplete no longer appears when you enter data in a cell.
 
 Advanced, Editing Options, Enable AutoComplete for Cell Values; also ensure there are no blank rows separating your new entry and previous entries
 
 Instead of moving the sheet up/down when you scroll the mouse, the sheet zooms in/out. You want the sheet to zoom in/out when you use the wheel on the mouse.
 
 Advanced, Editing Options, Zoom on roll with the IntelliMouse
 
 Multiple workbooks are open, but only one Excel item shows in the task bar.
 
 Advanced, Display, Show All Windows in the Taskbar
 
 The formula bar has disappeared, or you want to hide the for- Advanced, Display, Show Formula Bar or View tab, Formula mula bar. Bar Instead of the calculated values, the formulas are showing in the cells.
 
 Advanced, Display Options for This Worksheet, Show Formulas in Cells Instead of Their Calculated Results or press Ctrl+~
 
 When you double-click to open a workbook, Excel opens, but remains blank.
 
 Advanced, General, Ignore Other Applications That Use Dynamic Data Exchange (DDE)
 
 This page intentionally left blank
 
 This chapter shows you how to upload and download workbooks to and from the Windows SkyDrive.
 
 2
 
 Introducing the Excel Web App This chapter will help you get started working on and sharing your Excel files online. For a more in-depth coverage of Microsoft Office Web Apps and using SkyDrive, refer to Using the Microsoft Office Web Apps (ISBN 0-7897-4486-4) by Paul McFedries.
 
 Requirements You don’t need much to get started with the Excel Web App: • A current browser (minimum: Internet Explorer 7, Mozilla Firefox 3, or Safari 3) • A Windows Live ID • An Internet connection With these three items, you can view your Excel workbooks anywhere in the world where you can access Windows Live.
 
 Acquiring a Windows Live ID With a Windows Live ID, you can access the Windows Live SkyDrive online storage where you can store, view, edit, and share your Excel workbooks.
 
 You don’t need a Windows Live ID if you are accessing someone else’s SkyDrive and it’s set up to not require a login. But if you want to upload your own files or access a SkyDrive requiring login, you will need a Windows Live ID.
 
 SHOW ME
 
 Media 2.1—Creating a Windows Live ID You can watch a free video of this task when you log on to my.safaribooksonline. com/9780132182287/media.
 
 32
 
 Chapter 2
 
 |
 
 I nt ro d u c i n g t h e E xce l We b A p p
 
 LET ME TRY IT
 
 Creating a Windows Live ID A Windows Live ID enables you to log in to a variety of websites, such as Windows Live, Hotmail, and Xbox Live, using one account. If you already log into a Microsoftowned site, it is possible you already have a Windows Live ID. You can create the account using an existing email address or obtain a new email address through the live.com or hotmail.com domains, as shown in Figure 2.1. Follow these steps to create a Windows Live ID: 1. User your browser to navigate to https://signup.live.com. If you don’t see a webpage similar to the one in Figure 2.1, it’s possible you already have a Windows Live ID. In that case, you may see a page similar to Figure 2.2 with your login name in the upper-right corner. If that’s the case, you don’t need to create a Windows Live ID because you already have one.
 
 Figure 2.1 Go to https://signup.live.com to create your Window Live ID account.
 
 Acq u i r i n g a Wi n d ows L i ve I D
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 2. If you have an existing email address you want to use, type it into the Use Your E-Mail Address field, press the Tab key, and skip to step 6. Otherwise, click the Or Get a Windows Live E-Mail Address link to create a new email address and continue to step 3. 3. In the Windows Live ID domain list drop-down, select the domain you want to have the address for (live.com or hotmail.com). 4. In the Windows Live ID text field, type the username you want. 5. Click Check Availability to see if your username and domain combination is available. 6. If Windows Live informs you that the ID isn’t available, repeat steps 3–5; otherwise, if the ID is available, continue to step 7. 7. Type your password into the Create a Password field. 8. Type the same password again into the Retype Password field. 9. If you aren’t using an existing email address to create the Live ID account, tell Windows Live what you want to do in case you forget your password: • Use the Alternate E-Mail Address if you want Windows Live ID to email you password reset information. The email address must be different from your Windows Live ID. • Select the Or Choose a Security Question for Password Reset link if you want to verify your identity online. Select a predefined question from the Question list and enter the correct response in the Secret Answer field. The response must be at least five characters. 10. Fill in the rest of the requested information: name, location, gender and birth year. 11. In the Characters field, type the characters you see in the image. 12. Click I Accept. Windows Live will create your new ID.
 
 Uploading and Downloading Workbooks You no longer have to remember to move those important files to a USB flash drive and have that flash drive with you. From almost anywhere in the world, you can handle your boss’s desperate call to fix the department budget numbers for his 11 A.M. presentation to corporate. All you need is a computer with access to the
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 Internet. After you’ve logged into your Windows Live account, you can upload your own workbooks or create new ones for viewing, editing, and sharing.
 
 Only unprotected workbooks can be opened online.
 
 Accessing the SkyDrive You can sign into your Windows Live account from any site that supports the accounts, such as MSN.com or Bing.com, but to quickly get to your SkyDrive, go to skydrive.live.com. After you’re signed in, you’re brought to your SkyDrive.
 
 If you don’t see your SkyDrive, select More, SkyDrive from the Windows Live page as shown in Figure 2.2.
 
 Figure 2.2 Choose More, SkyDrive to access your SkyDrive from anywhere in Windows Live.
 
 Uploading with Windows Live You can upload a workbook viewable by just you, selected individuals, your network, or everyone. The folder where you place the workbook determines this viewing level. After it is uploaded, you can view, edit, and share the workbook.
 
 U p l o a d i n g a n d D ow n l o a d i n g Wo r k b o o k s
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 Uploading a Workbook Follow these steps to upload your workbook: 1. Select the folder to which you want to add your workbook. Note that the Favorites and Shared Favorites folders aren’t used for file sharing, but for website shortcuts. 2. Select Add Files, shown in Figure 2.3
 
 Figure 2.3 Select Add Files to select files to upload to SkyDrive. 3. Browse to the location of the file you want to upload and select it. 4. Click Open. 5. Click Upload to upload the file to your SkyDrive.
 
 Saving to SkyDrive from Excel Save a file from Excel directly to your SkyDrive by choosing File, Save & Send, Save to Web. Excel attempts to log you in automatically, but if it can’t, click the Sign In button, shown in Figure 2.4, to bring up the .NET Passport Wizard, which will take you through the steps to associate your Windows Live ID to your Windows User Account. After following the wizard the first time, you will always be linked to your SkyDrive.
 
 TELL ME MORE
 
 Media 2.2—SkyDrive
 
 You can listen to a free audio recording about the usefulness of SkyDrive, even if the computer you are at does not have Excel installed. When you log on to my.safaribooksonline.com/9780132182287/media.
 
 36
 
 Chapter 2
 
 |
 
 I nt ro d u c i n g t h e E xce l We b A p p
 
 Figure 2.4 Upload the active workbook to SkyDrive directly from Excel.
 
 Creating a New Workbook You aren’t limited to workbooks created previously in Excel on your desktop. You can create a new workbook online and download it when you return to the office.
 
 LET ME TRY IT
 
 Creating a New Workbook To create a new workbook on your SkyDrive, follow these steps: 1. Click the folder you want the workbook in. 2. Click New, Microsoft Excel Workbook (see Figure 2.5).
 
 Figure 2.5 Create a new workbook directly online. 3. Enter the name of the workbook and click Create. Windows Live automatically appends the file extension (xlsx) for you.
 
 U p l o a d i n g a n d D ow n l o a d i n g Wo r k b o o k s
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 Opening a Workbook When you select a folder, you’ll see all the workbooks in the folder. Select a workbook to see the available options. When you select to View a workbook, it’s opened as a read-only file. Unlike readonly mode on the desktop version of Excel, where you can make changes and not save them to the original file, you cannot make changes while in View mode. You can only look at the workbook, as shown in Figure 2.6.
 
 Figure 2.6 The View option opens a workbook in Read-only mode with a limited ribbon. Select Edit to access the full Excel Web App functionality and make changes to a workbook, as shown in Figure 2.7. Changes are automatically saved as they are made.
 
 Figure 2.7 Open a workbook using the Edit option to access all editing features.
 
 Saving a File to Your Local Drive Eventually, you will want to work on a workbook saved locally. This can be done in several ways: • Before you open the workbook, select Download from the menu. • While viewing or editing the workbook, select the File tab to reveal the following options (see Figure 2.8): • Open in Excel—Open the workbook locally in Excel. • Download a Snapshot—Download a copy of the workbook containing only its values, formatting, and charts. • Download a Copy—Download the entire workbook.
 
 The options Save As and Save a Copy create an online copy of the workbook with a new name in the same folder as the original.
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 Edit Mode
 
 View Mode
 
 Figure 2.8 Options under the File menu allow you to download the file to work on locally.
 
 Sharing a Workbook SkyDrive doesn’t just provide you with the convenience of being able to work with your workbooks wherever you are. It’s also set up to help you share your workbooks with other people.
 
 Creating a New Folder When you create an account, SkyDrive provides two folders for storing your documents: My Documents, a protected folder only you can access, and Public, a folder available to anyone. You cannot change the permissions of these two folders, but you can create new folders and set the permissions you want for them.
 
 LET ME TRY IT
 
 Creating a New Folder To create a folder from your SkyDrive main page, follow these steps: 1. Select Create Folder. 2. Enter the name of the folder in the Name field
 
 S h a r i n g a Wo r k b o o k
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 3. Choose who you want to share the folder with: Everyone (Public), My Network, Just Me, Select People (see Figure 2.9).
 
 Figure 2.9 When creating a new folder online, you can choose who you want to be able access it.
 
 4. Click Next, and you have the option of uploading new files or clicking Cancel to add files at a later time.
 
 Setting Folder Permissions When you created the preceding folder, Windows Live provided the basic permission settings. For the additional options shown in Figure 2.10, choose More, Edit Permissions while viewing the contents of a folder: • Public and Networks—Select Everyone (Public) and anyone can view the contents of the folder. Select My Network and you can choose between Can View Files if network members can only view your files or Can Add, Edit Details, and Delete Files to give members full permission to modify your folder contents. When you choose My Network, you can also select My Extended Network, allowing networks of your networks (friends of your friends) to View the contents of the folder. • Categories—A listing of the available categories. Select the category and choose Can View Files to allow members to only view files or choose Can Add, Edit Details, and Delete Files to give members full permission to modify your folder contents. • Individuals—Share the folder with select individuals. For each name or email address entered, you can choose to allow the individual to only view files (Can View Files) or give full access to the folder (Can Add, Edit Details, and Delete Files).
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 Figure 2.10 The Dept. Budget folder is configured to allow anyone to view the files, but people in the Excel People custom category can also edit details.
 
 Simultaneous Editing If you’re allowing others to edit your workbook, eventually you will be editing the workbook at the same time as another person. When you are the sole person editing the workbook, the text in the lower-right corner of your browser window reads 1 Person Editing. If other people are editing at the same time, the text will update to reflect the number of people. To see who else is in the workbook with you, click the arrow and a window will open up, showing everyone in the workbook, including you, as shown in Figure 2.11.
 
 Figure 2.11 You can see who else is editing the workbook with you.
 
 I nte r a c t i n g w i t h a S h e e t O n l i n e
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 Because changes to workbooks are automatically saved, you can see what the other person is doing almost right away. There is no hierarchy of permissions or way to verify changes, so another user can change your changes as quickly as you can make them.
 
 Interacting with a Sheet Online Even though the page in your browser looks a lot like the desktop version of Excel, it’s not. It’s still just a web page, and the navigation methods you’re used to from desktop Excel won’t work. The following navigation methods do not work in the Excel Web App: • There’s no right-click context menu. • There’s no fill handle, so you can’t drag to fill in a series or copy formulas. • You can’t double-click to autofit rows or columns. • You can’t double-click a cell to edit it. You’ll have to make changes directly in the formula bar. • If you have data/text in one cell bleeding into the one next to it, you can’t select the other cell until you make the first column wide enough so it doesn’t overlap into the other column. • You can’t click and drag to move cells, rows, or columns. The following methods still work in the Excel Web App: • Keyboard shortcuts • Adjusting the row and column widths manually • Dragging to select a range • Clicking row and column headings to select the entire row or column
 
 This page intentionally left blank
 
 This chapter shows you tricks for quickly entering data and fixing data that doesn’t look right.
 
 3
 
 Entering Data in Excel Data entry is one the most important functions in Excel—and one of the most tedious, especially when the data is repetitive. This chapter will show you tricks for copying down data, fixing entered data, and helping your users enter data correctly by providing a predefined list of entries.
 
 Dragging the Fill Handle to Extend a Series The fill handle, shown in Figure 3.1, can speed up data entry by completing a series for you. Excel comes with several preconfigured series, such as months, days of week, and quarters. You can also add your own series, as described in the “Creating Your Own Series” section later in this chapter.
 
 Fill Handle
 
 Figure 3.1 Use the Fill Handle to quickly fill in a series.
 
 SHOW ME
 
 Media 3.1—Using the Fill Handle to Fill in a Series You can watch a free video of this task when you log on to my.safaribooksonline.com/9780132182287/media.
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 Extending a Series Containing Text To extend a series containing text, enter the text you want the series to start with and drag the fill handle. You don’t need to start at the beginning of the series. You can start anywhere in the series and Excel will continue it, starting over if you drag the handle long enough. For example, if you begin a series in A1 with Sunday and drag the fill handle to A8, Sunday will appear again, repeating the series. If the text series contains a numerical value, Excel will also extend the numerical portion.
 
 Extending a Numerical Series If you try to fill numerical series based off of a single cell entry, Excel will copy the value instead of filling the series. There are four ways to get around this: • Enter at least the first two values of the series before dragging the fill handle. • Hold down the Ctrl key while dragging the fill handle. • If there is a blank column to the left or right of the numerical column, include that column in your selection when dragging the fill handle down. For example, if you enter 1 in A1 then select A1:B1 (B1 is blank), when you drag the fill handle down, the series in column A will be filled down. • Hold the right mouse button down while dragging the fill handle and select Fill Series from the context menu that appears when you release the mouse button.
 
 If you hold the Ctrl key while trying to extend a text series, Excel will copy the values instead of filling in the series.
 
 Creating Your Own Series You can teach Excel the lists that are important to you so that you can take advantage of the series capabilities in Excel. You can take almost any list of items on a sheet and create a custom list for use in filling or sorting.
 
 J o i n i n g Te x t
 
 LET ME TRY IT
 
 Creating a Custom List Follow these steps to create a custom list: 1. Create your list on the sheet and select the range. 2. Go to File, Options, Advanced, General, Edit Custom Lists. 3. The range you selected is already in the Import List from Cells field, so click Import. 4. The list will be added to both the Custom Lists and List Entries list boxes, as shown in Figure 3.2. The next time you type an item from your list and drag the fill handle, Excel will fill in the rest of the series for you.
 
 Figure 3.2 Create a custom list for use in filling in series. Unlike the built-in text series, if you include a number with your custom list and extend the series, Excel will copy the text entered and extend only the numerical value.
 
 Joining Text You can create a formula to join text values from separate columns into another column using the ampersand (&) to link the values together. You can also include additional characters, such as a space, to separate the two values.
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 Joining a First Name and Last Name Follow these steps to join a first name from one column and a last name from another column as the full name in the third column: 1. Type an equal sign in the cell where you want the full name to appear. 2. Select a cell from the first name column. 3. Type & “” &. Note that there is a space between the double quotes. 4. Select a cell from the last name column. Make sure the selection is in the same row as the cell selected in step 2. 5. Press Enter. You should have a formula similar to what’s shown in the formula bar in Figure 3.3.
 
 Figure 3.3 Use & to join text from multiple columns.
 
 Joining Dates and Text In Excel, dates are stored as serial numbers. So when you type in a date, such as 4/4/2010, you may see the date like this, but in reality, Excel is storing 40272. If you were trying to join text from a cell containing a date, instead of “Today is 4/4/2010,” you would get “Today is 40272.” To get the actual date to appear, wrap the TEXT function around the date. For the example of 4/4/2010, the function would be TEXT(TODAY(), “mm/dd/yyyy”), as shown in Figure 3.4. The TEXT function converts a value to text in the specified number format. It has two arguments. The first argument is the cell containing the numerical value; the second argument is the number format you want applied to the number.
 
 Fi x i n g N u m b e r s a s Te x t
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 Figure 3.4 Use the TEXT function to join text and dates.
 
 Fixing Numbers as Text When numbers in a sheet are being stored as text, Excel lets you know by placing a green triangle in the cell (if Background Error Checking is enabled). When you select the cell and click the warning sign that appears, Excel informs you that the number is being stored as text, as shown in Figure 3.5. It then gives you options for handling the number, such as Convert to Number or Ignore Error.
 
 Figure 3.5 With Background Error Checking enabled, Excel will inform you if a number is being stored as text.
 
 Background Error Checking is found under File, Options, Formulas.
 
 If you have a worksheet with thousands of cells, it will take a long time to convert them all to numbers. Two options for doing a larger-scale conversion are covered in the next sections. If you are using normal Excel, you have a third option available, which is discussed in the “Using Text to Columns to Convert Text to Numbers” section.
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 LET ME TRY IT
 
 Using Convert to Number on a Range Here’s one option for converting multiple cells into numbers: 1. Select the range consisting of all the cells you need to convert (making sure that the first cell in the range needs to be converted). The range can include text and other numerical values, as long as it doesn’t include cells you do not want to be converted to numbers. 2. Click the warning symbol in the first cell. 3. From the drop-down, select Convert to Number, and all cells in the selected range will be modified.
 
 LET ME TRY IT
 
 Using Paste Special to Force a Number If you have the Background Error Checking disabled and don’t see the green warning triangle, try this method for converting cells to numbers: 1. Enter a 1 in a blank cell and copy it. 2. Select the cells containing the numbers, right-click and select Paste Special, Paste Special. 3. From the dialog that appears, select Multiply and click OK. The act of multiplying the values by 1 forces the contents of the cells to become their numerical values.
 
 You can also copy a blank cell and use the Add function.
 
 Convert Text Case Although Excel doesn’t provide the ease Word does in changing the case of selected text, the capability is there in the form of functions: • PROPER—Convert the text to proper case. This doesn’t work well with names such as “McCartney”—Excel will return “Mccartney” instead, in which case you
 
 Co py i n g Fo r m u l a s R a p i d l y
 
 49
 
 can use PROPER and then use a Find & Replace of the text “Mcc” to “McC” with the Match Case option selected. • UPPER—Convert the text to all uppercase. • LOWER—Convert the text to all lowercase. Each of the functions has a single argument—the cell containing the text to be converted. After it is converted, you can use Paste Special, Values to replace the original text with the converted text.
 
 Copying Formulas Rapidly If you need to copy a formula into just a few rows, using the fill handle is fine. But if you have several hundred rows to update, you could zoom right past the last row. And if you have thousands of rows, using the fill handle can take quite some time. One solution is to copy the formula, select the range, and paste the formula into the range. But it can still be a bit tricky to select the entire range you need to paste to. If you have at least one column with data entered in every row, you can doubleclick the fill handle and have it quickly fill the formula down the column.
 
 LET ME TRY IT
 
 Filling a Formula Down a Column To quickly copy a formula down a column, follow these steps: 1. If the column to the left of your formula column has any blank spaces, hide that column. The column to the left of the formula column must not contain any blank spaces, or else the formula will be copied down to only the first blank row. 2. Place your cursor on the fill handle until it turns to a black plus sign, as shown in Figure 3.6. 3. Double-click and the formula will be copied down the sheet until it runs into a blank row in the column to the left.
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 Figure 3.6 Double-click when the cursor becomes a black plus sign to quickly copy the formula down the column.
 
 Converting Formulas to Values Formulas take up a lot of memory, and the recalculation time can make working in a large workbook a hassle. At times, you need a formula only temporarily; you just want to calculate the value once and won’t ever need to calculate it again. You could manually type the value over the formula cell, but if the result is a long number, or if you have a lot of calculation cells, this isn’t convenient. You’re probably used to copying the cell and doing a Paste Special, Values, but there’s a faster way.
 
 SHOW ME
 
 Media 3.2—Converting Formulas to Values You can watch a free video of this task when you log on to my.safaribooksonline.com/9780132182287/media.
 
 LET ME TRY IT
 
 Quickly Replacing Formulas with Values Follow these steps for a quick way to paste values: 1. Select the range of formulas. 2. Place your cursor on the right edge of the black border so that it turns from the white plus sign to four black arrows. 3. While holding your right mouse button down, drag the range to the next column and back to the original column. 4. Let go of the right mouse button. 5. From the context menu that appears, select Copy Here as Values Only.
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 Using Text to Columns Text to Columns can be used to separate data in a single column into multiple columns, for example, if you have full names in one column and need a column with first names and a column with last names. The button to call the wizard is found on the Data tab. In step 1 of the wizard, select whether the text is Delimited or Fixed Width. In step 2, you provide more details on how you want the text separated. In step 3, you tell Excel the basic formatting to apply to each column.
 
 If you have data in the columns to the right of the column you are separating, Excel will overwrite the data. Be sure to insert enough blank columns before beginning Text to Columns.
 
 TELL ME MORE
 
 Media 3.3—Pasting and Delimited Text
 
 You can listen to a free audio recording about a potentially useful bug that happens when you paste text after using Text to Columns when you log on to my.safaribooksonline.com/9780132182287/media.
 
 Working with Delimited Text Delimited text is text that has some character, such as a comma, tab, or space, separating each group of words that you want placed into its own column.
 
 LET ME TRY IT
 
 Separating Delimited Text into Multiple Columns To separate delimited text into multiple columns, follow these steps: 1. Highlight the range of text to be separated. 2. Go to Data, Text to Columns. The Convert Text to Columns Wizard opens. 3. Select Delimited from step 1 of the wizard, as shown in Figure 3.7, and click Next.
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 Figure 3.7 Select the Delimited option to separate text joined by delimiters, such as commas, spaces or tabs.
 
 4. Select one or more delimiters used by the grouped text, as in Figure 3.8, and click Next.
 
 Figure 3.8 Use a comma delimiter to separate the city from the state and ZIP code.
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 If you need more than one delimiter but one of the delimiters is used normally in the text, such as the space between city names and the space between a state and ZIP Code (Sioux Falls, SD 57057), consider running Text to Columns twice: once to separate the city (Sioux Falls) from the state ZIP (SD 57057) and again to separate the state and ZIP.
 
 5. For each column of data, select the data format. For example, if you have a column of ZIP Codes, you will want to set the format as Text so any leading zeros are not lost. But be warned—setting a column to Text will prevent Excel from properly identifying formulas entered into that column. 6. Click Finish. The text will be separated, as shown in Figure 3.9.
 
 Figure 3.9 Using Text to Columns with a comma delimiter separated the city from the state and ZIP code.
 
 Working with Fixed Width Text Fixed width text describes text where each group is a set number of characters. You can draw a line down all the records to separate all the groups, as shown in Figure 3.10. If your text doesn’t look like it’s fixed width, try changing the font to a fixed width font, such as Courier. It’s possible that it’s fixed width text in disguise.
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 Figure 3.10 Use the Fixed Width option when each group in the data has a fixed number of characters.
 
 LET ME TRY IT
 
 Separating Fixed Width Text into Multiple Columns To separate fixed width text into multiple columns, follow these steps: 1. Highlight the range of cells that include text to be separated. 2. Go to Data, Text to Columns. 3. Select Fixed Width from step 1 of the wizard and click Next. 4. Excel will guess at where the column breaks should go, as shown in Figure 3.10. You can move a break by clicking and dragging it to where you want it, insert a new break by clicking where it should be, or remove a break by double-clicking it. Click Next.
 
 Don’t worry about leading spaces—Excel will remove them for you.
 
 5. For each column of data, select the data format. For example, if you have a column of Zip Codes, you will want to set the format as Text so any leading zeros are not lost, as shown in Figure 3.11. But be warned—setting a column to Text will prevent Excel from properly identifying formulas entered into that column.
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 Figure 3.11 In step 3 of the wizard, set the format of each column. If you have ZIP codes, for example, you will want to make sure they are treated as text so not to lose any leading zeros.
 
 6. Click Finish.
 
 Using Text to Columns to Convert Text to Numbers A previous section, “Fixing Numbers as Text,” mentioned that Text to Columns can be used to convert a number stored as text to a real number. This is done in step 3 of the Text to Columns wizard.
 
 LET ME TRY IT
 
 Converting Numbers as Text to Just Numbers Follow these steps to convert a column of numbers stored as text to just numbers: 1. Highlight the range of text to be converted. 2. Go to Data, Text to Columns. 3. Click Finish. The numbers are no longer considered numbers stored as text.
 
 Controlling the Next Cell Selection You can use several tricks to control what cell you enter data into next.
 
 Enter Versus Tab Normally, when you hit the Enter key as you enter data, the active cell moves down the column. If instead you want the selection to move to the right, you must either
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 use the Tab key or the right arrow to move your selection. Then when you get to the end of the row, use Enter to move down to the beginning of the next row. Somehow, Excel will keep track of which column you started your data entry on and return you there, making it easier to start the next row of data.
 
 Moving Cell Pointer Direction If you don’t want to use both Tab and Enter, you can go to File, Options, Advanced, After Pressing Enter Move Selection, and change the Direction from Down to Right. But Excel will no longer move the selection to the next row when you get to the last column—because it doesn’t realize you are at the last column.
 
 Preselecting the Data Range If you have the selection set to move right when you press Enter, you can tell Excel when to go down to the next row by selecting the range into which you are entering data before you begin the data entry. In this way, Excel knows when you’ve reached the last column and will move down to the next row.
 
 Entering Data in a Circle If the data you need to fill in isn’t in consecutive columns or rows, such as a form, you can configure Excel to jump around to the different cells as you press the Enter key. You do this by setting up the data entry cells in a named range.
 
 LET ME TRY IT
 
 Using a Named Range to Indicate Data Entry Cells The following steps will show you how to set up a named range to assist in data entry: 1. Ignore the first data entry field, and select the second field. 2. Hold down the Ctrl key and select each data entry field in the order you want to enter the data. 3. After all the other data entry fields have been selected, while still holding down the Ctrl key, select the first field. 4. Type a name for the selected range in the Name Box and press Enter. 5. The next time you need to enter data in the fields, select the named range from the name box and the fields will be highlighted, as shown in Figure 3.12. Begin entering data in the first field and press Tab or Enter to automatically go to the next field, repeating until you are done.
 
 Wo r k i n g w i t h Ta b l e s
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 Figure 3.12 Quickly identify and go to the data entry fields by using a named range.
 
 Working with Tables When your data is defined as a Table, additional functionality in Excel is made available. For example, with Excel’s intelligent tables • Autofilter drop-downs are automatically added to the headings. • You can apply predesigned formats, such as banded rows or borders. • You can remove duplicates based on the values in one or more columns. • You can toggle the total row on and off. • Adding new rows or columns will automatically extend the table. • You can take advantage of automatically created range names.
 
 Defining a Table For your data to convert to a table, it must be set up properly. This means that, except for the headings row, each row must be one complete record of the table— for example, a customer or inventory item—as shown in Figure 3.13. Headings are not required, but if they are included, they must be at the top of the data. If your data does not include headers, Excel will insert some for you.
 
 Figure 3.13 Set up your data properly to define it as a table to uncover new functionality in Excel.
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 After your data is set up properly, you can define the table with one of the following methods. Select a cell in the dataset and • Go to Insert, Tables, Table. • Go to Home, Styles, Format as Table, and select a style to apply to the data. • Press Ctrl+T. • Press Ctrl+L. When you use any one of the preceding methods, Excel determines the range of your data by looking for a completely empty row and column. A dialog will appear showing the range Excel has defined. You can accept this range or modify it as needed. If Excel was able to identify headers, the My Table Has Headers box will be selected, so make sure that Excel has correctly identified whether your data has headers and click OK. If there were no headers, make sure the box is unselected and press OK. Your table will be formatted with autofilter drop-downs in the headers, as shown in Figure 3.14.
 
 Figure 3.14 A table automatically has autofilter drop-downs in the header.
 
 With the Web App, you should select your data range before defining the table because if you need to make a change, you will have to cancel out of the dialog.
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 Defining a Table To define your data as a table, follow these steps: 1. Select a cell in the data. 2. Go to Insert, Table. 3. In the Create Table dialog, verify the range Excel has selected. If it is incorrect, make the required changes. 4. If your data has headers, make sure the My Table Has Headers box is selected; otherwise, make sure it is not selected. 5. Click OK.
 
 Expanding a Table After your data is defined as a table, the table automatically expands as you add adjacent rows and columns. If you don’t want the new entry to be part of the table, you can tell Excel by clicking the lightning bolt icon that appears and then selecting either Undo Table AutoExpansion or Stop Automatically Expanding Tables, as shown in Figure 3.15.
 
 Figure 3.15 If you don’t want a new row to be part of the table, instruct Excel to undo or stop the AutoExpansion.
 
 When adding new rows to the bottom of a table, make sure the total row is turned off; otherwise, Excel cannot identify the new row as belonging with the existing data. The exception is if you tab from the last data row, Excel will insert a new row and move the total row down.
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 To manually resize a table, click and drag the angle bracket icon in the lower-right corner of the table. You can also select a cell in the table and go to Table Tools, Design, Properties, Resize Table. Specify the new range in the Resize Table dialog that appears.
 
 Adding a Total Row to a Table When you select Table Tools, Design, Table Style Options, Total Row, Excel adds a total row to the bottom of the active table. By default, Excel adds the word Total to the first column of the table and sums the data in the rightmost column, as shown in Figure 3.16. If the rightmost column contains text, Excel will return a count instead of a sum.
 
 Figure 3.16 Clicking the Total Row check box adds a default total row to the bottom of the table. Use the drop-downs in each cell in the total to add or change the function.
 
 Each cell in the total row has a drop-down of functions that can be used to calculate the data above it. For example, instead of the sum, you can calculate the average, max, min, and more. Just make a selection from the drop-down and Excel will insert the formula in the cell.
 
 The functions listed in the drop-down are calculated using variations of the SUBTOTAL function. For more information on this function, see Chapter 9, “Subtotals and Grouping.”
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 Adding Totals to a Table To add a total row containing multiple calculations, follow these steps: 1. Select a cell in the table. 2. Go to Table Tools, Design, Table Style Options, and select Total Row. A total row will appear at the bottom of the table, with a formula summing the rightmost column. 3. Select the cell in the total row of the column whose calculation you need to change. A drop-down arrow appears. 4. Click the drop-down arrow and select the desired function. 5. Repeat Step 4 for any other columns that require calculations.
 
 Data Validation Data validation, found under Data, Data Tools, Data Validation, allows you to limit what a user can type in a cell. For example, you can limit users to whole numbers, dates, a list of selections, or a specific range of values. Custom input and error messages can be configured to guide the user entry. The available validation criteria are: • Any Value—The default value allowing unrestricted entry. • Whole Number—Requires a whole number be entered. You can select a comparison value (between, not between, equal to, and so on) and set the minimum and maximum value. • Decimal—Requires a decimal value be entered. You can select a comparison value (between, not between, equal to, and so on) and set the minimum and maximum value. • List—Requires user to select from a predefined list, as shown in Figure 3.17. The source can be within the data validation dialog or can be a vertical range on any sheet.
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 Figure 3.17 Provide users with a list of entries to choose from.
 
 • Date—Requires a date be entered. You can select a comparison value (between, not between, equal to, and so on) and set the minimum and maximum value. • Time—Requires a time be entered. You can select a comparison value (between, not between, equal to, and so on) and set the minimum and maximum value. • Text Length—Requires a text value be entered. You can select a comparison value (between, not between, equal to, and so on) and set the minimum and maximum number of characters. • Custom—Uses a formula to calculate TRUE for valid entries or FALSE for invalid entries.
 
 LET ME TRY IT
 
 Limiting User Entry to a Selection from a List Data validation allows you to create a drop-down in a cell, restricting the user to selecting from a predefined list of values, as shown in Figure 3.17. To set up the source range and configure the data validation cell, follow these steps: 1. Create a vertical list of the values to appear in the drop-down. You can place these values in a sheet different from where the drop-down will actually be placed, then hide the sheet, preventing the user from changing the list. 2. Select the cell you want the drop-down to appear in. 3. Go to Data, Data Tools, Data Validation. The Data Validation dialog will appear. 4. From the Allow field of the Settings tab, select List.
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 5. Place your cursor in the Source field. 6. Select the list you created in step 1, as shown in Figure 3.18. If your list is short, instead of the separate list you created in step 1, you can enter the values separated by commas directly in the Source field. For example, you could enter Yes, No in the source field (no quotes, no equal sign).
 
 Figure 3.18 The source for the validation list can be a different sheet. You can then hide the sheet from users.
 
 7. If you want to provide the user with an input prompt, go to the Input Message tab and fill in the Title and Input Message fields. 8. If you want to provide the user with an error message, go to the Error Alert tab and fill in the Style, Title and Error Message fields. 9. Click OK.
 
 The font and font size of the text in the drop-down is controlled by your Windows settings, not Excel.
 
 This page intentionally left blank
 
 This chapter will show you how to format your data manually and create rules to format it automatically
 
 4
 
 Data Formatting You don’t have to format the data in a workbook, but good use of formatting can make a dull presentation pop or even highlight the point you are trying to get across. This chapter reviews formatting from the most basic options, such as bolding text, to the more advanced options, such as data bars.
 
 Cell Formatting All the formatting options described in this section can be found on the Format Cells dialog in Excel and Excel Starter, which you can open by right-clicking a cell and selecting Format Cells or by pressing Ctrl+1 (the number one). Many formatting options are also available on the minitoolbar in Excel and Excel Starter. Instead of using either of those dialogs, instructions will reference the button or group on the Home tab, if one is available.
 
 Font Group The Font group on the Home tab consists of several tools you can use to add emphasis to a range.
 
 Font Typeface The default font in Excel is Calibri, but many others are available. To change the font, select the range, and then select a new font from the drop-down in the Font group, as shown in Figure 4.1. In Excel and Excel Starter, you can preview the selection in the selected range as you move your cursor through the list.
 
 Font Size To change the font size, select the range, and then select a new size from the dropdown. Excel and Excel Starter have two additional buttons next to the font size drop-down, shown in Figure 4.2. To increase the font size by one point (two after 12 point), click the A with the up arrow (A^); to decrease the font size by one point
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 (two after 12 point), click the slightly smaller A with the down arrow (Av).
 
 Figure 4.1 When you select a font from the drop-down, the active cell will update to show you how the font will look with your text.
 
 Decrease font size
 
 Increase font size
 
 Figure 4.2 The Increase Font Size and Decrease Font Size buttons allow you to change the font size of the selected range with one click.
 
 Applying Bold, Italic, and Underline The three icons for bold, italic, and underline toggle the property on and off. The Bold icon is a bold letter B. The italic icon is an italic letter I. The Underline icon, which is a drop-down in Excel and Excel Starter, is either an underlined U or a double-underlined D. To apply formatting, select the range and click the desired formatting button. In Excel and Excel Starter, you can select one specific word in a cell and apply the formatting just to it.
 
 Strikethrough, Superscript, Subscript The strikethrough, superscript, and subscript effects are available only in the Effects group on the Font tab of the Format Cells dialog in Excel and Excel Starter. To apply the formatting, select the cell or specific characters in the cell, right-click over the selection, and select Format Cells to bring up the dialog and select the desired formatting option.
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 Borders The borders drop-down includes 13 of the most popular border options (there are seven options on the Web App). These borders are applied to the selected cell or range, either the inside borders or the outside borders, depending on your selection. For more options, go to the Borders tab in the Format Cells dialog.
 
 The Excel Web App is limited to thin border lines shown in its Borders drop-down.
 
 LET ME TRY IT
 
 Formatting a Table with a Thick Outer Border and Thin Inner Lines Follow these steps (Excel and Excel Starter only) to create a table that has a thick outer border and a thin border around each inner cell, as shown in Figure 4.3.
 
 Figure 4.3 Use the borders drop-down menu to create a table. 1. Select the range to format. 2. From the border drop-down, select the All Borders option. 3. Return to the border drop-down and select the Thick Box Border option.
 
 Fill Fill refers to the color applied inside of a cell; it is represented by a paint bucket on its button. When you click the button, a drop-down of available colors opens up. As you move your cursor over the colors, the selected range automatically updates to reflect the color your cursor is currently over. When you’ve decided on the color you want, click the color and the drop-down will close, and the range is colored as specified.
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 The Format Cells dialog offers additional fill effects, such as patterns, styles, and gradient fills. Pattern Color and Pattern Style work together to fill a cell with a pattern (various dots, lines) in the selected color. This effect is placed on top of the Background color. A gradient fill is when a color slowly changes from one color to another within a cell.
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 Applying a Two-Color Gradient to a Cell To apply a two-color gradient to a range, follow these steps: 1. Select one or more cells. If you select a range, the gradient will repeat across the range. 2. Press Ctrl+1 to bring up the Format Cells dialog. 3. Go to the Fill tab. 4. Click the Fill Effects button. The Fill Effects dialog, shown in Figure 4.4, will open.
 
 Figure 4.4 The Fill Effects dialog offers more options for applying color inside of a cell.
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 5. Select a color from the Color 1 drop-down. 6. Select a different color from the Color 2 drop-down. 7. Select a shading style from the Shading Styles section. 8. Make a selection from the Variants section. The Sample box will update to reflect your selection. 9. Click OK twice.
 
 Font Color The Font Color drop-down is the button with the A underscored by a thick red line, which changes when you select a different color from the available colors. Any color in the drop-down can be applied to a cell. Excel and Excel Starter will even allow you to change the color of single selected character within a cell.
 
 Alignment Group The Alignment group consists of tools that affect how a value is situated in a cell or range.
 
 Alignment There are six alignment buttons in the Alignment group, representing the most popular settings for how a value is situated in a cell. Top Align, Middle Align, and Bottom Align describe the vertical placement of the value in the cell. Align Text Left, Center, and Align Text Right describe the horizontal placement of the value in the cell. More options are available in the Format Cells dialog on the Alignment tab.
 
 LET ME TRY IT
 
 Centering Text Across a Selection Follow these steps to center a title across the top of a table without merging the cells, as shown in Figure 4.5.
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 Figure 4.5 Use Center Across Selection instead of Merge Cells to center a title on a report.
 
 1. Type your title in the leftmost cell to the table. 2. Select the title cell and extend the range to include all cells you want the title centered over. 3. Press Ctrl+1 to bring up the Format Cells dialog. 4. Go to the Alignment tab. 5. From the Horizontal drop-down, select Center Across Selection. 6. Click OK.
 
 Merging Cells Merge Cells takes two or more adjacent cells and combines them to make one cell. For example, if you are designing a form with many data entry cells, and need space for a large comment area, resizing the column may not be practical as it will also affect the size of the cells above it. Instead, select the range you want the comments to be entered in and merge the cells. Any text other than that found in the top-left cell of the selection is deleted as the newly combined cell takes on the identity of this first cell.
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 Use caution when merging cells because it can lead to potential issues: • Unable to sort if there are merged cells within the data. • Unable to cut and paste unless the same cells are merged in the pasted location. • Column and row autofit won’t work. • Lookup type formulas return a match only for the first matching row or column.
 
 Wrapping Text When you type a lot of text in a cell, it continues to extend to the right beyond the right border of the cell. You can widen the column to fit the text, but sometimes that may be impractical. If that’s the case, you can set the cell to Wrap Text, moving any text that extends past the edge of the column to a new line in the cell. Normally, when you wrap a cell, the row height automatically adjusts to fit the text. If it doesn’t, make sure you don’t have the cell merged with another; Excel will not autofit merged cells. If there are merged cells, unmerge them and manually force an autofit (see the “Setting Row Heights and Column Widths” section). The row height will begin to auto adjust again. Refer to the “Justifying Text in a Range” if you don’t want to wrap text in a single cell and would prefer to have each line on its own row.
 
 Indenting Cell Contents By default, text entered in a cell is flush with the left side of the cell. To move text away from the left edge, you might be tempted to add spaces before text. If you change your mind about this formatting at a later time, it can be quite tedious to remove the extraneous spaces. Instead, use the Increase Indent and Decrease Indent buttons to move the value about two character lengths over. Increase Indent will move the value away from edge it is aligned with. Decrease Indent will move the value back toward its edge.
 
 If you use these buttons with a right-aligned number, the number will become left-aligned and adjust from the left margin. This does not occur with rightaligned text.
 
 When adjusting the Indent from the Format Cells dialog, the Alignment tab uses a single Indent field with a number to indicate the number of indentations.
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 Orienting Text Vertical text can be difficult to read, but sometimes limited space makes it a requirement. The Orientation button, which looks like ab written at a 45 degree angle, has five variations of vertical text, Angle Counterclockwise, Angle Clockwise, Vertical Text, Rotate Text Up and Rotate Text Down. The Orientation section in Format Cells, Alignment offers more precise control (see Figure 4.6).
 
 Figure 4.6 Use the Orientation settings to rotate the contents of a cell.
 
 Justifying Text in a Range There’s a very handy tool that’s not found with the other formatting tools. It didn’t even appear on the Excel 2003 toolbars (it was hidden in the Edit menu) and is hidden in the Editing group on the Home tab. The button is the Fill button (a blue down arrow) and the option within it is Justify. The Justify option reflows the text in a paragraph to fit a certain number of columns. For example, if you paste a paragraph directly into a cell, the height of the cell will increase, but the column width will be unaffected. Use Fill, Justify to reflow the text. Be careful when selecting the range, because if you do not have enough empty rows available for the text to flow into, Excel will, after warning you, overwrite the rows below the selection.
 
 J u s t i f y i n g Te x t i n a R a n g e
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 Reflowing Text in a Paragraph To reflow text in a paragraph to fit a certain number of columns, follow these steps: 1. Ensure that the text is composed of one column of cells. The sentences can extend beyond one column, but the left column must contain text and the remaining columns must be blank. 2. Select a range as wide as the finished text should be. Ensure that the upper-left cell of the selection is the first line of text and include several extra rows in the selection rectangle, as shown in Figure 4.7.
 
 Figure 4.7 The number of columns selected determines the width of the final result.
 
 3. From the Home tab, select Editing, Fill, Justify. The text will reflow so that each line is shorter than the selection range, as shown in Figure 4.8.
 
 Figure 4.8 The text flows to the width of the original selection and down the number of rows it needs to.
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 Cell Styles You’re probably used to using styles in Word but never realized that styles are also available in Excel. Select a range in Excel and go to Home, Styles, Cell Styles. Move your cursor over the predefined styles and watch your range update to reflect the styles. You aren’t limited to these predefined styles. You can create and save your own style for use throughout the workbook it’s saved in.
 
 SHOW ME
 
 Media 4.1—Creating a Custom Style Access this video file through your registered Web edition at my.safaribooksonline.com/9780132182287/media.
 
 LET ME TRY IT
 
 Creating a Custom Style Follow these steps to quickly create a custom style in the active workbook: 1. Select a cell with all the formatting styles needed. 2. Go to Home, Styles, Cell Styles, New Cell Style. 3. If there is any type of formatting you do not want as part of the style, such as the alignment, unselect the style option. 4. Enter a name for the style in the Style Name field and click OK.
 
 Using Number Formats in Excel and Excel Starter The way you see number data in Excel is controlled by the format applied to the cell. For example, you may see the date as April 5, 2010, but what’s actually in the cell is 40273. Or you may see 10.5%, but the actual value in the cell is 0.105. This is important because when doing calculations, Excel doesn’t care what you see. It deals only with the actual values. There are only a few formatting options on the Home tab in the Numbering group. This section reviews the formatting options available in the Format Cells, Number-
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 ing dialog. For a review of the Number Format drop-down and the Increase Decimal and Decrease Decimal buttons, see the “Number Formats in Excel Web Apps” section because the same buttons are used there.
 
 General General is the default format used by all cells on a sheet when you first open a workbook. Decimal places and the negative symbol are shown if needed. Thousand separators are not.
 
 Number By default, the Number format uses two decimal places but does not use the thousand separator. You can change the number of decimals, turn on the thousands separator, and choose how to format negative numbers, as shown in Figure 4.9.
 
 Figure 4.9 Additional options may be available when you select a format to apply.
 
 Currency The default Currency format displays the systems currency symbol, two decimal places and a thousands separator. You can change the number of decimals, the currency symbol, and select a format for negative numbers.
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 Accounting Accounting is similar to Currency but automatically lines up the currency symbols on the left side of the column and decimals points to the right side of the cell. The default Accounting format displays the systems currency symbol, two decimal places, and a thousands separator. You can change the number of decimals and the currency symbol.
 
 Date There is no default Date format. Sometimes Excel will reformat the date you enter, sometimes it keeps it the way you entered it. You can select a date format from the list in the Type box, which also contains date and time formats. The date formats vary from short dates, such as 4/5, to long dates, such as Monday, April 5, 2010. When selecting a date format, look at the sample above the type list. It will help you differentiate between the format 14-Mar, which is March 14, and the format Mar-01, which is March 2001, not March 1.
 
 Time There is no default Time format. You can select a time format from the list in the Type box, which also contains two date and time formats. Excel sees times on a 24-hour clock. That is, if you enter 1:30, Excel assumes you mean 1:30 a.m. But if you enter 13:30, Excel knows you mean 1:30 p.m. If you need to display times beyond 24 hours, such as if you’re working on a timesheet adding up hours worked, use the time format 37:30:55, as shown in Figure 4.10.
 
 Percentage The default Percentage format includes two decimal places. When you apply this format, Excel takes the value in the cell, multiplies it by 100, and adds a % at the end. When you use the cell in a calculation, the actual (decimal) value is used. For example, if you have a cell showing 90% and multiply it by 1000, the result will be (in General format) 900 (0.9*1000). If you include the % when you type the value in the cell, in the background Excel converts the value to its decimal equivalent, but the Percentage format is applied to the cell.
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 Figure 4.10 There are various time formats available.
 
 Fraction The Fraction category rounds decimal numbers up to the nearest fraction. You can select to round the decimal to one, two, or three digits, or to round to the nearest half, quarter, eighth, sixteenth, tenth, or hundredth.
 
 Scientific The default Scientific category displays the value in scientific notation accurate to two decimal places. You can change the number of decimals.
 
 Text There are no controls for the Text category. Setting this format to a cell forces Excel to treat the numbers in the cell as text, and you view exactly what is in the cell. If you set this format before typing in a number, the number becomes a number stored as text and may not work in some calculations.
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 Special This category provides formats for numbers that do not fall in any of the preceding categories because the values are not actually numbers. That is, they aren’t used for any mathematical operations and instead are treated more like words. The four special types are specific to U.S. formatting: • ZIP Code and ZIP Code + 4—Ensures that east coast cities do not lose the leading zeros in their ZIP Codes. • Phone Number—Formats a telephone number with parentheses around the area code and a dash after the exchange. • Social Security Number—Uses hyphens to separate the digits into groups of three, two, and four numbers.
 
 Custom Formats Despite all the options available in the preceding categories, not all the possible situations are covered. That’s why there’s the option of Custom Formats, allowing you to create a format specific to your situation. Custom formats are saved with the workbook they are created in.
 
 Understanding the Four Sections of a Number Format A custom number format can contain up to four different formats, each separated by a semicolon. You should keep several things in mind when creating a custom number format: • Use semicolons to separate the code sections. • If there is only one format, it will apply to all numbers. • If there are two formats, the first section applies to positive and zero values. The second section applies to negative values. • If all four sections are used, they apply to positive, negative, zero, and text values, respectively. Figure 4.11 shows a custom number format using all four sections. The table in C9:D13 displays how the formats would be applied to different values. Note the value in D11 is red and a zero, not a blank, must be entered in C12 for “No Sales” to appear.
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 Figure 4.11 Use the four sections of a custom number format to design formatting for positive, negative, zero, and text values.
 
 Using Text and Spacing in a Number Format As shown in Figure 4.12, you can display both text and numbers in a cell. To do this, enclose the text in double quotation marks. If you need only a single character, you can omit the quotation marks and precede the character with a backslash (\). Some characters don’t need quotes or a backslash. These special characters are: $ - + / ( ) : ! ^ & ’ ~ { } = < > and the space character.
 
 Figure 4.12 Use an underscore to instruct Excel to add a specific amount of space to a format.
 
 If using the fourth section of the number format, include the @ sign where you want to display any text in the formatted cell. If the @ is omitted from the format, text entered in the cell will not be displayed.
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 To have Excel add space to a format, such as to have Excel line up the decimals in a column on negative and positive numbers where the negative numbers are wrapped in parentheses, use an underscore followed by a character. In Figure 4.12, the format in column B doesn’t include the _) in the positive section of the format, and so the positive value in the cell is flush with the right margin. In contrast, the format in column C does include the _) and the decimals beneath are lined up. It’s like having an invisible ) in the cell. To fill unused space in a cell with a repeating character, use an asterisk followed by the character to repeat. The repeat character can appear before or after the value in the cell. For example *-0 fills the leading space in the cell with dashes, whereas 0*^ fills in the trailing space with carets.
 
 Using Decimals and the Thousands Separator in a Number Format Zeros are used as placeholders in a format when you need to force the place to be included, such as if you need to format all numbers with exactly three decimal places. If you would like to display up to three decimal places, but it is not necessary, use the pound (#) sign as the place holder. Use a question mark (?) on either side of a decimal to replace insignificant zeros if you will be using a fixed-width font (such as Courier) and want the decimals to line up. To include a thousands separator, use a comma in the format, such as #,###.0. To scale a number by thousands, as shown in Figure 4.13, include a comma at the end of the numeric format for each multiple of 1000.
 
 Figure 4.13 Use a comma as a thousands multiplier to change how a value is displayed.
 
 LET ME TRY IT
 
 Formatting Significant and Insignificant Digits To format the positive section to always show three decimals and the negative section to show only what’s entered, follow these steps: 1. Right-click over the cell to format and select Format Cells.
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 2. On the Number tab, select Custom from the Category list. 3. In the Type field enter 0.000;-0.### and click OK. 4. Positive values will display exactly three decimal places and negative values will display up to three decimal places, as shown in Figure 4.14.
 
 Figure 4.14 Create a custom format to treat positive and negative values differently.
 
 Using Color and Conditions in a Number Format You can use eight text color codes in a format: red, blue, green, yellow, cyan, black, white, and magenta. You place the color in square brackets, such as [cyan]. It should be the first element of a numeric formatting section. You can use conditions in conjunction with colors to create number formats that apply only when specific conditions are met. The colors and conditions can only be applied to the first two sections of the number format, but the other sections can still be used. For example, to color values greater than or equal to 50 in green, less than 50 in red, a blank for zeros, and have “Sales” joined to any existing text, use this format: [Green][>=50];[Red][= from the drop-down. 9. Enter 33 in the Value field. 10. Select Percent from the Type drop-down. 11. Click the third drop-down under the Icon heading and select the red stoplight. 12. Click OK.
 
 Using Rules Use the preset conditional formats if all you need is to format all the cells in a range based on how they compare to each other. But if your needs are more advanced, such as formatting only the top 10% or only cells that meet a specific condition, then you’ll want to apply formatting using rules.
 
 TELL ME MORE
 
 Media 4.5—Using Preset Conditional Formatting
 
 Rules You can listen to a free audio recording about using the built-in conditional formatting rules in Excel 2010 when you log on to my.safaribooksonline.com/9780132182287/media.
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 Built-in Rules Under Conditional Formatting, Highlight Cells Rules and Top/Bottom Rules options, you’ll find several built-in rules that you can apply to your data. Apply selected formatting to the following: • Cells containing values greater than, less than, between, or equal to the value you specify. • Cells containing specific text. • Cells containing a date from the last day, two days, and so on. • Cells containing duplicate values. • Cells containing the top or bottom n items. • Cells containing the top or bottom n%. • Cells containing values above or below the average. For all of the preceding built-in rules, you can apply one of Excel’s preset formats or design your own custom format.
 
 LET ME TRY IT
 
 Using a Custom Format for the Top n Items in a Range To apply a custom format to the Top n items in the selected range, follow these steps: 1. Select the range to which you want to apply the formatting. 2. On the Home tab, go to Conditional Formatting, Top/Bottom Rules, Top 10 Items. 3. Enter the number of items you want formatted. 4. From the format drop-down, select Custom Format. 5. From the Format Cells dialog that appears, design the format you want applied (see Figure 4.23). You can go to any of the tabs (Number, Font, Border, and Fill) to make your selections. The only change you cannot make is to the font type and size on the Font tab.
 
 Building Custom Rules You can customize any of the prebuilt rules, but if what you need is not listed, you’ll want to build your own conditional formatting rule based on a formula.
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 Figure 4.23 Using Custom Format, the top eight items had bold italic format and borders applied.
 
 The formula box, shown in Figure 4.24 has a few rules for writing a formula:
 
 Figure 4.24 Use a custom formula to highlight the next seven days in a list of dates.
 
 • The formula must start with an equal (=) sign. • The formula must evaluate to a logical value of True or False or the equivalents of 1 and 0.
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 • If you use your mouse to select cells on the sheet, Excel will insert the address using absolute referencing. If relative referencing is what you need, press the F4 key three times to toggle away the dollar signs in the formula. • For more information on absolute versus relative referencing, see the section “Absolute Versus Relative Referencing” in Chapter 5, “Using Formulas.” • The formula you write will apply to the topmost left cell of your selection, so you need to look at the Name Box in the formula bar and see what cell is the active cell. If you are writing a relative formula, write the formula as it would appear for the active cell. Excel will apply the formula appropriately to all the other cells you have selected. In Figure 4.24, the active cell is B4, which is also referenced in the formula. • By default, the keyboard navigation keys (up arrow, down arrow, left arrow, right arrow, Page Up, Page Down, Home) are tied to the sheet and won’t work in the formula field. If you try to use the arrow keys to change your cursor position while typing in the formula field, Excel will instead place the cell address you just selected. To work around this behavior, press F2 before using the navigation keys. You can verify what mode you are in by looking in the lower-left corner of the status bar. There are three modes: • Enter—The default mode for entering a formula in the formula field. Using the navigation keys will change the selection on the sheet. • Edit—The mode for using the navigation fields to move through the formula field. • Point—The mode for selecting cells on the sheet. Excel automatically switches to this mode when selecting cells on the sheet. • To set up a conditional format based on a formula, select the range it applies to and, from the Home tab, go to Conditional Formatting, New Rule, and select Use a Formula to Determine Which Cells to Format from the Select a Rule Type box. Enter your logical formula in the formula field and set the desired Format.
 
 LET ME TRY IT
 
 Using a Custom Formula to Format Data To create a conditional formatting based on a custom logical formula, follow these steps: 1. Select the range to which you want to apply the formatting.
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 2. On the Home tab, go to Conditional Formatting, New Rule and select Use a Formula to Determine Which Cells to Format from the Select a Rule Type box. 3. Type the logical formula in the formula field. 4. Click Format to bring up the Format Cells dialog and apply the desired formatting. 5. Click OK twice to apply the conditional format to the selected range.
 
 Combining Rules You can have multiple conditions evaluate to True and as each condition is met, the format is applied to the cell. For example, one rule sets the fill color to red and another rule italicizes the contents, as shown in Figure 4.25. If both rules are met, the cell is formatted in italic with a red fill. If a cell meets one condition, only the corresponding format is applied. If the formatting of the rules is conflicting, for example the first rule applies a red font and the second rule applies a blue font, the formatting of the first rule, the red font, is applied.
 
 Figure 4.25 Setting up multiple rules can apply multiple formatting to cells.
 
 Stopping Further Rules From Being Checked Because rules are applied starting at the top, you might want to prevent further rules from being applied if a certain condition is met. In that case, check the Stop If True option in the Conditional Formatting Rules Manager for the rule you want to be the last if the condition is True. For example, in Figure 4.25, values below 8000
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 were italic with a red fill. But if you want to differentiate between items below 8000 and those between 8001 and 10000 (without setting up a rule referencing the specific range), you would check the Stop If True for the first rule, as shown in Figure 4.26.
 
 Figure 4.26 Check the Stop If True checkbox to prevent further rules from being applied to the data.
 
 Clearing Conditional Formatting You can set more than one conditional formatting rule on a range, so if you want to replace a format with another, you will need to clear the previous rule. Or, you may want to clear all the formatting on a sheet. To clear conditional formatting, go to Home, Conditional Formatting, Clear Rules. From the drop-down that appears you can: • Clear Rules from Selected Cell • Clear Rules from Entire Sheet • Clear Rules from This Table • Clear Rules from This PivotTable
 
 This chapter will teach you about entering and troubleshooting formulas.
 
 5
 
 Using Formulas Excel is great for simple data entry, but its real strength is its capability to perform calculations. After you design a sheet to perform calculations, you can easily change the data and watch Excel instantly recalculate. This chapter introduces you to formula basics that you can later apply to Chapter 6, “Using Functions.”
 
 The Importance of Laying Data Out Properly Except for when using certain functions, such as VLOOKUP, Excel doesn’t really care how you lay out your data. For example, you can lay out your data as shown in Figure 5.1, with dates across the top. But if you later decide you want to use a pivot table or certain functions, your options are limited. You’ll have fewer limitations if you lay out your data in the optimal fashion, shown in Figure 5.2, with a column assigned to each type of information entered.
 
 Figure 5.1 Laying out data with dates across the top may make sense when you want to see the data by date, but it can make it more difficult to apply functions.
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 Figure 5.2 Providing a column field for each data type allows you to take full advantage of many of Excel’s functions.
 
 Adjusting Calculation Settings By default, Excel calculates and recalculates whenever you open or save a workbook or make a change to a cell used in a formula. At times, this isn’t convenient— such as when you’re working with a very large workbook with a long recalculation time. In times like this, you will want to control when calculations occur. The Calculation group on the Formulas tab has the following options: • Calculation Options—Has the options Automatic, Automatic Except for Data Tables, and Manual. • Calculate Now—Calculates the entire workbook. • Calculate Sheet—Calculates only the active sheet. The calculation options under File, Options, Formulas include the same Calculation Options as the preceding list, but the Manual option allows you to turn on/off the way Excel recalculates a workbook when saving it.
 
 Formulas Versus Values You can’t tell the difference between a cell containing numbers and one with a formula just by looking at it on the sheet. To see whether a cell contains a formula, select the cell and look in the formula bar. If the formula bar contains just a number, the cell is static. But if the formula bar contains a formula, which always starts with an equal sign (=), as shown in Figure 5.3, you know the number you’re seeing on the sheet is a result of a calculation.
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 Figure 5.3 The formula bar reveals whether a cell, in this case H2, contains a number or a formula.
 
 Entering a Formula Entering a basic formula is straightforward. Select the cell, enter an equal sign, type in the formula, and press Enter. Typing the formula is very similar to entering an equation on a calculator, with one exception. If one of the terms in your formula is already stored in a cell, you can point to that cell instead of typing in the number stored in the cell. The advantage of this is that if the other cell ever changes, your formula will recalculate.
 
 SHOW ME
 
 Media 5.1—Entering a Basic Formula You can watch a free video of this task when you log on to my.safaribooksonline.com/9780132182287/media.
 
 LET ME TRY IT
 
 Enter a Formula To enter a formula that includes a pointer to another cell, follow these steps: 1. Select the cell you want the formula to be in. 2. Type an equal sign. This tells Excel you are entering a formula. 3. Type the first number and an operator, as you would on a calculator. There’s no need to include spaces in the formula. 4. Select the cell you want to include in the formula. 5. Press Enter. Excel calculates the formula in the cell.
 
 Relative Versus Absolute Formulas When you copy a formula, such as =B2*C2, down a column, the formula automatically changes to =B3*C3, then =B4*C4, and so on. Excel’s capability to change B2
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 to B3 to B4 and so on is called relative referencing. This is Excel’s default behavior when dealing with formulas, but it might not always be what you want to happen. If the cell address must remain static as the formula is copied, you need to use absolute referencing. This is achieved through the strategic placement of dollar signs ($) before the row or column reference, as shown in Table 5.1.
 
 Table 5.1 Relative Versus Absolute Reference Behavior Format
 
 Copied Down
 
 Copied Across
 
 A1
 
 A2—the row reference updates
 
 B1—the column reference updates
 
 $A$1
 
 $A$1—neither reference updates
 
 $A$1—neither reference updates
 
 $A1
 
 $A2—the row reference updates
 
 $A1—neither reference updates
 
 A$1
 
 A$1—neither reference updates
 
 B$1—the column reference updates
 
 R1C1 Notation The default setting in Excel is A1 notation. R1C1 notation is another reference style for cells. To turn it on, go to File, Options, Formulas and in the Working with Formulas section, select R1C1 Reference Style. When you do this, your sheet column headers change from letters to numbers, as shown in Figure 5.4.
 
 Figure 5.4 R1C1 notation is very different from the A1 reference style.
 
 Instead of A1 in the Name Box when you select the top leftmost cell on a sheet, you see R1C1, which stands for Row 1 Column 1. But the change is more than the notation difference, the way you write formulas is deeply affected. In R1C1 notation, the reference RC refers to the current cell. You modify RC by adding or subtracting a particular row or column number. For example, R5C refers to row 5 of the current column. RC5 refers to column 5 of the current row.
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 If the row or column numbers are enclosed in square brackets, then you are referring to a relative number of cells from the current cell. For example, if you have a formula in G8 and use the reference R[-1]C[3], you are referring to a cell one row above and 3 columns to the right of G8, which would be J7. In Figure 5.4, all the formulas are the same because the formula is based off the cell the formula is in. Note the formulas shown are actually the formulas in the Total column. The formula multiplies the value in the cell two columns to the left (Cost) by the value one column to the left (Qty) of the formula cell (Total). Both references are to a cell in the same row as the formula, so there is no number by the row reference.
 
 Using F4 to Change the Cell Referencing When typing in a formula and you select a cell or range, Excel uses the relative reference. If you need the absolute reference, you will probably either type in the address manually or go back and change the address after you are done with the whole formula. Another option is to change the reference to what you need while typing in the formula. You can do this by using the F4 key right after selecting the cell or range. Each time you press the F4 key, it changes the cell address to another reference variation, as shown in Figure 5.5.
 
 Figure 5.5 Use F4 to toggle through the variations of relative to absolute referencing.
 
 If you need to change a reference after you’ve already entered the formula, you can still place your cursor in the cell address and use the F4 key to toggle through the references.
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 LET ME TRY IT
 
 Changing a Cell Address to a Column Fixed Reference To change the cell address in a formula to a column fixed reference as you type it in, follow these steps: 1. Select the cell you want the formula to be in. 2. Type an equal sign. 3. Type the first number and operator, as you would on a calculator. 4. Select the cell you want to include in the formula. 5. Press F4 once and the address changes to absolute referencing. Press F4 again and it becomes a Row Fixed Reference. Press F4 a third time and it becomes a Column Fixed Reference. If you miss the reference you need to use the first time, continue pressing F4 until it comes up again. 6. Press Enter. Excel calculates the formula in the cell.
 
 Entering Formulas After typing the equal sign to start a formula, you have three options for entering the rest of the formula: • Type the complete formula. • Type numbers and operator keys, but use the mouse to select cell references. • Type numbers and operator keys, but use the arrow keys to select cell references. The method you use depends on what you find most comfortable. Some users consider the first method the quickest because they never have to move their fingers off the main section of the keyboard. For others, using the mouse makes more sense, especially when selecting a large range for use in the formula.
 
 Copying a Formula You can use four ways to enter the same formula in multiple cells: • Copy the entire cell and paste it to the new location.
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 • Enter the formula in the first cell and then use the fill handle to copy the formula. • Preselect the entire range for the formula. Enter the formula in the first cell and press Ctrl+Enter to simultaneously enter the formula in the entire selection. • Define the range as a table. Excel automatically copies new formulas entered in a table. See the section “Tables and Table Formulas” for more information.
 
 LET ME TRY IT
 
 Copying a Formula by Using Ctrl+Enter To copy a formula using Ctrl+Enter, follow these steps: 1. Select the range you want the formula to be in. 2. Type the formula in the first cell. 3. Press Ctrl+Enter. Excel copies the formula to all cells in the selected range.
 
 LET ME TRY IT
 
 Copying a Formula by Dragging the Fill Handle To copy a formula by dragging the fill handle, follow these steps: 1. Select the cell you want the formula to be in. 2. Type the formula in the first cell. 3. Press Ctrl+Enter to accept the formula and keep the cell as your active cell. 4. Click and hold the fill handle, which looks like a little black square in the lower-right corner of the selected cell. When the cursor is positioned correctly, it turns into a black cross, as shown in Figure 5.6. 5. Drag the fill handle to the last cell that needs to hold a copy of the formula. 6. Release the mouse button. The first cell is copied to all the cells in the selected range.
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 Fill Handle
 
 Figure 5.6 You can copy a formula by clicking and dragging the fill handle.
 
 If you have a large vertical range to copy the formula down, double-clicking the handle may work for you. See the “Copying Formulas Rapidly” section in Chapter 3 for details on how to do this.
 
 Formula Operators Excel offers the mathematical operators listed in Table 5.2. Table 5.2 Mathematical Operators Operator
 
 Description
 
 +
 
 Addition
 
 -
 
 Subtraction
 
 /
 
 Division
 
 *
 
 Multiplication
 
 ^
 
 Exponents
 
 ()
 
 Override the usual order of operations
 
 -
 
 Unary minus (for negative numbers)
 
 =
 
 Equal to
 
 >
 
 Greater than
 
 
=
 
 Greater than or equal to
 
 =, 
 
 Greater than
 
 A1>B1
 
 
=0
 
 C1,0,IF(D1=C1,D1*B1,A1)))
 
 Excel 2007 and 2010 allow 64 nested IF statements, but if you’re sharing the workbook with legacy Excel users, you’re limited to seven nested IF statements. Also, too many nested IF statements can be difficult to read, though you can use Alt+Enter to force linebreaks in a formula. An alternative is to create a User-Defined Function using Select Case statements. For more information on this, refer to Chapter 13, “Macros and UDFs.”
 
 IFERROR The IFERROR function works only in Excel 2007 and 2010. If you’re sharing the workbook with legacy Excel users, you will not be able to use this function.
 
 If there’s a chance a formula may return an error, use the IFERROR function to prevent the error from appearing in the cell. Instead of an error, a text message or other value may appear. In Figure 6.10, the top table uses a straightforward division formula to calculate the unit price. In F9, the column is summed, but returns an error because of the error in F5. The bottom table in Figure 6.10 uses IFERROR to return the text “No Sales” if an error occurs in the calculation, as shown in F12. In F17, the SUM formula is used again, but this time there isn’t an error in the range to throw Excel off, and so the sum is calculated.
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 Figure 6.10 Use IFERROR to resolve potential problems before they arise.
 
 Date and Time Functions Dates and times in Excel are not stored the same way we’re used to seeing them. For example, you may type 4/19/10 into a cell, but Excel actually sees 40287. That number, 40287, is called a date serial number. The formatted value, 4/19/10, is called a date value. Storing dates and times as serial numbers allows Excel to do date and time calculations. Time serial numbers are stored as decimals, starting at 0.0 for 12:00 a.m. and ending at 0.999305556 for 11:59 p.m. The rest of the day’s decimal values are equivalent to their calculated percentage, based on the number of hours in a day, 24. For example, 1:00 a.m. is 1/24 or .04166. 6:00 p.m. would be the 18th hour of the day, 18/24 = 0.75. Understanding how Excel stores dates and times is important so that you can successfully use formulas and functions when calculating with dates and times. You might already be familiar with the functions that return the system date and time. DATE() returns the system date. NOW() returns the system date and time. The next few sections review additional functions in Excel for dealing with dates and times.
 
 Convert and Breakdown Dates Table 6.2 lists the functions that can convert a date value to its serial value, or vice versa. It also lists the functions that can return part of a date, such as the month. The date used in the examples is April 19, 2010.
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 Table 6.2 Date Conversion Functions Function
 
 Description
 
 Example
 
 DATE
 
 Returns the serial number of a date. Note: since Excel automatically reformats date cells, you may have to format the cell to General yourself.
 
 =DATE(2010,4,19) returns 40287
 
 (year, month, day)
 
 DATEVALUE (date_text)
 
 Converts a text date to a serial number. Note: if =DATEVALUE(“4/19/10”) returns 40287 you try to use a date value, the function will return an error.
 
 DAY
 
 Returns the day from a serial number.
 
 =DAY(40287) returns 19
 
 Returns the month from a serial number.
 
 =MONTH(DATEVALUE(“4/19/10”)) returns 4
 
 Returns the year from a serial number.
 
 =YEAR(40287) returns 2010
 
 Returns the serial number of the date indicated by the months before or after the start date. Note that the start_date must be the serial number of the date.
 
 =EDATE(DATEVALUE(“4/19/10”),3.5) returns 40378, which is 7/19/2010
 
 Returns the serial number of the last day of the month indicated by the months before or after the start date. Note that the start_date must be the serial number of the date.
 
 =EOMONTH(40287, -3.5) returns 40209, which is 1/30/2010
 
 (serial_number) MONTH (serial_number) YEAR (serial_number) EDATE1 (start_date, months)
 
 EOMONTH1 (start_date, months)
 
 WEEKDAY
 
 Converts a serial number to a day of the week. (serial_number, [return_type]) Return_type is a value expressing what Excel should consider the first and last day of the week. The default is 1, meaning 1 is Sunday and 7 is Saturday.
 
 =WEEKDAY(40287) returns 2, which is Monday.
 
 WEEKNUM1
 
 =WEEKNUM(40287) returns 17, with the week starting on Sunday.
 
 Converts a serial number to a week number (serial_number, [return_type]) representing what week of the year the date falls on. Return_type is a value expressing what day of the week is the beginning of the week. 1
 
 =WEEKDAY(40287,3) returns 0 because the value 3 code tells the function to count Monday as the beginning of the week starting with 0 and ending with 6 for Sunday.
 
 =WEEKNUM(40287,12) returns 16 because the week doesn’t begin until Tuesday.
 
 Function was originally part of the Analysis Toolpak. If you send the workbook to a legacy Excel user who does not have the toolpak installed or active, the function will return an error.
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 Convert and Breakdown Times Table 6.3 lists the functions that can convert a time value to its serial value or vice versa. It also lists the functions that can return a part of a time, such as the hour. The time used in the examples is 4:53 p.m.
 
 Table 6.3 Time Conversion Functions Function
 
 Description
 
 Example
 
 TIME
 
 Returns the serial number of the specified time based on a 24-hour clock
 
 =TIME(16,53,0) returns 4:53 PM
 
 Converts a time in the form of text to a serial number
 
 =TIMEVALUE(“4:53 PM”) returns 0.70347
 
 (hour, minute, second) TIMEVALUE (time_text) HOUR (serial_number)
 
 Returns the hour in a serial number, based on a 24-hour clock =HOUR(0.70347) returns 16, which is 4 PM
 
 MINUTE
 
 Returns the minutes in a serial number
 
 =MINUTE(TIMEVALUE(“4:53 PM”)) returns 53
 
 Returns the seconds in a serial number
 
 =SECOND(0.70347) returns 0
 
 (serial_number) SECOND (serial_number)
 
 Date Calculation Functions The following functions were originally part of the Analysis Toolpak add-in. If you send the workbook to a legacy Excel user who does not have the add-in installed or active, the function will return an error.
 
 Table 6.4 lists functions that return calculated information, such as the end date based on a starting date, or the number of days between two dates. The date used in the examples is April 19, 2010.
 
 D a te a n d Ti m e Fu n c t i o n s
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 Table 6.4 Date Calculation Functions Function
 
 Description
 
 Example
 
 WORKDAY
 
 Returns the serial number of the date before or after a specified number of workdays. Holidays can be a range of dates, or an array constant list of serial dates.
 
 =WORKDAY(DATEVALUE(“4/19/2010”),3) returns 40290, which is 4/22/2010
 
 (start_date, days, [holidays])
 
 WORKDAY.INTL (start_date, days, [weekend], [holidays])
 
 =WORKDAY(DATEVALUE(“4/19/2010”),60,{40329, 40363}) 40329 is the serial value of May 31, 2010. 40363 is the serial value of July 4, 2010. Note that DATEVALUE could not be used within the array constant. Also the curly brackets were entered manually; this is not an array formula.
 
 Returns the serial number of the date =WORKDAY.INTL(4287,10,3) returns 40300, which is before or after a specified number of 5/2/2010. The code value of 3 told Excel Monday, workdays, taking into account which days Tuesday were to be considered weekends. during the week are considered weekends and what dates are holidays. Weekend is a code value. Holidays can be a range of dates, or an array constant list of serial dates.
 
 NETWORKDAYS
 
 Returns the number of workdays between =NETWORKDAYS(40287,DATEVALUE(“4/30/10”)) two dates. Holidays can be a range of returns 10. (start_date, dates, or an array constant list of serial end_date, [holidays]) dates. NETWORKDAYS.INTL (start_date, end_date, [weekend], [holidays])
 
 YEARFRAC (start_date, end_date, [basis])
 
 Returns the number of workdays between =NETWORKDAYS.INTL(40287,DATEVALUE(“4/30/10”),3) two days, taking into account which days returns 8. The code value of 3 told Excel Monday, during the week are considered weekends Tuesday were to be considered weekends. and what dates are holidays. Weekend is a code value. Holidays can be a range of dates, or an array constant list of serial dates. Returns a decimal year value of the number of whole days between dates. Basis is a code value of the type of date count basis to use.
 
 =YEARFRAC(DATE(2008,1,1),DATE(2009,1,1)) returns 1. The basic count of 0, the default, instructs Excel to count the days based on 30/360 American plan. =YEARFRAC(DATE(2008,1,1),DATE(2009,1,1),3) returns 1.002739. The basis code of 3 instructs Excel to count the actual days between the dates divided by 365.
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 Troubleshooting: Calculating with Dates As long as the dates on a sheet are serial dates, you can perform a variety of calculations with them.
 
 Calculate Days Between Dates If you need to find the number of days between two dates on a sheet, you can enter a direct formula, such as =F21-F20. After pressing Enter, you may get an odd answer, such as 1/25/1900. You didn’t have the cell formatted as date, but because the variables were dates, Excel feels the answer should be formatted as one. There’s nothing you can do about this—you will have to manually format the cell as general to get the actual number of days between the dates. If you get a ###### error, the formula is trying to subtract a new date from an older date.
 
 Dates Stored as Strings If you receive a sheet where the dates are stored as strings (you may see ’4/19/10 in a cell), there are two ways to convert the dates: either using Paste Special to add a blank cell onto the range or using text to columns to convert the column.
 
 LET ME TRY IT
 
 Using Paste Special to Convert Text to Dates To convert text dates to real dates using paste special, follow these steps: 1. Copy a blank cell. 2. Select the range of text dates to convert. 3. Go to Home, Clipboard, Paste, Paste Special, and select Add. 4. Click OK and the text dates will convert to dates that can be formatted and that Excel can do calculations with.
 
 D a te a n d Ti m e Fu n c t i o n s
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 Using Text to Columns to Convert Text to Dates To convert a column of text dates to real dates using text to columns, follow these steps: 1. Select the range of text dates. 2. Go to Data, Data Tools, Text to Columns. 3. From the wizard dialog that appears, click Next twice to reach step 3 of the wizard. You can go with the default settings of the first two steps. 4. In step 3, select the Date option and select the desired format. 5. Click Finish and the text dates will convert to dates that can be formatted and that Excel can do calculations with.
 
 Calculating Overtime You have a sheet similar to the one in Figure 6.11 where start and end times are entered; then the number of hours worked each day are calculated by subtracting the start time from the end time. At the end of the week, all the times are added together—and you get a number that is most definitely not correct, as shown in D7.
 
 Figure 6.11 A combination of the correct formatting and formulas will enable you to show overtime on timesheets. The problem isn’t the method of summing the column, but instead, the format applied to the cell. The standard format of h:mm can’t handle more than 24 hours. To get Excel to show more than 24 hours, change the format of the calculated cell to [h]:mm.
 
 See the section on date and time formatting in Chapter 4, “Data Formatting,” for more details on time formats.
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 SHOW ME
 
 Media 6.3—Calculating Times Over 24 Hours You can watch a free video of this task when you log on to my.safaribooksonline.com/9780132182287/media.
 
 LET ME TRY IT
 
 Calculating Overtime If you have a sheet with daily work times, and you need to calculate the total number of hours worked and also the overtime, follow these steps: 1. For each workday, calculate the time elapsed, as shown in cell E2 of Figure 6.11. 2. Select the range of elapsed time. 3. Go to Home, Editing, and click the AutoSum button. 4. Right-click the cell containing the totaled time and select Format Cells. 5. On the Number tab, select the Custom Category. 6. In the Type field, enter [h]:mm. Click OK to return to the sheet. 7. In the overtime cell, enter a MAX function that returns the greater of 0 or the calculated overtime. To calculate the overtime, divide the number at which overtime begins (example 40) by 24. Take that calculation and subtract it from the calculated time, as shown in D9. 8. Right-click the cell containing the overtime and select Format Cells. 9. On the Number tab, select the Custom Category. 10. In the Type field, enter [h]:mm. Click OK to return to the sheet. This is a precaution in case the amount of overtime exceeds 24 hours.
 
 Data Analysis Tools The Analysis Toolpak is an add-in that adds the Data Analysis button to the Data tab. The tool contains a variety of functions to assist in statistical and engineering analysis, as shown in Table 6.5.
 
 D a t a A n a l ys i s To o l s
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 Table 6.5 Data Analysis Tools Tool
 
 Description
 
 Anova: Single Factor
 
 Measures variance for two or more samples with a single variable.
 
 Anova: Two-Factor with Replication
 
 Measures variance for two or more samples with two variances.
 
 Anova: Two-Factor without Replication
 
 Measures variance for two or more samples with two variances, allowing for only a single observation per pair.
 
 Correlation
 
 Measures the extent to which two measurement variables vary together, independent of the units involved. Coefficients are scaled to lie between -1 and +1, inclusive.
 
 Covariance
 
 Measures the extent to which two measurement variables vary together. Coefficients are not scaled.
 
 Descriptive Statistics
 
 Generates a report of univariate statistics for data in the input range, providing information about the central tendency and variability of the data.
 
 Exponential Smoothing
 
 Predicts a value that is based on the forecast for the prior period, adjusted for the error in that prior forecast.
 
 F-Test Two-Sample for Variances
 
 Performs a two-sample F-test to compare two population variances.
 
 Fourier Analysis
 
 Uses the Fast Fourier Transform method to solve problems in linear systems and analyze periodic data.
 
 Histogram
 
 Calculates individual and cumulative frequencies for a cell range of data and data bins.
 
 Moving Average
 
 Projects values in the forecast period, based on the average value of the variable over a specific number of preceding periods.
 
 Random Number Generator
 
 Fills a range with independent random numbers drawn from one of several distributions.
 
 Rank and Percentile
 
 Produces a table containing the ordinal and percentage rank of each value in a data set.
 
 Regression
 
 Performs linear regression analysis using the least squares method to fit a line through a set of observations.
 
 Sampling
 
 Creates a sample from a population by treating the input range as a population.
 
 t-Test: Paired Two Sample for Means
 
 Tests for equality of the population means underlying the sample by assuming the two samples represent before-treatment and after-treatment observations on the same subjects.
 
 t-Test: Two-Sample Assuming Equal Variances
 
 Tests for equality of the population means underlying the sample by assuming the population variances are equal.
 
 t-Test: Two-Sample Assuming Unequal Variances Tests for equality of the population means underlying the sample by assuming the population variances are not equal.
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 Table 6.5 Data Analysis Tools Tool
 
 Description
 
 z-Test: Two Sample for Means
 
 Performs a two sample z-Test for means with known variances.
 
 To enable the Analysis Toolpak: 1. Go to File, Options, Add-Ins. 2. From the Manage drop-down at the bottom of the Excel Options dialog, select Excel Add-ins and click Go. 3. Select Analysis ToolPak from the Add-ins dialog. If Analysis ToolPak is not listed, click Browse to locate it. If prompted that the Analysis ToolPak is not currently installed on the computer, click Yes to install it. 4. Click OK and Excel will load the add-in. It will be available whenever Excel is opened. For detailed help on using the data analysis tools, see Microsoft Excel 2010 In Depth, by Bill Jelen (ISBN 0-7897-4308-6).
 
 Goal Seek Goal Seek, found under Data, Data Tools, What-If Analysis, adjusts the value of a cell to get a specific result from another cell. For example, if you have the price, term, and rate of a loan, you can use the PMT function to calculate the payment. But what if the calculated payment wasn’t satisfactory and you wanted to recalculate with additional prices? You could take the time to enter a variety of prices, recalculating the payment. Or use Goal Seek to tell Excel what you want the payment to be and let it calculate the price for you.
 
 SHOW ME
 
 Media 6.4—Using Goal Seek to Return a Value You can watch a free video of this task when you log on to my.safaribooksonline.com/9780132182287/media.
 
 Us i n g t h e Wi z a rd to Tro u b l e s h o o t Fo r m u l a s
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 Using Goal Seek To use Goal Seek to return a value, follow these steps: 1. Select the cell whose value you want to be a specific value. 2. Go to Data, Data Tools, What-If Analysis, Goal Seek. 3. In the Set Cell field should be the address of the cell selected in step 1. If not, select the cell whose value you want sought. 4. In the To Value field, enter the value you want the Set Cell to be. 5. In the By Changing Cell field, select the cell whose value you want Excel to change so the Set Cell field calculates to the desired value. 6. Click OK. Excel will attempt to return a solution as close to the desired value as possible.
 
 Using the Wizard to Troubleshoot Formulas If you have one function using other functions as arguments and the formula returns an error, you can use the function wizard to track down which function is generating the error. To do this, place your cursor in the function name in the formula bar and click the fx button. The function wizard will open, with the selected function filled in. You can review the arguments to make sure they are correct and falling into the correct fields. To check the next function, click the function name in the formula bar—you do not need to close the wizard and start from the beginning.
 
 LET ME TRY IT
 
 Troubleshooting a Formula To troubleshoot a formula through the function wizard, follow these steps: 1. Select the cell with the formula to troubleshoot. 2. Click one of the functions in the formula bar. 3. Click the fx button to the left of the formula bar. The Function Arguments dialog (also known as the function wizard) appears for the selected function, with its arguments filled in.
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 4. If you see the error in the selected function, you can fix it and click OK to recalculate the formula. Otherwise, continue to the next step. 5. If you do not see what is causing the error, click another function in the formula bar. Repeat this step until you have inspected all the functions or resolved the issue.
 
 This chapter will show you the various ways you can sort your data, even by color.
 
 7
 
 Sorting Sorting data is a significant capability in Excel, allowing you to view data from least to greatest, greatest to least, by color, or even by your own customized sort listing. This chapter shows you the variety of ways you can sort your data in Excel.
 
 Preparing Data Your data should adhere to a few basic formatting guidelines to make the most of Excel’s sorting capabilities: • There should be no blank rows or columns. The occasional blank cell is acceptable. • Every column should have a header. • Headers should be in only one row; otherwise, Excel gets confused and is unable to find the header row on its own.
 
 Sorting in the Web App The sorting capabilities in the Web App are not nearly as extensive as the ones in Excel and Excel Starter, reviewed in the rest of this chapter. To sort in the Web App, select a cell in the data and click Home, Tables, Sort & Filter as Table. Excel will verify the data range before turning it into a table. After the range is a table, you can select to sort a column ascending or descending by clicking the filter arrow in the column header and selecting Sort Ascending or Sort Descending.
 
 The Sort Dialog The Sort dialog has four entry points: • On the Home tab, select Editing, Sort & Filter, Custom Sort. • On the Data tab, select Sort & Filter, Sort (this works only for Excel, not Excel
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 Starter or the Web App). • Right-click any cell and select Sort, Custom Sort. • From a filter drop-down, select Sort by Color, Custom Sort. The Sort dialog allows up to 64 sort levels. Through the dialog, you can sort multiple columns by values, cell color, font color, or by conditional formatting icons. The sort order can be ascending, descending, or by a custom list (see the section on Sorting Non-Alphabetically for more information on custom lists). If your data has headers, they will be listed in the Sort by drop-down; otherwise, the column headings will be used.
 
 Sorting by Values When you use the Sort dialog, Excel applies each sort in the order it appears in the list. In Figure 7.1, the Region column will be sorted first. The second column to be sorted will be the Customer column. When you look at the data after it is sorted, you’ll notice the regions are grouped together; for example, Central will be at the top of the list. Within Central, the customer names will be alphabetized. If you scroll down to the next region, East, the customer names will be alphabetized within that region. If the data should have listed the customers and then the regions, the two sort fields need to be switched so that Excel sorts the Customer field first and the Region field second.
 
 Figure 7.1 Use the Sort dialog to sort data by multiple levels.
 
 SHOW ME
 
 Media 7.1—Sorting Values with the Sort Dialog Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 Th e S o r t D i a l o g
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 Sorting Values To sort data by values, follow these steps: 1. Ensure that the data has no blank rows or columns and that each column has a one-row header. 2. Select a cell in the data. Excel will use this cell to determine the location and size of the data. 3. Go to Home, Editing, Sort & Filter, Custom Sort to open the Sort dialog. 4. Make sure the My Data Has Headers check box is selected. Excel will not select the headers themselves. 5. Make sure all the data’s columns are selected. If they are not all selected, a blank column exists, confusing Excel as to the size of your data. 6. From the Sort By drop-down, select the first column header to sort by. 7. From the Sort On drop-down, select Values. 8. From the Order drop-down, select the order by which the column’s data should be sorted. 9. If you need to sort by another column, click Add Level and repeat steps 6 to 8. Repeat these steps until all the columns to sort by are configured, as shown in Figure 7.1. 10. If you realize that a field is in the wrong order, use the up or down arrows to move it to the correct location. 11. Click OK to sort the data.
 
 Sorting by Color or Icon Although sorting by values is the most typical use of sorting, Excel can also sort data by fill color, font color, or icon set from conditional formatting. You can apply fill and font colors through conditional formatting or the cell format icons. In addition to sorting colors and icons through the sort dialog, the following options are also available when you right-click a cell and select Sort from the context menu: • Put Selected Cell Color on Top
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 • Put Selected Font Color on Top • Put Selected Cell Icon on Top If you use one of the preceding options to sort more than one color or icon, the latest selection will be placed above the previous selection. So, if yellow rows should be placed before the red rows, sort the red rows first, and then the yellow rows.
 
 LET ME TRY IT
 
 Sorting by Color Using the Sort Dialog To sort data by the color fill in the cells using the sort dialog, follow these steps: 1. Ensure that the data has no blank rows or columns and that each column has a one row header. 2. Select a cell in the data. Excel will use this cell to determine the location and size of the data. 3. Right-click the cell and select Sort, Custom Sort. 4. Make sure the My Data Has Headers check box in the upper-right corner is selected. Excel will not select the headers themselves. 5. Make sure all the data’s columns are selected. If they are not all selected, a blank column exists, confusing Excel as to the size of your data. 6. From the Sort By drop-down, select the first column header to sort by. 7. From the Sort On drop-down, select Cell Color. 8. From the first Order drop-down, select the color by which the column’s data should be sorted. 9. From the second Order drop-down, select whether the color should be sorted to the top or bottom of the data. If you select multiple colors to sort at the top of the data, the colors will still appear in the order chosen. 10. If you need to sort by another column, click Add Level and repeat steps 6 to 9. Repeat these steps until all the columns to sort by are configured. 11. If you realize a field is in the wrong order, use the up or down arrows to move it to the correct location. 12. Click OK to sort the data.
 
 Us i n g t h e Q u i c k S o r t B u t to n s
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 Doing a Case-Sensitive Sort Normally, Excel doesn’t pay attention to case when sorting text: ABC is the same as abc. If case is important in the sort, you need to direct Excel to include case as a parameter. This is done from the Options in the Sort dialog. If Case Sensitive is selected, Excel will sort lowercase values before uppercase values in an ascending sort.
 
 Using the Quick Sort Buttons The quick sort buttons offer one-click access to sorting cell values. They do not work with colors or icons. There are four entry points to the quick sort buttons: • On the Home tab, select Editing, Sort & Filter, Sort A to Z1 or Sort Z to A1. • On the Data tab, select Sort & Filter, AZ or ZA (available only in Excel, not Excel Starter or the Web App). • Right-click any cell and select Sort, Sort A to Z1 or Sort Z to A1. • From a filter drop-down, select Sort A to Z1 or Sort Z to A1. The quick sort buttons are very useful when sorting a single column. When sorting just one column, make sure you select just one cell in the column. If you select more than one cell, Excel will sort the selection, not the column. Also ensure there are no adjacent columns or Excel will want to include them in the sort. If there are adjacent columns, then select the entire column before sorting. If you use the quick sort buttons to sort a table of more than one column, Excel will sort the entire table automatically. Because there is no dialog, it’s very important that every column have a header. If just one header is missing, Excel will not treat the header row as such and will include it in the sorted data.
 
 Quick Sorting Multiple Columns If you keep in mind that Excel keeps previously sorted columns sorted as new columns are sorted, you can use this to sort multiple columns. For example, if column A is sorted, Excel doesn’t randomize the data in column A when column B is
 
 1
 
 The actual button text may change depending on the type of data in the cell. For example, if the column contains values, the text will be Sort Smallest to Largest. If the column contains text, it will be Sort Z to A.
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 sorted. Instead, column A retains its sort to the degree it falls within the column B sort. The trick is to apply the sorts in reverse to how they would be set up in the sort dialog.
 
 SHOW ME
 
 Media 7.2—Using the Quick Sort Buttons to Sort Multiple Columns Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 LET ME TRY IT
 
 Using the Quick Sort Buttons to Sort Multiple Columns To sort multiple columns in a table using the quick sort buttons, follow these steps: 1. Make sure all columns have headers. If even one column header is missing, Excel will not sort the data properly. 2. Select a cell in the column that should be sorted last. 3. Click the desired quick sort button on Home, Editing, Sort & Filter. 4. Select a cell in the next column to be sorted. 5. Click the desired quick sort button on Home, Editing, Sort & Filter. 6. Repeat steps 4 and 5 until all desired columns are sorted.
 
 Random Sort Excel doesn’t have a built-in tool to do a random sort, but by using the RAND function in a column by the data and then sorting, you can create your own randomizer.
 
 LET ME TRY IT
 
 Randomizing Data To randomize data in a column, follow these steps: 1. Add a new column to the right of the data. Give the column a header.
 
 S o r t i n g w i t h a Cu s to m S e q u e n ce
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 2. In the first cell of the new column, type =RAND() and press Ctrl+Enter (this will keep the formula cell as the active cell). The formula will calculate a value between 0 and 1. 3. Double-click the fill handle in the lower-right corner of the cell to copy the formula to the rest of the rows in the column. 4. Select one cell in the new column. 5. Go to Home, Editing, Sort & Filter, AZ. The list will be sorted in a random sequence, as shown in Figure 7.2.
 
 Figure 7.2 Use the RAND function with a sort to randomize data. 6. Delete the data in the temporary column that you added in step 1.
 
 Right after Excel performs the sort, it recalculates the formula in the temporary column, so it may appear that the numbers are out of sequence.
 
 Sorting with a Custom Sequence At times, data may need to be sorted in a custom sequence that is neither alphabetical nor numerical. For example, you may want to sort by month, by weekday, or by some custom sequence of your own. You can do this by sorting by a custom list.
 
 Using a Custom List Within the Sort dialog, you can select Custom List from the Order field for each level of sort configured. When this option is selected, the Custom Lists dialog appears from which you can select the custom list to sort the selected column by.
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 Sorting by a Custom List To sort one or more columns based on a custom list, follow these steps: 1. Ensure that the data has no blank rows or columns and that each column has a one row header. 2. Select a cell in the data. Excel will use this cell to determine the location and size of the data. 3. Go to Home, Editing, Sort & Filter, Custom Sort to open the Sort dialog. 4. Make sure the My Data Has Headers check box in the upper-right corner is selected. Excel will not select the headers themselves. 5. Make sure all the data’s columns are selected. If they are not all selected, a blank column exists, confusing Excel as to the size of your data. 6. From the Sort By drop-down, select the first column header to sort by. 7. From the Sort On drop-down, select Values. 8. From the Order drop-down, select Custom List. The Custom Lists dialog, shown in Figure 7.3, appears.
 
 Figure 7.3 Data can be sorted by a custom list, such as the days of the week.
 
 9. The list box on the left provides a list of available custom lists. Selecting one will display all the entries in the right list box. Select the desired list and click OK. 10. If you need to sort by other columns, click Add Level. Otherwise, skip to step 13.
 
 R e a r r a n gi n g Co l u m n s
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 11. Repeat steps 6 to 9. If you don’t need to use another custom list, select the desired order from the drop-down instead of Custom List. 12. If you realize that a field is in the wrong order, use the up or down arrows to move it to the correct location. 13. Click OK to sort the data.
 
 TELL ME MORE
 
 Media 7.3—Creating Custom Lists
 
 To listen to a free audio recording about creating custom lists, log on to my.safaribooksonline.com/9780132182287/media.
 
 Rearranging Columns If you receive a report where you’re always having to rearrange the columns to suit yourself, the following methods may prove to be very useful.
 
 Using the Sort Dialog Using the option of sorting left to right instead of top to bottom, you can rearrange the columns on your sheet.
 
 SHOW ME
 
 Media 7.4—Rearranging Columns Using the Sort Dialog Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Rearranging Columns To rearrange the columns on a sheet, follow these steps: 1. Insert a new blank row above the headers. 2. In the new row, type numbers corresponding to the new sequence of the columns. 3. Select a cell in the data range.
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 4. Press Ctrl+* (or Ctrl+Shift+8) to select the current region, including the two header rows. 5. Go to Home, Editing, Sort & Filter, Custom Sort to open the Sort dialog. 6. Click the Options button to open the Sort Options dialog. 7. Select Sort Left to Right. 8. Click OK to return to the Sort dialog. 9. In the Sort By drop-down, select the row in which the numbers you added in step 2 are located. 10. In the Order drop-down, make sure Smallest to Largest is selected. 11. Click OK and Excel will rearrange the columns. 12. Delete the temporary row added in step 1.
 
 Using the Mouse If you have just a few columns to rearrange, you can use a combination of keyboard shortcuts and the mouse to rearrange them quickly.
 
 LET ME TRY IT
 
 Rearranging a Few Columns If you have only a few columns to rearrange, follow these steps to rearrange them using the keyboard and mouse: 1. Select a cell in the column to move. 2. Press Ctrl+spacebar to select the entire column. 3. Place the cursor on the black border surrounding the selection, hold down the right mouse button, and drag the column to the new location. 4. When you release the mouse button, a context menu appears, as shown in Figure 7.4. Select Shift Right and Move. 5. The data will rearrange itself, inserting the column in the new location and moving other columns over to the right to make room.
 
 Fi x i n g S o r t Pro b l e m s
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 Figure 7.4 Use Shift Right and Move to quickly move a column to a new location.
 
 Fixing Sort Problems If it looks like the data did not sort properly, refer to the following list of possibilities: • Make sure no hidden rows or columns exist. • Use a single row for headers. If you need a multiline header, either wrap the text in the cell or use Alt+Enter to force line breaks in the cell. • If the headers were sorted into the data, there was probably at least one column without a header. • Column data should be of the same type. This may not be obvious in a column of ZIP Codes where some, such as 57057 are numbers, but others that start with 0s are actually text. To solve this problem, convert the entire column to text. • If sorting by a column containing a formula, Excel will recalculate the column after the sort. If the values change after the recalculation, it may appear that the sort did not work properly, but it did.
 
 This page intentionally left blank
 
 This chapter shows you how to use Excel’s filtering functionality to look at just the desired records. It will also show you how to create a list of unique items and consolidate data.
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 Filtering and Consolidating Data Filtering and consolidating data are important tools in Excel, especially when you are dealing with large amounts of data. The filtering tools can quickly reduce the data to the specific records you need to concentrate on. The consolidation tool can bring together information spread between multiple sheets or workbooks.
 
 Preparing Data To make the most out of Excel’s filtering capabilities, your data should adhere to a few basic formatting guidelines: • There should be no blank rows or columns. The occasional blank cell is acceptable. • There should be a header above every column. • Headers should be in only one row; otherwise Excel will get confused and be unable to find the header row on its own.
 
 Applying a Filter to a Dataset To activate the filtering option, select a single cell in the dataset and use one of the following: • On the Home tab, select Editing, Sort & Filter, Filter. • On the Data tab, select Sort & Filter, Filter (works only in Excel, not Excel Starter or the Web App). • When a dataset is turned into a table (Insert, Tables, Table), the headers automatically become filter headers. This is the only method for turning on filters in the Web App.
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 It is very important to select only a single cell because it is possible to turn on filtering in the middle of a dataset if you have more than one cell selected.
 
 In Excel and Excel Starter, the Filter button is a toggle button. Click it once to turn filtering on and click it again to turn filtering off. When a filter is applied to a dataset, drop-down arrows appear in the column headers. One or more selections can be made from each drop-down, filtering the data below the headers. Filters are additive, which means that each time a filter selection is made, it works with the previous selection to further filter the data. When filters are in use in Excel and Excel Starter, the numbered row headings turn blue. In all Excel applications, an icon will replace the arrow on the column headers that have a filter applied. Although it may look as if the filtered rows are deleted, they are only hidden. After filtering is cleared, all rows reappear.
 
 Clearing a Filter A filter can be cleared from a specific column or for the entire dataset. To clear all the filters applied to a dataset, use one of the following methods: • On the Home tab, select Editing, Sort & Filter, Clear. • On the Data tab, select Sort & Filter, Clear. • Turn off the Filter entirely using one of the following methods: • On the Home tab, select Editing, Sort & Filter, Filter. • On the Data tab, select Sort & Filter, Filter (works only in Excel, not Excel Starter or the Web App). To clear all the filters applied to a specific column, use one of the following methods: • Click the filter drop-down arrow and select Clear Filter From column header. • Click the filter drop-down arrow and select Select All from the filtering list. • Right-click a cell in the column to clear and select Filter, Clear Filter From column header.
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 Reapplying a Filter If data is added to a filtered range, Excel does not automatically update the view to hide any new rows that don’t fit the filter settings. You can refresh the filters settings so they include the new rows through one of the following methods: • On the Home tab, select Editing, Sort & Filter, Reapply. • On the Data tab, select Sort & Filter, Reapply. • Right-click a cell in the filtered dataset and select Filter, Reapply.
 
 Filtering in the Web App A workbook with normal or table filtering can be uploaded, and users in View or Edit mode can interact with the filters. The only way to turn on filtering in an uploaded workbook is to be in Edit mode and to turn the dataset into a table by selecting a cell in the dataset and going to Home, Tables, Sort & Filter as Table or Insert, Tables, Table. After a dataset has been turned into a table in the Web App, it cannot be turned back unless it is opened in Excel or Excel Starter. The filtering options in the Web App work a bit differently from Excel and Excel Starter, but offer many of the same options. To get to the filtering list, click the columns drop-down and select Filter. A separate dialog window appears, from which you can select one or more items. See the section “Filter Listing for Listed Items” for more details. Most of the Text, Number, and Date Filters options are also available—see the section “Using Text, Number, and Date Special Filters” for more information.
 
 Sometimes you may upload a workbook where the filters are already set and rows are hidden, but when you look at the drop-down, you don’t see the option to clear the filter. To force the filters to reset, select Filters from the drop-down to bring up the filter listing. Select one item from the list and click OK. The Clear Filter from column header option should now be available.
 
 Turn Filtering on for One Column Filtering can be turned on for a single column or for two or more adjacent columns. This can be useful if you want to limit the filtering users can apply. If the sheet is then protected, users cannot turn on filtering for the other columns (see the Allow Filtering on a Protected Sheet section for more information). A workbook uploaded to the Web App will retain this setting.
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 To control what column has filtering, select the header and first cell directly beneath the header. Then do one of the following: • On the Home tab, select Editing, Sort & Filter, Filter. • On the Data tab, select Sort & Filter, Filter.
 
 Filtering Options You can use several methods for filtering from the filter drop-down after the filter is turned on, as shown in Figure 8.1. The next several sections review these methods.
 
 Figure 8.1 The filter drop-down provides several filtering methods.
 
 Filter Listing for Listed Items The filter listing is probably the most obvious filter tool when you open the dropdown. For text, numbers, and ungrouped dates, a listing of all unique items in the column appears (see the “Grouped Dates Filter Listing” section if dates appear grouped by year and month). All items will be checked, because they are all visible the first time you open the drop-down, but you can select just the items that should appear in the data. Any item that no longer bears a check mark will be hidden.
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 Filtering a Column for Specific Items To filter a column for specific items, follow these steps:
 
 If filtering an existing table, skip to step 3.
 
 1. Select a single cell in the dataset to apply filtering to. 2. In Excel or Excel Starter, go to Home, Sort & Filter, Filter. In the Web App, go to Home, Sort & Filter as Table. The Web App will verify the range to be converted to a table. Click OK to continue. 3. Open the drop-down of the column to filter. 4. If in Excel or Excel Starter, skip to step 5. Otherwise, in the Excel Web App, click Filter in the drop-down to open the filter listing dialog. 5. Unselect the Select All item to clear all the check marks in the list. 6. Select the item(s) to be viewed in the dataset. 7. Click OK. The sheet will update, showing only the item(s) selected.
 
 Grouped Dates Filter Listing This section applies to dates that are grouped, as shown in Figure 8.2. In Excel and Excel Starter, the grouping is controlled by a setting found under File, Options, Advanced, Display Options for This Workbook, Group Dates in the AutoFilter Menu. By default, this option is selected. If unselected, the dates will appear in a list like the filter for number and text items. You can refer to the section on “Filter Listing for Listed Items” for more information on that filter listing. Dates in the filter listing are grouped by year, month, and day. All items will be checked, because they are all visible the first time you open the drop-down, but you can select just the items that should appear in the data. Any item that no longer bears a check mark will be hidden. If you click the + icon by a year, it opens up, showing the months. Click the + icon by a month and it opens up to show the days of the month. An entire year or month can be selected or unselected by clicking the desired year or month. For example, to deselect 2009 and January 2010 in Figure 8.2, deselect the 2009 group,
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 then deselect the January group under 2010. The data will filter to show only February and March 2010.
 
 Figure 8.2 With the group dates option selected, dates appear grouped by year, month, and day in the filter listing.
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 Filtering a Column for Specific Dates To filter a column for specific dates, follow these steps:
 
 If filtering an existing table, skip to step 3.
 
 1. Select a single cell in the dataset to apply filtering to. 2. In Excel or Excel Starter, go to Home, Sort & Filter, Filter. In the Web App, go to Home, Sort & Filter as Table. The Web App will verify the range to be converted to a table. Click OK to continue. 3. Open the drop-down of the column to filter. 4. If in Excel or Excel Starter, skip to step 5. Otherwise, in the Excel Web App, click Filter in the drop-down to open the filter listing dialog. 5. Deselect the Select All item to clear all the check marks in the list. 6. Click the + icon to the left of the desired year.
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 7. Click the + icon to the left of the desired month. 8. Select the desired days. 9. Repeat steps 6 to 8 as needed. 10. Click OK. The sheet updates, showing only the dates selected.
 
 Searching Functions for Listed Items If you have a long list of items in the filter listing, you can search for items to include or exclude from the filter. Searches are done on the entire data list, not just the items currently filtered on. Use an asterisk (*) as a wildcard for one or more characters before, after, or in between any of the search terms.
 
 SHOW ME
 
 Media 8.1—Using the Search Function to Include and Exclude Items in the Filtering Listing Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 Searching for Items to Include in Filter When a search term is entered in the search field, the filter listing updates with all matches selected. You can deselect the items you want to filter out, check Add Current Selection to Filter if you do not want to lose any items you previously filtered for, and click OK. You should keep two things in mind when using the search function: • The search looks through the entire column, including items you may have already filtered out. • The search function is additive when the Add Current Selection to Filter is selected. If not selected, each search’s results are treated as a new filter.
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 Using the Search Function to Filter Items To perform multiple searches to filter items, follow these steps: 1. Open the drop-down of the column to filter. 2. Enter the first term, or partial term, to filter by.
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 3. If you want to filter by all the resulting terms, skip to step 6. Otherwise, continue to step 4. 4. Deselect Select All Search Results. 5. Select the desired items from the search results. 6. Click OK. 7. Open the drop-down of the column to filter again. 8. Enter the second term, or partial term, to filter by. 9. If you want to filter by all the resulting terms, click OK and skip to step 12. Otherwise, continue to step 10. 10. Deselect Select All Search Results. 11. Select the desired items from the search results. 12. Select Add Current Selection to Filter. 13. Click OK.
 
 Searching for Items to Exclude from Filter The search function can also be used to exclude items from the filter. You do this by entering a search term, deselecting the items to exclude from the results, and then selecting the Add Current Selection to Filter. You should keep three things in mind when using the search function to exclude items: • The search looks through the entire column, including items you may have already filtered out. • To exclude items from the listing, deselect them from the result. • The search function is additive when the Add Current Selection to Filter is selected. If not selected, each search’s results are treated as a new filter.
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 Using the Search Function to Exclude Items from Results To exclude items from a list of filtered results, as shown in Figure 8.3, follow these steps:
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 Figure 8.3 Use the search function to exclude items from a filtered list. 1. Open the drop-down of the column to filter. 2. Enter the first term, or partial term, to filter by. 3. If you want to filter by all the resulting terms, skip to step 6. Otherwise, continue to step 4. 4. Deselect Select All Search Results. 5. Select the desired items from the search results. 6. Click OK. 7. Open the drop-down of the column to filter again. 8. Enter the exclusion term. 9. If you want to filter out all the resulting terms, skip to step 12. Otherwise, continue to step 10. 10. Deselect Select All Search Results. 11. Select the desired items from the search results. 12. Select Add Current Selection to Filter. 13. Click OK.
 
 Using the Search Function for Grouped Dates If you have a lot of dates in the filter listing, you can search for specific years, months, or dates to include or exclude from the filter. Searches are done on the entire data list, not just the items currently filtered on. The search function for grouped dates includes a drop-down, allowing you to search by year, month, or date. It does not allow you to search for an entire date, such as 04/19/2010. • Year—Search results will be grouped by year. • Month—Search results will be grouped by year and then month. The search term must be the long version of the month, such as January.
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 • Date—Search results will be grouped by year, then month, then day. Because the search will return partial matches, you should use the two-digit variation for dates. For example, to search for the 1st of a month, enter 01 instead of 1. If you enter 1, every date with a 1, such as 10, 11, 12, will be returned. • All—Search results will be grouped by year, then month, then day. This option looks for a match anywhere in the date. For example, if your dataset includes dates from 2009 and the search term is 09, all dates from 2009 will be returned. If you want only the 9th day returned, use the Date option. Because searches are additive, proper application of the Add Current Selection to Filter in the search results allows you to include or exclude the results from the filter. For more information, see the sections “Searching for Items to Include in Filter” and “Searching for Items to Exclude from Filter.”
 
 SHOW ME
 
 Media 8.2—Using the Search Function to Filter for Specific Dates Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Filtering for Specific Days from All Months in a Specific Year. To filter for specific days from each month of a specific year, follow these steps: 1. Open the drop-down of the date column to filter. 2. Select Date from the Search drop-down. 3. Type in the two-digit date. 4. Deselect Select All Search Results. 5. Scroll down the filter listing and select the year of the data to include in the filter. Selecting the year will automatically select all the months and dates in the year’s group. 6. Click OK. 7. Open the drop-down of the date column to filter again. 8. Select Date from the Search drop-down.
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 9. Type in the two-digit date. 10. Deselect Select All Search Results. 11. Select Add Current Selection to Filter. 12. Scroll down the filter listing and select the year of the data to include in the filter. 13. Click OK. 14. Repeat steps 7 to 13 if you want to include more dates in the filter.
 
 Using Text, Number and Date Special Filters Special filters are available in the filter drop-down depending on which data type (text, numbers, or dates) appears most often in a column. All the special filters, except for ones that take action immediately, open the Custom AutoFilter dialog, allowing two conditions to be combined using AND or OR. If the column contains mostly text, Text Filters will be available with the options Equals, Does Not Equal, Begins With, Ends With, Contains, and Does Not Contain. Selecting one of these opens a Custom AutoFilter dialog in which text can be entered. Wildcards can also be used in the text fields. Use an asterisk (*) to replace multiple characters or a question mark (?) to replace a single character. If the column contains mostly numbers, Number Filters will be available with the options Equals, Does Not Equal, Greater Than, Greater Than Or Equal To, Less Than, Less Than or Equal To, Between Top 10, Above Average, and Below Average. Selecting Top 10, Above Average, or Below Average will automatically update the filter to reflect the selection. If Top 10 is selected, you can specify the top or bottom items or percent to view. For example, you could choose to view the bottom 15% or the top 7 items. For columns with dates, the special filter offers a wide selection of options, including additional options under All Dates in the Period, as shown in Figure 8.4. The Custom AutoFilter dialog for dates includes calendars to aid in data entry. The options dealing with quarters refer to the traditional quarter of a year, January through March being the first quarter, April through June being the second quarter, and so on.
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 Figure 8.4 There are numerous options for filtering dates.
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 Filtering a Numeric Column for a Value Range To filter a numeric column for a value range as shown in Figure 8.5, follow these steps: 1. Open the drop-down of the numeric column to filter. 2. Select Number Filters, Greater Than. The Custom AutoFilter appears. 3. The top-left drop-down should already have Is Greater Than selected, but if not, select it from the drop-down. 4. The top-right drop-down lists all the values in the column. You may select one of those or enter your own value. 5. Between the top and bottom drop-down, make sure AND is selected. 6. In the bottom-left drop-down, select Is Less than.
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 7. In the bottom-right drop-down, select a value from the list or enter your own value. 8. Click OK. The sheet will update, showing only the values that fell within the selected range.
 
 Figure 8.5 Use the special filters to filter a list for a range of values.
 
 Filtering by Color or Icon Data can be filtered by font color, color (set by cell fill or conditional formatting) or icon by going to the Filter by Color option in the filter listing, as shown in Figure 8.6. There, colors and/or icons used in the column are shown. Filter selections are additive, so if you first select to filter all green rows and then red circles, the filter range will reflect rows that have a green fill and red circle.
 
 Figure 8.6 The Filter by Color option allows you to filter by font color, fill color, or icon.
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 Filtering By Selection Even without the filter turned on, you can right-click any cell in a column, go to Filter, and choose to filter by the cell’s value, color, font color, or icon. Doing so will turn on the filter and configure the filter for the selected cell’s property. The filtering is additive. If you filter a cell by one value and then go to a cell in another column and filter by its value, the result will be those rows that satisfy both filter criteria. You cannot filter by a property more than once within the same column, but you can filter a column by multiple properties—for example, filter by icon and then value.
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 Using Filter Selection To use filter selection to view records meeting a specific value and font color, follow these steps: 1. Right-click a cell containing the value to filter by. 2. Go to Filter, Filter by Selected Cell’s Value. 3. Right-click a cell containing the font color to filter by. 4. Go to Filter, Filter by Selected Cell’s Font Color.
 
 Allow Filtering on a Protected Sheet Normally, if you set up filters on a sheet, protect the sheet, and then send it out to other users, the recipients won’t be able to filter the data. If you want others to be able to filter your protected sheet, follow these steps:
 
 If filtering an existing table, skip to step 3.
 
 1. Select a single cell in the dataset to apply filtering to. 2. Go to Home, Sort & Filter, Filter. The filter will be turned on for the dataset. 3. Go to Review, Changes, Protect Sheet. 4. In the listing for All Users of This Worksheet To, scroll down and select Use AutoFilter.
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 5. If applying a password to the sheet, enter it in the Password to Unprotect Sheet field. Otherwise, skip to step 6. 6. Click OK. 7. If you entered a password in step 5, Excel will prompt you to reenter the password. Do so and click OK.
 
 Using the Advanced Filter Despite the visual simplicity of the Advanced Filter dialog, it can perform a variety of functions. Depending on the options selected and the setup on the sheet, the Advanced Filter can do the following: • Filter records in place • Filter records to a new location on the same or different sheet • Reorganize columns • Use formulas as criteria • Filter for unique records Select either Filter the List, In-Place or Copy to Another Location to tell the function where to put the resulting dataset. If copying the results to a new location, specify the location in the Copy To field. When specifying the range • If the results include all columns of the dataset in the original order, only the location of the first header needs to be specified. • If the results consist of any change to the headers, whether it’s a new order or fewer headers, copy the headers to use in the desired order to a new location. The Copy To range must include the entire new range of headers. • If results need to be on another sheet, the Advanced Filter must be called from the sheet where the results will be placed. List Range is the dataset, including required headers. Most Advanced Filter functions require each column to have a header. The Criteria Range is where rules are configured for the filter. See “Using the Criteria Range” section for details. Select Unique Records Only if duplicates should not be included in the results. See the “Filtering for Unique Items” section for an example of how the option is useful for removing duplicates from a single column.
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 Using the Criteria Range Criteria can consist of exact values, values with operators, wildcards, or formulas. You should keep the following things in mind when setting up the criteria range: • Except for when the criterion is a formula, the first row must consist of the column header used by the filter. • Starting in the second row, enter the criterion to filter for in the column. • Criteria entered on the same row are read as joined by AND. In the top table of Figure 8.7, the criteria in the first row is read West AND ABC.
 
 Figure 8.7 The top table shows the criteria properly configured to return all ABC products for West and East regions. The configuration of the bottom table’s criteria will return ABC products for West, but all products for East.
 
 • Criteria entered on different rows are read as joined by OR. In the top table of Figure 8.7, the criteria is read West AND ABC OR East AND ABC. • If a cell in the criteria range is blank and has a column header, this is read as returning all records that match the column header. In the bottom table in Figure 8.7, the data returned will be West and ABC or all data in East. • Operators (, =, ) can be combined with numeric values for a more general filter. • Wildcards can be used with text values. An asterisk (*) replaces any number of characters. A question mark (?) replaces a single character. The tilde (~) allows the use of wildcard characters in case the text being filtered uses such a character as part of its value. • If the criterion is a formula, do not use a column header as it is applied to the entire dataset. The formula should be one that returns a TRUE or FALSE.
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 SHOW ME
 
 Media 8.3—Using the Advanced Filter with Various Criteria Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Filtering a Dataset Using the Advanced Filter To filter a dataset using the Advanced Filter, combining various criteria, and placing the results on a new sheet, follow these steps: 1. Copy and paste the desired headers from the dataset to a new sheet. 2. If filtering by a formula, skip to step 4. Otherwise, in row 1 of a blank section of the datasheet, type the column headers to filter by. 3. Below the column headers entered in step 2 fill in the criteria, as shown in Figure 8.8. Note that the criteria is not case sensitive.
 
 Figure 8.8 The Advanced Filter can use a combination of criteria to filter a dataset. Note: Results in G6:K25 are a representation of the actual results on the Report sheet.
 
 4. To filter by a formula, enter the formula in a column on the datasheet that does not have a header, as shown in column J of Figure 8.8. Because the formula in J2 is on the same row as other criteria, Excel will treat it as part of that criteria. But the formula in J3 is alone in its row. It will apply to the entire dataset. 5. After all the criteria are entered, return to the results sheet.
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 6. Select a blank cell. 7. Go to Data, Sort & Filter, Advanced. 8. Select Copy to Another Location. 9. Place the cursor in the List Range field. 10. Go to the dataset’s sheet and select the dataset. 11. Place the cursor in the Criteria Range field. 12. Go to the dataset’s sheet and select the criteria range. If the criteria range is just a formula, be sure to include a blank cell above the formula. Do not include any blank rows (except for above formulas). 13. Place the cursor in the Copy To field. 14. Select the column headers for the results. 15. Click OK.
 
 Filtering for Unique Items When the Unique Records Only option is selected, the Advanced Filter can be used to remove duplicates. Unlike the Remove Duplicates command on the Data tab, the original dataset will remain intact if you choose to copy the results to a new location. But also unlike the Remove Duplicates command, you cannot specify multiple columns to filter by. If Filter the List, In-Place is selected, the duplicate rows will be hidden. Go to Data, Sort & Filter, Clear to clear the filter and unhide the rows.
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 Removing Duplicates from a Single Column To quickly filter out duplicates in a single column and copy the results to a new location, follow these steps: 1. Select a cell in the column to filter. 2. Go to Data, Sort & Filter, Advanced Filter. 3. Verify the range in the List Range field is the desired range. Correct it if it’s wrong. 4. Select Copy to Another Location.
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 5. Place your cursor in the Copy to Range field. 6. Select a cell on the sheet where you want the first cell of the filtered range copied to. 7. Select Unique Records Only. 8. Click OK.
 
 Removing Duplicates After a cell is selected in the dataset, Remove Duplicates can be found under Data, Data Tools, Remove Duplicates, or if the dataset is a table, under Table Tools, Design, Tools, Remove Duplicates. The tool permanently deletes data from a table based on the selected columns in the Remove Duplicates dialog. Unlike other filters, it does not just hide the rows. Because of this, you may want to copy the data before deleting the duplicates.
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 Removing Duplicates from a Dataset To remove duplicates from a dataset, follow these steps: 1. Select a cell in the dataset. 2. Go to Data, Data Tools, Remove Duplicates. 3. Excel will highlight the dataset. If columns are missing in the selection, go back and make sure there are no blank separating columns. 4. From the Remove Duplicates dialog, make sure My Data Has Headers is selected if the dataset has headers. 5. By default, all the columns are selected. A selected column means the tool will use the columns when looking for duplicates. Duplicates in an unselected column will be ignored. Select the columns to search for duplicates. 6. Click OK. The dataset will update, deleting any duplicate rows. A message box will appear informing you of the number of rows deleted and the number remaining in the dataset.
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 Media 8.4—Finding Duplicates
 
 To listen to a free audio recording about finding duplicates using conditional formatting, log on to my.safaribooksonline.com/9780132182287/media.
 
 Consolidating Data You can use the Consolidate tool, found under Data, Data Tools, to combine data in three ways: • By Position—Sum1 data found on different sheets or in different workbooks based on their positions in the datasets. For example, if the ranges are A1:A10 and C220:C230, the results will be A1+C220, A2+C221, A3+C222, and so on. Do not select either of the options under Use Labels In. • By Category—Sum1 data found on different sheets or in different workbooks based on matching row and column labels, similar to a pivot table report. The references must include the labels in the leftmost column of the ranges. Select either or both of the options under Use Labels In to have the labels appear in the final data. • By Column—Combine the data to a new sheet, with each dataset in its own column. Select the Top Row option under Use Labels In. The Reference field is where the datasets are entered. Click Add to add the selection to the All References list. If the dataset is in a closed workbook, you can reference it only by using a range name. Click the Browse button to find and select the workbook. After the exclamation point (!) at the end of the path, enter the range name assigned to the dataset.
 
 See “Using Names to Simplify References” in Chapter 5, “Using Formulas” for details on how to create a range name.
 
 Create Links to Source Data applies only to external workbooks. If this option is selected, the consolidated data will update automatically when the source is changed. Also, the consolidated data will be grouped, as shown in Figure 8.9. Click the + icon to the left of the data to open the group and see the data used in the summary. 1
 
 The function applied to the data can be any available from the drop-down list in the Consolidate dialog. These include Sum, Count, Average, and more.
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 Figure 8.9 When linking to an external workbook, the consolidation will include the individual values of the selected references.
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 Consolidating Duplicate Data by Category To combine duplicate data from within the same workbook, follow these steps: 1. Select the top leftmost cell where the consolidated report should be placed. If other data is on the sheet, make sure there is enough room for the new data. 2. Go to Data, Data Tools, Consolidate. 3. Select the desired function from the Function drop-down. 4. Place the cursor in the Reference field. 5. Go to the sheet with the desired dataset. 6. Select the dataset, making sure the duplicated labels are in the leftmost column and that the column headers are included in the selection. 7. Click the Add button. 8. Repeat steps 4 to 7 for each additional dataset. 9. To include the top and/or left column labels, select the corresponding option. 10. Click OK.
 
 This page intentionally left blank
 
 This chapter shows you how data can be summarized and grouped together using Excel’s subtotal and grouping tools.
 
 9
 
 Subtotals and Grouping The ability to group and subtotal data allows you to summarize a long sheet of data to fewer rows. The individual records are still there, so that you can unhide them if you need to investigate a subtotal in detail.
 
 Although the capability to create groups and outlines is not available in Excel Starter or Web App, workbooks with preexisting groups will still work as designed.
 
 SUBTOTAL Function The SUBTOTAL function calculates a column of numbers based on the code used in the function. With the correct code, SUBTOTAL can calculate averages, counts, sums, and eight other functions listed in Table 9.1. It can also ignore hidden rows when the 100 version of the code is used. See Figure 9.1 for examples of the SUBTOTAL function in action. The function will ignore any cells in the range that include SUBTOTAL functions themselves, as shown in column E of the worksheet in the figure. Column G uses the SUM function instead of SUBTOTAL and does not ignore the hidden rows or previous SUM formulas in the Grand Total.
 
 TELL ME MORE
 
 Media 9.1—Adding Grand Totals When the Subtotals Were Manually Entered You can listen to a free audio recording about an old accounting trick for adding a total to data that has been manually subtotaled when you log on to my.safaribooksonline.com/9780132182287/media.
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 Table 9.1 SUBTOTAL Function Numbers Function_num (includes hidden values)
 
 Function_num (ignores hidden values)
 
 Function
 
 1
 
 101
 
 AVERAGE
 
 2
 
 102
 
 COUNT
 
 3
 
 103
 
 COUNTA
 
 4
 
 104
 
 MAX
 
 5
 
 105
 
 MIN
 
 6
 
 106
 
 PRODUCT
 
 7
 
 107
 
 STDEV
 
 8
 
 108
 
 STDEVP
 
 9
 
 109
 
 SUM
 
 10
 
 110
 
 VAR
 
 11
 
 111
 
 VARP
 
 Figure 9.1 Use SUBTOTAL to ignore hidden rows and prevent counting other SUBTOTAL calculations twice in the Grand Total.
 
 Subtotal Tool The SUBTOTAL function is very useful, but if you have a large dataset it can be time consuming to insert all the Total rows. When your dataset is large, use the Subtotal tool from the Data tab in the Outline group. This tool will group the sorted data, applying the selected function.
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 From the Subtotal dialog, you can select the column to group the data by, the function to subtotal by, and which columns to apply the subtotal to.
 
 SHOW ME
 
 Media 9.2—Using the Subtotal Tool Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Summarizing Data Using the Subtotal Command To quickly group and apply subtotals to a dataset, follow these steps: 1. Sort the data by the column the summary should be based on. For example, if summarizing by region, sort the Region column.
 
 See Chapter 7, “Sorting,” for more information about sorting by columns.
 
 2. Select a cell in the dataset. 3. Go to Data, Outline, Subtotal. The Subtotal dialog, shown in Figure 9.2, will open.
 
 Figure 9.2 Use the Subtotal dialog to set your subtotaling options.
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 4. From the At Each Change In field, select the column by which to summarize the data. 5. From the Use Function field, select the function to calculate the totals by. 6. From the Add Subtotal To field, select the columns the totals should be added to. Notice that, by default, the last column is already selected. 7. Click OK. The data will be grouped and subtotaled, with a grand total at the very bottom, as shown in Figure 9.3.
 
 Figure 9.3 Profit is summarized for each region.
 
 Placing Subtotals Above Data By default, subtotals appear below the data being summarized. If the subtotals need to appear above the data instead, deselect Summary Below Data in the Subtotal dialog.
 
 Remove Subtotals or Groups To remove all the subtotals and groups, click the Remove All button in the Subtotal dialog. To remove only the group and outline buttons, leaving the subtotal intact, select Data, Outline, Ungroup, Clear Outline.
 
 Expanding and Collapsing Subtotals When data is grouped and subtotaled, outline symbols appear to the left of the row headings, as shown in Figure 9.4. Clicking the numbered icons at the top (1,2,3
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 in Figure 9.4) will hide and unhide the data in the sheet. For example, clicking the 2 will hide the data rows, showing only the Total and Grand Total rows. Clicking the 1 will hide the Total rows, showing only the Grand Total. Clicking the 3 will unhide all the rows.
 
 Figure 9.4 Use the outline icons to expand and collapse the grouped data. Below the numbered icons, next to each Total and Grand Total, are the expand (+) and collapse (-) icons. These will expand or collapse the selected group.
 
 Copying Subtotals If you hide the data rows, copy the subtotals, and paste them to another sheet, all the data, including the hidden data rows, will appear in the new sheet. To copy and paste only the subtotals, select only the visible cells.
 
 LET ME TRY IT
 
 Copying Only the Totals to a New Location To copy only the totals to a new location, follow these steps: 1. Click the outline icon so that only the rows to copy are visible. 2. Select the entire dataset. 3. Go to Home, Editing, Find & Select, Go to Special, and select Visible Cells Only, as shown in Figure 9.5. Note: the dashed lines in the figure are shown for emphasis only. They will appear in the next step. 4. Select Home, Clipboard, Copy.
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 Figure 9.5 Select Visible Cells Only to copy and paste only the total rows.
 
 5. Select the cell where the data is to be pasted. 6. Select Home, Clipboard, Paste. The formulas will be converted to values automatically.
 
 A shortcut for step 3 is to press ALT+; (semicolon).
 
 Formatting Subtotals If you hide the data rows, select the subtotals, and apply formatting to them, all the data, including the hidden data rows, will reflect the new formatting. To format just the subtotals, select only the visible cells.
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 Applying Formatting to Only the Totals To copy just the totals to a new location, follow these steps: 1. Click the outline icon so that only the rows to format are visible. 2. Select the entire dataset. If you don’t want to apply the formatting to the header row, do not include it in the selection.
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 3. Go to Home, Editing, Find & Select, Go to Special, and select Visible Cells Only. 4. Apply the desired formatting.
 
 A shortcut for step 3 is to press ALT+; (semicolon).
 
 Applying Multiple Subtotal Function Types A dataset can have more than one type of subtotal applied to it—for example, a sum subtotal of one column and a count subtotal of another. Make sure the Replace Current Subtotals option in the Subtotal dialog is deselected so that each subtotal will be applied separately. Each subtotal will be calculated and placed on its own row, pushing any existing subtotal row down, as shown in Figure 9.6.
 
 Figure 9.6 Multiple subtotals can be applied to a dataset. The Total was added first, followed by the Count.
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 Applying Multiple Subtotal Function Types To apply multiple subtotals to a dataset, follow these steps: 1. Sort the data by the column the summary should be based on. For example, if summarizing by region, sort the Region column.
 
 188
 
 Chapter 9
 
 |
 
 S u b to t a l s a n d G ro u p i n g
 
 See Chapter 7 for more information about sorting by column.
 
 2. Select a cell in the dataset. 3. Go to Data, Outline, Subtotal. 4. From the At Each Change In field, select the column by which to summarize the data. 5. From the Use Function field, select the function to calculate the totals by. 6. From the Add Subtotal To field, select the columns the totals should be added to. Notice that, by default, the last column is already selected. 7. Click OK. 8. Go to Data, Outline, Subtotal. 9. Deselect Replace Current Subtotals. 10. Repeat steps 4 to 6, selecting a new function from the Use Function field. 11. Click OK. The dataset will reflect two subtotals.
 
 Combining Multiple Subtotals to One Row When applying multiple function types, Excel places each subtotal on its own row. There is no built-in option to have the subtotals appear on the same row. But you can manipulate Excel to make this happen by applying a subtotal to a column where you don’t want it, and then manually changing the formula.
 
 LET ME TRY IT
 
 Portraying Multiple Function Types on a Single Row To have multiple function types appear on a single row, as shown in Figure 9.7, follow these steps:
 
 Figure 9.7 Columns F:H are sums of the grouped data, but column D is a count of the data, as shown in the formula bar (3 is the function code for COUNTA).
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 1. Sort the data by the column the summary should be based off of. For example, if summarizing by region, sort the Region column.
 
 See Chapter 7 for more information about sorting by columns.
 
 2. Select a cell in the dataset. 3. Go to Data, Outline, Subtotal. 4. From the At Each Change In field, select the column by which to summarize the data. 5. From the Use Function field, select the function to calculate the totals by. 6. From the Add Subtotal To field, select the columns the totals should be added to. Also select the column where you want to apply the second function type, like the Customer column selected in Figure 9.8.
 
 Figure 9.8 The Customer column is selected as a temporary holder for the actual subtotal formula that will be used.
 
 7. Click OK. 8. Collapse the dataset by clicking the “2” outline symbol so only the total rows are visible. 9. Select the data in the column where the second function type should be.
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 10. Go to Home, Editing, Find & Select, Go to Special, and select Visible Cells Only. 11. Go to Home, Editing, Find & Select, Replace. 12. In the Find What field, type “SUBTOTAL(9,”. 13. In the Replace With field, type the subtotal function using the desired function number. For example, in Figure 9.9, “SUBTOTAL(2,” will replace the SUM function with the COUNTA function.
 
 Figure 9.9 Use Find and Replace to replace the automated subtotals with the desired function argument.
 
 See the “SUBTOTAL Function” section earlier in this chapter for the available codes.
 
 14. Click Replace All. 15. Click OK to close the Excel notification of the number of replacements made. 16. Click Close. If needed, apply any required formatting to the selected cells.
 
 Subtotaling by Multiple Columns To add subtotals based on multiple columns, as shown in Figure 9.10, sort the dataset by the desired columns and then apply the subtotals, making sure Replace Current Subtotals is not selected. The subtotals should be applied in order of greatest to least. For example, if the data is sorted by Region, with the products within each region sorted, apply the subtotal to the Region column and then the Product column.
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 Figure 9.10 Apply subtotals to Region (the major column) and then Product (the secondary column) to get subtotals of both.
 
 SHOW ME
 
 Media 9.3—Subtotaling by Multiple Columns Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Subtotaling by Multiple Columns To subtotal by multiple columns, as shown in Figure 9.10, follow these steps: 1. Sort the data by the columns the summary should be based on.
 
 See Chapter 7, “Sorting” for more information about sorting by columns.
 
 2. Select a cell in the dataset. 3. Go to Data, Outline, Subtotal. 4. From the At Each Change In field, select the major column by which to summarize the data. 5. From the Use Function field, select the function to calculate the totals by. 6. From the Add Subtotal To field, select the columns the totals should be added to. 7. Click OK.
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 8. Repeat steps 3 to 7 for the secondary column.
 
 Sorting Subtotals If you try to sort a subtotaled dataset while viewing all the data, Excel informs you that to do so would remove all the subtotals. Although the data itself cannot be sorted, the subtotal rows can be, and the data within will remain intact. To do this, collapse the data so that only the subtotals are being viewed, and then apply the desired sort.
 
 LET ME TRY IT
 
 Sorting a Subtotaled Column To sort the dataset by a subtotaled column, follow these steps: 1. Collapse the dataset so only the subtotals are in view. 2. Select a cell in the column to be sorted. 3. Go to Data, Sort & Filter, and select the quick sort button for the desired sort order.
 
 Inserting Blank Rows When subtotals are inserted into a dataset, only one row is added between the groups. The report may appear crunched together for some reviewers (see Figure 9.11), and they may request that rows be inserted, separating the subtotaled groups from each other. You can insert blank rows into a subtotaled report in two ways.
 
 I n s e r t i n g B l a n k R ows
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 Figure 9.11 The close rows in this report can make it difficult to see the different groups.
 
 Separating Subtotaled Rows for Print If the report is going to be printed, blank rows probably don’t need to be inserted. Just the illusion needs to be created because the actual need is for more space between the subtotal and the next group. This can be done by adjusting the row height of the subtotal rows.
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 Increasing the Amount of Space After a Subtotal To increase the amount of space after a subtotal placed below the data, follow these steps: 1. Collapse the dataset so that only the subtotals are in view. 2. Select the entire dataset, except for the header row. 3. Press Alt+; (semicolon) to select the visible cells only. 4. Go to Home, Cells, Format, and select Row Height. 5. Enter a new value in the Row Height dialog, as shown in Figure 9.12.
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 Figure 9.12 Adjust the row height of the subtotal rows to give the appearance of an extra row between the groups.
 
 6. Click OK. 7. Go to Home, Alignment, and select the Top Align button. 8. Spacing now appears between each group, as shown in Figure 9.13.
 
 Figure 9.13 Adjust the row height and text alignment of the subtotal rows to separate the groups.
 
 Separating Subtotaled Rows for Distributed Files It’s a bit involved, but a blank row can be inserted between groups in a file that you’re going to distribute. The method involves using a temporary column to hold the space below where a blank row is needed.
 
 This method will disable Excel’s capability to manipulate the subtotals in the dataset. The total rows will remain, but the outline icons no longer work properly, and future subtotal changes will require the groupings and subtotals to be manually removed first.
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 SHOW ME
 
 Media 9.4—Inserting Blank Rows Between Subtotal Groups Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Inserting Blank Rows After Subtotals To insert blank rows after subtotals placed below the data (see Figure 9.14), follow these steps: 1. Collapse the dataset so only the subtotals are in view. 2. In a blank column to the right of the dataset, select a range as long as the dataset. 3. Press Alt+; (semicolon) to select the visible cells only. 4. Type a 1 and press Ctrl+Enter to enter the value in all visible cells. 5. Expand the dataset. 6. Select the cell above the first cell with a 1 in it. 7. Go to Home, Cells, Insert, Insert Cells. 8. From the Insert dialog, select Shift Cells Down, and click OK, as shown in Figure 9.14.
 
 Figure 9.14 Select the cell above the first cell with a 1 in it then insert a new cell to shift all the values down one row.
 
 9. Highlight the column with the 1s in it. 10. Go to Home, Editing, Find & Select, Go to Special.
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 11. From the Go to Special dialog, select Constants and click OK, as shown in Figure 9.15
 
 Figure 9.15 Use Go To Special, Constants to select just the 1s in the temporary column.
 
 12. Go to Home, Cells, Insert, Insert Sheet Rows. A blank row is inserted above the row containing a 1, as shown in Figure 9.16.
 
 Figure 9.16 Use a temporary column to insert blank rows between groups. 13. Delete the temporary column.
 
 Grouping and Outlining Selected rows and groups can be grouped together manually using the options in Data, Outline, Group. The Expand/Collapse button will be placed below the last row in the selection or to the right of the last column in the selection.
 
 G ro u p i n g a n d O u t l i n i n g
 
 197
 
 If the data to be grouped includes a calculated total row or column between the groups, you can use the Auto Outline option. This option creates groups based on the location of the rows or columns containing formulas. If the dataset contains formulas in both rows and columns, though, the option will create groups for both rows and columns. This tool works best if there are no formulas within the dataset itself, unless you do want the groups to be created based off those calculations. Use the Group option for absolute control of how the rows or columns are grouped. For example, if you have a catalog with products grouped together, users can expand or collapse each group to view the products, as shown in Figure 9.17. By default, the Expand/Collapse buttons will appear below the data. To get them to appear above the grouped data, first apply a subtotal to the dataset with Summary Below Data unselected. Then undo the change and apply the desired groupings.
 
 Figure 9.17 Group items together to make it easier for users to view only the desired items.
 
 Groups can be cleared one of two ways from the Data, Outline, Ungroup dropdown: • Ungroup—Ungroups the selected data. Will ungroup a single row from a larger group if that is all that is selected. • Clear Outline—Clears all groups on a sheet unless more than one cell is selected, in which case the selected item will be ungrouped. If used on data that was subtotaled using the Subtotal button, the subtotals will remain; only the groups will be removed.
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 Manually Grouping Rows To manually group rows with the Expand/Collapse button above the grouped dataset, follow these steps: 1. Select a cell in the dataset. 2. Go to Data, Outline, Subtotal. 3. A message may appear that Excel cannot determine which row has column labels. Click OK. 4. In the Subtotal dialog, deselect Summary Below Data and click OK. 5. Click the Undo button in the Quick Access toolbar. 6. Select the first set of rows to group together. Do not include the header. For example, to create the Hitachi grouping in Figure 9.17, select rows 4 and 5 to group. To create the Haier group, select only row 2. 7. Go to Data, Outline, Group, Group, or just select the Group button itself. 8. Repeat steps 6 and 7 for each group of rows.
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 This chapter will introduce you to the power of pivot tables and provide you with the knowledge to create straightforward but useful reports.
 
 Pivot Tables Pivot tables can summarize one million rows with five clicks of the mouse button. They’re so powerful with so many options that this chapter cannot cover it all. This chapter is meant to provide you with the tools to create straightforward, but useful, pivot tables. If you find your needs not covered by the sections in this chapter, refer to Pivot Table Data Crunching: Microsoft Excel 2010 (ISBN 0-7897-4313-2) by Bill Jelen and Michael Alexander. Excel is required to create pivot tables, but the functionality in an existing pivot table will carry over to Excel Starter and Web App.
 
 Data Preparation Your dataset should adhere to a few basic formatting guidelines for working with pivot tables: • There should be no blank rows or columns. • If a column contains numeric data, don’t allow blank cells in the column. Use zeros instead of blanks. • Each row should be a complete record. • There shouldn’t be any total rows. • There should be a unique header above every column. • Headers should be in only one row; otherwise, Excel will get confused, unable to find the header row on its own. Figure 10.1 shows a dataset properly formatted for working with pivot tables. Figure 10.2 shows a dataset not suitable for pivot tables. The dates should be in a column of their own. And although a person may understand that all the data shown is relevant to the West region, Excel does not. If your dataset looks like Figure 10.2, refer to the “Making Data Suitable for Pivot Tables” section for steps to help make the dataset more suitable.
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 Figure 10.1 This dataset is great for pivot tables.
 
 Figure 10.2 This dataset is not suitable for a pivot table.
 
 Pivot Table Limitations As incredibly powerful as pivot tables are, they do have a few limitations: • Only 1 million rows are allowed, despite the 1,048,576 rows on a sheet. • Only 16,000 columns are allowed, despite the 16,384 columns on a sheet. • Only 1 million unique items per field are allowed. • You cannot add a calculated item to a grouped field. • If a field is grouped by days, grouping by months, quarters, or years will undo the group by days. • Changing the source data does not automatically update the pivot table. You must click the Refresh button.
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 • Blank cells confuse Excel. A single blank cell in a numeric column will make Excel think the column contains text values, changing the default behavior for that column. • You cannot insert rows or columns in a pivot table.
 
 Pivot Table Compatibility Pivot table compatibility between Excel 2010 and the legacy versions is a bit tricky. • If you open an xlsx file with a converter in a legacy version, the pivot tables will not work. • If you create pivot tables in an xlsx file and then save the file as an xls, the pivot tables will not work. The compatibility checker dialog will appear when you save the file, warning of the incompatibilities, such as Show Values As. • To get a pivot table created in 2010 to work in legacy Excel, save the file as an xls before creating the pivot table. Close and reopen the file, and then create the pivot table. Any options not compatible with older versions of Excel, such as slicers (which you can read more about later in this chapter), will not be available. Strangely enough, you can apply Show Values As and save the file. Excel will not warn of compatibility issues and the pivot table will open fine in legacy versions.
 
 PivotTable Field List There are two parts to a pivot table report—the pivot table itself and the PivotTable Field List, which appears only when a cell in the pivot table is selected. The PivotTable Field List consists of a list of the column headers in the dataset (the fields) and the four areas of a pivot table. Figure 10.3 shows a basic pivot table, using all four areas of a pivot table to summarize product revenue by month on a regional basis. The four areas are as follows: • Report Filter—Limits the report to a specific criteria; in this case, we are looking at only the West region’s revenue. Instead of creating a separate report for each region, use the Report Filter to view the desired region. • Column Labels—The headers going across the top of the pivot table—in this case, the monthly breakdown. • Row Labels—The labels going down the left side of the pivot table—in this case, the Products. If there is more than one field, the fields will appear in a hierarchical view, with the second field under the first field.
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 • Values—The data being summarized—in this case, Revenue. The data can be summed, counted, and many other calculation types. Not all four areas must be used. Each area can have more than one field.
 
 Figure 10.3 A basic pivot table using all fields to summarize monthly product sales for the West region.
 
 Creating a Pivot Table Creating a pivot table is simple if the dataset is suitable for pivot tables. It can be quickly created by selecting the desired fields in the field list. Based on the data in a field, Excel will place the selected field in the area it thinks it should go. Text fields will be placed in the Row Label area. Numeric fields will be placed in the Values area and summed. If a field needs to be moved, see the section “Moving Fields in a Pivot Table.”
 
 SHOW ME
 
 Media 10.1—Creating a Pivot Table Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Creating a Pivot Table To create a pivot table from data on another sheet in the workbook, follow these steps: 1. Make sure the dataset is set up properly, as explained in the section “Data Preparation. 2. Select a cell in the dataset. 3. Go to Insert, Tables, and click the PivotTable button (not the drop-down arrow). 4. The Create Pivot Table dialog, shown in Figure 10.4, will appear where Excel will select the dataset. If the selection is correct, continue to step 5. If the selection is not correct, return to step 1.
 
 Figure 10.4 Use the Create Pivot Table dialog to identify the source data and where the pivot table should be created.
 
 5. Select the location where the pivot table is to be placed. The default location is always a new sheet. If using an existing sheet, ensure there is enough room on the sheet. 6. Click OK. The pivot table template and field list will appear, as shown in Figure 10.5.
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 Figure 10.5 Once the pivot table template and field list appear, you can start designing the report.
 
 7. Select the fields that should be the row labels. Select them in the order they should appear in, left to right on the report. 8. Select the fields the report should summarize. 9. If a field needs to be a column label, click and drag the field from the list to the Column Labels area. 10. If a field needs to be a filter, click and drag the field from the list to the Report Filter area. 11. If any of the fields in steps 7 and 8 didn’t appear where you wanted them to or if the values were counted instead of summarized, see the section “Moving Fields in a Pivot Table.”
 
 TELL ME MORE
 
 Media 10.2—Using Other Data Sources
 
 To listen to a free audio recording about using other data sources to create pivot tables, log on to my.safaribooksonline.com/9780132182287/media.
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 Moving Fields in a Pivot Table When you select fields in the field list and add them to an area that already contains fields, the new fields are placed below the existing fields. The up/down layout in the area corresponds to a left/right layout of the fields in the pivot table, except for the Report filter, which also goes up/down. The order of the fields and the area in which they’re located can be changed by clicking the field and dragging it to a new location. You can also drag fields from the field list to an area, instead of selecting them and letting Excel choose their locations. You can reorganize the layout by clicking and dragging the headers in the pivot table itself. The new location is signified by a semisolid line, as shown in Figure 10.6.
 
 Figure 10.6 Drag fields to new locations by clicking and dragging the header.
 
 Remove a Field To remove a field from a pivot table, deselect it from the field list or click it in the area and select Remove Field. You can also click and drag the field from the area to the sheet until an X appears by the cursor. When the X appears, release the mouse button.
 
 Rename a Field You can rename the field as it appears in the pivot table by typing a new name directly in the cell. The name must be unique and cannot be the same as the field’s original name before it was placed in the pivot table.
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 Change Calculation Type When Excel identifies a field as numeric, it automatically sums the data. If it cannot identify the field as numeric, it will count the data. No matter which calculation type Excel appoints to a value field, it can be changed by going to PivotTable Tools, Options, Calculations, Summarize Values By, and selecting an option from the dropdown.
 
 LET ME TRY IT
 
 Change the Calculation Type of a Field Value To change the calculation type used on a field value, follow these steps: 1. Select a cell in the value field to change. 2. Go to PivotTable Tools, Options, Calculations, Summarize Values By. 3. Select a new calculation type from the drop-down.
 
 Show Values Based on Other Items Go to PivotTable Tools, Options, Calculations, Show Values As to change the way the data is viewed—for example, in comparison to another field as shown in Figure 10.7. The following options do not require additional information:
 
 Figure 10.7 Use Show Values As to view the data in relation to other fields
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 • No Calculation—The default selection that shows the actual numbers. • % of Grand Total—Displays values as a percentage of the grand total of all the values in the report. • % of Column Total—Displays values as a percentage of the column total. • % of Row Total—Displays values as a percentage of the row total. • % of Parent Row Total—Displays values based on the following calculation: (value for the item)/(value for the parent item on rows). • % of Parent Column Total—Displays values based on the following calculation: (value for the item)/(value for the parent item on columns). • Index—Displays values based on the following calculation: ((value in cell) x (Grand Total of Grand Totals))/((Grand Row Total) x (Grand Column Total)). The following options require that a base field be specified: • % of Parent Total—Displays values based on the following calculation: (value for the item)/(value for the parent item of the selected Base field). • Running Total In—Displays values for successive items in the selected Base field as a running total. • % Running Total In—Calculates the value for successive items in the selected Base field that are displayed as a running total as a percentage. • Rank Smallest to Largest—Displays the rank of the values in the specified field, with 1 representing the smallest item. • Rank Largest to Smallest—Displays the rank of the values in the specified field, with 1 representing the largest item. The following options require that a base field and base item be specified: • % Of—Displays values as a percentage of the value of the selected Base item in the Base field. • Difference From—Displays values as the difference from the value of the selected Base item in the Base field. • % Difference From—Displays values as the percentage difference from the value of the selected Base item in the Base field.
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 Pivot Table Sorting Excel automatically sorts text data alphabetically when building a pivot table. Any record or field in a pivot table can be dragged to a new location, the same way a header can be as shown in Figure 10.6, but this is a temporary measure. After you pivot the table, the sort will be lost. Another option is to sort using one of the methods in the following sections. When a sort is applied in a pivot table, it remembers the settings, so as you pivot the table, the sort sticks.
 
 Pivot Table Quick Sort The quick sort buttons offer one-click access to sorting cell values. There are four entry points to the quick sort buttons. • On the Home tab, select Editing, Sort & Filter, Sort A to Z1 or Sort Z to A1. • Data, Sort & Filter, select either the AZ or ZA quick sort buttons to sort the active field • Right-click a cell in the pivot table, select Sort, and choose from Sort A to Z1 or Sort Z to A1. • From a pivot label drop-down, select Sort A to Z1 or Sort Z to A1. Unlike sorting outside pivot tables, it doesn’t matter if you have more than one cell selected during the sort. Excel will automatically sort the entire pivot table. If multiple columns are selected Excel will sort only the leftmost column in the selection. To quick sort a field, select a cell in the field and apply the desired quick sort method outlined previously. The data will re-sort based on the selected field. The sort dialog, discussed in the following section, will be updated for the selected field.
 
 Pivot Table Sort (Fieldname) Dialog To bring up the pivot table Sort (fieldname) dialog shown in Figure 10.8, select a
 
 1
 
 The actual button text may change depending on the type of data in the cell. For example, if the column contains values, the text will be Sort Smallest to Largest. If the column contains text, it will be Sort Z to A.
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 Figure 10.8 Use the Sort (fieldname) dialog for advanced sorting options. The dialog may appear slightly different depending on the data type of the selected field.
 
 cell and use one of the following methods: • Select a cell in the desired field, and then go to the Home tab, select Editing, Sort & Filter, Custom Sort. • Select a cell in the desired field, and then go to Data, Sort & Filter, Sort. • Right-click a cell in the desired field in the pivot table, select Sort, and select More Sort Options. • From a pivot label drop-down, select More Sort Options. You can select the field to sort at the top of the drop-down. The Sort (fieldname) dialog provides additional sorting options, which the pivot table will remember as the table layout is changed. • Manual—The default sort, clearing, but not undoing, any previous settings. • Ascending/Descending—These options sort the selected column based on the original field or a value field selected from the drop-down. If you click the More Options button, the following options are revealed: • AutoSort—Select to have the sort updated when the pivot table is updated. • First Key Sort Order—Available when AutoSort is deselected, allowing the field to be sorted by a custom list. • Sort by Grand Total—Available when either Ascending or Descending is
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 selected with another field; this option sorts the data using the Grand Totals. • Sort by Values In Selected Column—Available when either Ascending or Descending is selected with another field; this option sorts the data using the column of the selected cell.
 
 LET ME TRY IT
 
 Create a Sort Rule To create a sort rule for one field based on another, as shown in Figure 10.9, follow these steps:
 
 Figure 10.9 Create a rule to sort data on a specific column using More Options. In this case, customer names will be sorted by 2008 profits.
 
 1. Select a row or column label cell in the field to apply the rule to. 2. Go to PivotTable Tools, Options, Sort & Filter, Sort. 3. Make sure the field name in the Sort (fieldname) dialog is the field the rule will be applied to. If not, repeat steps 1 and 2. 4. Select the sort direction option. 5. From the now active drop-down, select the field to be sorted.
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 6. Select More Options 7. Select the AutoSort option if the report should re-sort automatically. 8. Select Grand Total to base the sort on the Grand Total of the column selected in step 5, and continue to step 9. Otherwise, skip to step 11. 9. Select Values in Selected Column to base the sort on a specific column. 10. If the cell address in the Values does not reflect the correct column, highlight it and then select a cell in the desired column on the sheet. 11. Click OK twice.
 
 Expanding and Collapsing Fields Individual groups in a pivot table can be quickly expanded and collapsed by clicking the + and - icons. Additional methods, including the capability to expand or collapse all the groups in a fields are the following: • Select a cell in the field and go to Data, Outline, Show Detail or Hide Detail, which affects all the groups in the field. • Select a cell in the field and go to PivotTable Tools, Options, Active Field, Expand Entire Field or Collapse Entire Field, which affects all the groups in the field. • Right-click a cell in the field and choose one of the following: • Expand or Collapse—Affects the selected group. • Expand Entire Field or Collapse Entire Field—Affects all the groups in the field. • Collapse to (fieldname) or Expand to (fieldname)—One or more menu options, depending on the number of grouped fields available, affects the selected group. If you try to expand a data item instead of the field itself, Excel will open a Show Detail dialog allowing you to add a new field within the selected data item.
 
 Drill Down Double-clicking a data item, or right-clicking and selecting Show Details, will create a new sheet with a table showing the records from which the data item was derived. This can be useful if you notice a value in a pivot table that stands out and you need to investigate it in more detail. The new table is not linked to the original data or the pivot table. If you need to make corrections to the data, make them to the original source and refresh the
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 pivot table. You can then delete the sheet that was created for the drill down.
 
 Grouping Dates A common issue with pivot tables occurs when someone tries to group a date field and receives the error Cannot Group That Selection. The reason may be that the dates are not real dates, but instead text that looks like dates. If that’s the case, see the “Using Text to Columns” section in Chapter 3, “Entering Data in Excel” to convert the text dates to real dates. The Grouping dialog allows dates to be grouped by number of days, months, quarters, and years. When dates are grouped into more than one type, such as month and year, virtual fields are added to the pivot table, which can be used just like the regular fields. To access the Grouping dialog, do one of the following: • Right-click a date and select Group. • Select a date cell and go to PivotTable Tools, Group, Group Selection or Group Field. • Select a date and go to Data, Outline, Group. When grouping dates, if Months is the only selection, multiple years will be combined into the month. To get the months grouped into their respective years, also select Years from the dialog. To return the dates to normal, you have to ungroup the field. Unselecting the original or virtual field will not ungroup the dates. To ungroup the dates, do one of the following: • Right-click a grouped date and select Ungroup. • Select a date cell and go to PivotTable Tools, Options, Group, Ungroup. • Select a date and go to Data, Outline, Ungroup.
 
 SHOW ME
 
 Media 10.3—Grouping Dates into Months and Years Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Group a Date Field into Months and Years To group a date into months and years, follow these steps: 1. Select a cell in the pivot table with a date value. 2. Go to Tools, Group, Group Field. If you receive the error Cannot Group That Selection, see the “Using Text to Columns” section in Chapter 3 to convert the text dates to real dates. Otherwise, continue to step 3. 3. The date range found by Excel will appear in the Group dialog. Make changes if needed. 4. Select Months and Years. 5. Click OK. The data will be grouped into months and years, and a Years field will be added to the field list.
 
 Summarize Weeks At first glance, there does not appear to be a way of creating a weekly report. But by using the Days option in the Group dialog, seven days can be grouped together to create a week, 14 days for a biweekly report, and so on. Excel will group the selected number of days based on the range in the dialog, so if the weeks need to represent a normal week, such as Sunday to Saturday, change the starting date to be a Sunday that will include the first date in the dataset, as shown in Figure 10.10.
 
 Figure 10.10 Create a weekly report by selecting the Days option in the Grouping dialog.
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 LET ME TRY IT
 
 Group Dates into Weeks To group dates into seven-day weeks, follow these steps: 1. Select a cell in the pivot table with a date value. 2. Go to Tools, Group, Group Field. If you receive the error Cannot Group That Selection, see “Using Text to Columns” in Chapter 3 to convert the text dates to real dates. Otherwise, continue to step 3. 3. The date range found by Excel will appear in the Group dialog. Make changes if needed. 4. Select Days. 5. Deselect Months if needed. 6. Change the Number of Days to 7. 7. Click OK. The data will be grouped into weeks, showing the first and last day of each week, as shown in Figure 10.10.
 
 Filtering Options This section reviews several filtering methods available for viewing only specific records. These methods can be accessed with one of the following steps: • In the PivotTable Field List, highlight a field and click the drop-down arrow to open the filter listing. • In the pivot table, click the label drop-down. • Right-click a label in the pivot table and select Filter.
 
 Filter Listing for Listed Items The filter listing is probably the most obvious filter tool when you open the dropdown. If the pivot table area contains more than one field, a Select Field dropdown will appear at the top, allowing another field to be selected if the incorrect one is active, as shown in Figure 10.11. All items in the filter listing will be selected, because they are all visible the first time you open the drop-down, but you can select just the items that should appear in the data. Any item that no longer bears a check mark will be hidden.
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 Figure 10.11 A drop-down at the top of the filter window allows the correct field to be selected.
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 Filter a Field for Specific Items To filter a field for specific items, follow these steps: 1. Open the drop-down of the area to filter. 2. If needed, select the correct field from the drop-down at the top of the window, as shown in Figure 10.11. 3. Deselect the Select All item to clear all the check marks in the list. 4. Select the item(s) to be viewed in the dataset. 5. Click OK. The pivot table will update, showing only the item(s) selected.
 
 Search Function for Listed Items If you have a long list of items in the filter listing, you can search for items to include or exclude from the filter. Searches are done on the entire data list, not just the items currently filtered on. Use an asterisk (*) as a wildcard for one or more characters before, after, or in between any of the search terms.
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 Search for Items to Include in Filter When a search term is entered in the search field, the filter listing updates with all matches selected. You can deselect the items you want to filter out, check Add Current Selection to Filter if you do not want to lose any items you previously filtered for, and click OK. You should keep two things in mind when using the search function: • The search looks through the entire column, including items you may have already filtered out. • The search function is additive when the Add Current Selection to Filter is selected. If it’s not selected, each search’s results are treated as a new filter.
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 Use the Search Function to Filter Items To perform multiple searches to filter items, follow these steps: 1. Open the drop-down of the area to filter. 2. If needed, select the correct field from the drop-down at the top of the window. 3. Enter the first term, or partial term, to filter by. 4. If you want to filter by all the resulting terms, skip to step 7. Otherwise, continue to step 5. 5. Deselect Select All Search Results. 6. Select the desired items from the search results 7. Click OK. 8. Open the drop-down of the column to filter again. 9. Enter the second term, or partial term, to filter by. 10. If you want to filter by all the resulting terms, click OK and skip to step 13. Otherwise, continue to step 11. 11. Deselect Select All Search Results.
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 12. Select the desired items from the search results. 13. Select Add Current Selection to Filter. 14. Click OK.
 
 Search for Items to Exclude from Filter The search function can also be used to exclude items from the filter. This is done by entering a search term, deselecting the items to exclude from the results, and then selecting the Add Current Selection to Filter. You should keep three things in mind when using the search function to exclude items: • The search looks through the entire column, including items you may have already filtered out. • To exclude items from the listing, deselect them from the result. • The search function is additive when the Add Current Selection to Filter is selected. If not selected, each search’s results are treated as a new filter.
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 Use the Search Function to Exclude Items from Results To exclude items from a list of filtered results, as shown in Figure 10.11, follow these steps: 1. Open the drop-down of the area to filter. 2. If needed, select the correct field from the drop-down at the top of the window. 3. Enter the first term, or partial term, to filter by. 4. If you want to filter by all the resulting terms, skip to step 7. Otherwise, continue to step 5. 5. Deselect Select All Search Results. 6. Select the desired items from the search results. 7. Click OK. 8. Open the drop-down of the column to filter again.
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 9. Enter the exclusion term. 10. If you want to filter out all the resulting terms, skip to step 13. Otherwise, continue to step 11. 11. Deselect Select All Search Results. 12. Select the desired items from the search results. 13. Select Add Current Selection to Filter. 14. Click OK.
 
 Special Filters Special filters are available in the filter drop-down and also by right-clicking a label and going to Filter. If the selected field is a date field, Date Filters will appear. If the selected field is anything other than a date, Label Filters will appear. In both cases, Value Filters will be included. All the special filters, except for ones that take action immediately, open a filter dialog in which specifics for the filter are entered. Selection of any of the Label Filters opens the Label Filter (fieldname) dialog in which text can be entered. Wildcards can also be used in the text fields. Use an asterisk (*) to replace multiple characters or a question mark (?) to replace a single character. Value Filters includes various options that will bring up the Value Filter (fieldname) dialog in which values can be entered. There is also a Top 10 option, described in more detail in the section “Top 10 Filtering.” Date Filters offers a wide selection of options, including additional options under All Dates in the Period, as shown in Figure 10.12. The Custom Filter (fieldname) dialog for dates includes calendars to aid in date entry. The options dealing with quarters refer to the traditional quarter of a year, January through March being the first quarter, April through June being the second quarter, and so on.
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 Figure 10.12 Numerous methods are available in the Date Filters option.
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 Filter a Value Field for a Range of Values To filter a value field for a range of values, follow these steps: 1. Open the pivot table filter drop-down. 2. Go to Value Filters, Between. 3. From the first drop-down, select the value field to filter. 4. The second drop-down should show the text Is Between. Note that other selections can be made. 5. In the third field, enter the minimum value of the range to be shown. 6. In the fourth field, enter the maximum value of the range. 7. Click OK. The pivot table will update, showing only the records with grand totals that fell within the selected range.
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 Top 10 Filtering The Top 10 option has a flexible dialog allowing you to specify the top or bottom items, percentages, or sums to view. For example, you could choose to view the bottom 15% or the top 7 items. The Top 10 option is available under the Values Filter listing and also by right-clicking a label and selecting Filter, Top 10.
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 Filter for Records That Sum to a Specific Value To filter for records that sum to a specific value, as shown in Figure 10.13, follow these steps: 1. Open the pivot table filter drop-down. 2. Go to Value Filters, Top 10. The Top 10 Filter (fieldname) dialog will appear. 3. From the first drop-down, select to Top or Bottom. 4. In the second field, enter the value to sum for. The actual summed value may surpass this. 3. Select sum from the third drop-down. 4. Select the value field to sum. 5. Click OK. The pivot table will filter to the records that meet the entered criteria.
 
 Figure 10.13 Use the Top 10 option to create a report of top customers who account for a specific amount of revenue.
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 Filter By Selection One or more labels can be manually selected and filtered by right-clicking the selection and going to Filter. From the right-click context menu that appears, select Keep Only Selected Items or Hide Selected Items, as shown in Figure 10.14.
 
 Figure 10.14 Use the Ctrl key to select individual items for filtering through the context menu.
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 Filter by Manual Selection To manually select items and apply a filter, follow these steps: 1. Select the first item. 2. While holding down the Ctrl key, select another item. Continue to hold down the Ctrl key as you select additional items. When all the items are selected, continue to step 3. 3. Right-click over a selected item. 4. Go to Filter and choose either Keep Only Selected Items or Hide Selected Items.
 
 Clearing Filters To clear all filters applied to a pivot table, go to PivotTable Tools, Actions, Clear, Clear Filters. You can use two ways to clear a filter from a specific field: • Right-click the field, go to Filter, and select Clear Filter from fieldname.
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 • Open the label’s filter drop-down, select the field from the drop-down at the top, and select Clear Filter from fieldname.
 
 Calculated Fields A calculated field is a field you create by building a formula using existing fields and constants. Go to PivotTable Tools, Options, Calculations, Fields, Items, & Sets, and select Calculated Field. The entry fields in the dialog, shown in Figure 10.15, are the following: • Name—The unique name you assign the new field. • Formula—The formula for the field. It should consist of one or more selections from the Fields listing, operators, and constants. • Fields—A list of all available fields.
 
 Figure 10.15 Create a Calculated Field to do calculations with fields.
 
 Creating the formula isn’t that different from building one in the formula bar, but instead of cell references, use the fields. Double-click or highlight and select Insert Field to insert a field in the formula. When the formula is complete, click Add to accept it. When you return to the pivot table, the new field will appear in the field list and can be used in the same way as the existing fields.
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 Create a Calculated Field To create a calculated field, follow these steps: 1. Go to PivotTable Tools, Options, Calculations, Fields, Items, & Sets and select Calculated Field. 2. In the Name field, enter the name of the field as it will appear in the field list. 3. Highlight the 0 in the Formula field. 4. Enter the formula in the Formula field. Double-click or highlight and click Insert Field to insert fields into the formula. Type any operators, constants or parentheses as needed directly in the Formula field. 5. Click Add to accept the formula. 6. Click OK. The new field is added to the field list and can now be arranged and formatted as needed in the pivot table.
 
 Adding Color and Lines to a Pivot Table PivotTable Tools, Design, PivotTable Styles consists of various designs that can be applied to the active pivot table. As the cursor is moved over the selections, the pivot table will update. When you find a style you like, click the style and it will be applied to the pivot table.
 
 Hiding Totals By default, subtotals and grand totals are automatically added to the pivot table as the fields are arranged. To hide grand totals, do one of the following: • Right-click a specific grand total field and select Remove fieldname. • Right-click the header of a specific grand total field and select Remove Grand Total. • Right-click the pivot table and select PivotTable Options or go to PivotTable Tools, Options, PivotTable, Options. From the dialog that appears, go to the Totals & Filters tab and deselect Show Grand Totals for Rows and Show Grand Totals for Columns.
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 • Go to PivotTable Tools, Design, Layout, and click the Grand Totals dropdown. From there you can turn all grand totals on or off, or turn on only row grand totals or column grand totals. To hide subtotals: • Right-click a specific subtotal field and unselect Subtotal fieldname. • Select a cell in the specific field. Go to PivotTable Tools, Options, Active Field, Field Settings. From the Field Settings dialog that appears, on the Subtotals & Filters tab, select None. • Go to PivotTable Tools, Design, Layout, and click the Subtotals drop-down. From there you can turn all subtotals off or choose where they appear in respect to their data.
 
 Formatting Values If you right-click a cell in a pivot table, select Format Cells, and apply formatting to the cell, only the one cell will be formatted. To apply formatting to an entire field, the formatting must be applied through the pivot tables Format Cells dialog, shown in Figure 10.16. The dialog is similar to the normal Format Cells dialog, except only the Number tab is available. To access this dialog, do one of the following: • Right-click a cell in the field and select Number Format • Right-click a cell in the field and select Value Field Settings. From the dialog that appears, click Number Format. • Select a cell in the field and go to PivotTable Tools, Options, Active Field, Field Settings. From the dialog that appears, click Number Format.
 
 Refer to “Using Number Formats in Excel and Excel Starter” in Chapter 4, “Data Formatting,” for details on the various number formats.
 
 The selected format will be applied to the entire field. In Figure 10.16, the Currency format was applied to the Revenue field, which is represented by the columns 2008, 2009, and Grand Total.
 
 Pi vo t Ta b l e Vi e ws
 
 225
 
 Figure 10.16 Apply formatting to an entire field through the pivot tables Format Cells dialog.
 
 Pivot Table Views There are three ways the pivot table report will appear, as shown in Figure 10.17. The view can be changed by going to PivotTable Tools, Design, Report Layout, and selecting one of the desired layouts:
 
 Figure 10.17 Excel offers three ways of viewing and working with a pivot table report.
 
 • Compact—This is the default configuration for xlsx or xlsm files. All the fields in the row labels area share the same column. The Total, such as the West Total, appears in the same row as the field.
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 • Outline—The fields in the row labels area each have their own column. The Total, such as the West Total, appears in the same row as the field. • Tabular—This the default configuration for an xls file. The fields in the row labels area each have their own column. The Total, such as the West Total, appears in its own row beneath its group.
 
 Slicers Slicers allow you to filter a pivot table, but in a much more user-friendly way. Unlike the filter drop-down, slicers are always visible and you can change their dimensions to better fit your sheet design, as shown in Figure 10.18. There are three filters—Year, Decade, and Genre—in the figure. The selections update the three pivot tables—Top 20, Top 10 and First Loser—beneath them.
 
 Figure 10.18 The three slicers offer a more visually pleasing and user-friendly way of filtering the pivot tables.
 
 To insert a slicer, go to PivotTable Tools, Options, Sort & Filter, Insert Slicer. The Insert Slicers dialog appears, listing all fields except calculation fields. The field for which a slicer is added does not need to be visible in the pivot table. Slicers can be sized and placed as needed. The Slicer Tools will now be available, from which you can modify many settings, such as changing the look of the slicers and attaching the slicer to multiple pivot tables.
 
 SHOW ME
 
 Media 10.4—Adding Slicers to a Pivot Table Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Add a Slicer to a Pivot Table To add slicers to a pivot table, follow these steps: 1. Go to PivotTable Tools, Options, Sort & Filter, Insert Slicer. 2. Select the field(s) to create slicers for. 3. Click OK. The slicers will be added to the sheet. 4. Click and drag any corner of the slicer to resize it. 5. To set up multiple columns in the slicer, right-click the slicer and select Size and Properties. In the dialog that appears, go to Position and Layout. Under Layout, change the number of columns. Click Close. 6. To change the header that appears at the top of the slicer, right-click the slicer and select Slicer Settings. In the Caption field of the Slicer Settings dialog, enter a new caption. For example, you can use the caption to instruct users to “Hold down Ctrl to select multiple customers.”
 
 For an in-depth look at slicers, refer to Pivot Table Data Crunching: Microsoft Excel 2010 (ISBN 0-7897-4313-2) by Bill Jelen and Michael Alexander.
 
 Making Data Suitable for Pivot Tables Figure 10.2 displays data unsuitable for a pivot table. If you have a dataset with any of the issues shown in that figure, this section may have the steps to help you clean up the data. 1. Make a copy of the dataset. a. Right-click the sheet tab. b. Select Move or Copy. c. From the To Book drop-down, select New Book. d. In the Move or Copy dialog, select Create a Copy, as shown in Figure 10.19. 2. Ensure there are no formulas in the dataset. a. Select the entire sheet by clicking the light gray triangle above and to the left of cell A1. b. Press Ctrl+C to copy the data. c. Go to the Home, Clipboard, Paste drop-down and choose Paste Values.
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 Figure 10.19 Make a copy of the dataset in case you make a mistake.
 
 3. Review the data for patterns in your dataset similar to the patterns in Figure 10.19. The data contains total rows, such as row 5, where column C (Product) is blank. 4. The region and customer information in columns A and B are not repeated in every row. The data will need to be filled in. Select the last cell in column B and then press Ctrl+Shift+Home to select all the data up to column A1. 5. Select only the blank cells. a. Press F5 to bring up the Go To dialog. b. Click the Special button in the lower-left corner of the dialog. c. In the Go To Special dialog, select Blanks and click OK. All the blank cells in the original selection are now the only cells selected. Do not use the keyboard to navigate at this point or you will lose the selection. 6. Enter the following formula. Note that instead of cell references, just key strokes are used, so the formula is easily entered no matter what your actual column selections are. Press the =, the up-arrow key, and Ctrl+Enter. All the previously blank cells will be filled with a formula that points to the cell above the current cell, as shown in Figure 10.20.
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 Figure 10.20 Ctrl+Enter places the formula in all the selected blank cells.
 
 7. Convert the formulas to values. a. Select a cell in column B. b. Press the End key and then the down-arrow to select the last cell in the column. c. Hold down Ctrl+Shift+Home to select up to cell A1. d. Press Ctrl+C to copy the selection. e. Go to Home, Paste, Paste Values. 8. If your dataset contains total rows as discussed in step 3, you can now sort them out of the way and delete them. If your dataset does not contain total rows, skip to step 9. a. Select cell C1. b. Go to Home, Editing, Sort & Filter, Sort A to Z. c. The dataset will be re-sorted with any blank cells in column C moved to the bottom. d. With C1 still selected, press the End key and then the down-arrow twice. This will select the first empty cell in column C. e. Visually verify that from the selected cell to the bottom of the dataset, all the values in column B are total rows. These are the rows you want to delete. f. Move over one cell to the right so you’re now in column B. g. Hold down the Shift key and press End then the down-arrow to select the rest of the rows. h. Right-click over the selection and choose Delete. i. From the Delete dialog, select Entire Row and press OK. The dataset now consists of only records, without any total rows.
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 9. The next issue is the dates going across the top of the data. They should be in their own column. If your data does not have this issue, skip to step 16. Otherwise, continue to step 10. 10. Insert a new column D with the heading Month. 11. Open a new workbook and copy cells A1:E1 from the original workbook to the new workbook. 12. Rename the new cell E1 to Revenue. 13. In the original workbook, copy cell E1 to column D from row 2 to the end of the dataset, as shown in Figure 10.21.
 
 Figure 10.21 Fill in the first data column’s date in column D.
 
 14. Copy columns A:E of the original workbook to the next available blank row in the new workbook. 15. Return to the original workbook. At this point, all the Jan data has been copied to the new workbook, so the Jan column can be deleted. To delete the column a. Select the entire column by clicking the E heading. b. Right-click over the selection and select Delete. 16. Repeat steps 13–15 for the rest of the month columns. 17. After all the months are copied over to the new workbook, sort the data so the blank revenue columns are at the bottom of the dataset. You can then delete them. 18. The dataset is now suitable for pivot tables.
 
 This chapter will show you how to insert and modify charts. It will also introduce you to a new type of mini-chart called sparklines.
 
 11
 
 Creating Charts Charts are a great way to graphically portray data. They’re a quick and simple way to emphasize trends in data. People prefer to look at them instead of trying to make sense of rows and columns of numbers. This chapter will show you how to create charts to supplement your data reports. Excel’s charting abilities discussed in this chapter are also available in Excel Starter. The Web App doesn’t allow new charts to be inserted, but updating existing data, or, if the data is in a Table, adding new rows or columns will update any linked charts.
 
 Components of a Chart A chart is a graphical representation of numerical data. Behind every chart, there is a range on a sheet. This range is called the source data. A series is a row or column from the source data represented on the chart as a line, a bar, or other component used to portray the data. A typical series consists of the following: • Series Name—The cell with the name of the series that will appear in the legend. • Series Values—The row or column containing the data to be charted. • Category Labels—The range containing the label that will appear along the axis, identifying the series value. The axes consist of major and minor gridlines that go usually below and to the left of the charted data (except for pie charts), labeling or marking intervals of the data. An axis may also have an Axis Title or Display Units Title. The legend is the color code for the chart series, identifying each series by the name assigned it. Data labels are text that appears in the chart by the series, identifying the value of
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 the points being charted. Put together, a chart has two areas: • Plot Area—Consists of the series and inner gridlines • Chart Area—Consists of the area surrounding the plot area, including the frame of the chart The column chart in Figure 11.1 has three series, one for each row of data. The series names are East, Central, and West. The series values are presented by the thick-shaded vertical columns. The category labels are the dates, Jan-08 through May-08, along the horizontal or x-axis. Each series has a slightly different color. The legend across the top is used to identify the color for each series.
 
 Figure 11.1 A basic chart and its source data.
 
 Preparing Data The first step in creating a chart is ensuring that the data is set up properly. While these rules aren’t going to prevent a chart from being created, following them will allow Excel to help you quickly create a chart by identifying the chart components. • Ensure that there are no blank rows or columns. • Ensure that headers along the left column and top row identify each series.
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 If the headers consist of numbers or dates, leave the upper-left corner of the chart blank (see cell A2 in Figure 11.1). If the cell isn’t blank, Excel will be confused when it tries to help you create the chart and it will assume there are not category labels.
 
 Types of Charts There are 11 chart groups, each with several types, giving a total of 73 charts you can select from in Excel. Further manual changes, such as mixing chart types, provide even more variations. The Charts group on the Insert tab shows six of the types, with the other five available under the Other Charts drop-down.
 
 In a chart, a marker is the graphic (for example a bar or pie slice) representing a data point being charted.
 
 • Column—Includes 2D Column, 3D Column, Cylinder, Cone, and Pyramid chart types that feature markers relating the vertical height to size. They are useful for showing data changes over a period of time or comparing items. • Line—Includes 2D Line and 3D Line chart types. They are useful for displaying continuous data over time against a common scale. • Pie—Includes 2D Pie and 3D Pie chart types. Pie charts are most suitable for single series datasets. They are useful for showing how an item is proportional to the sum of all items. • Bar—Includes 2D Bar, 3D Bar, Cylinder, Cone, and Pyramid chart types that feature markers relating the horizontal width to size. They are useful for comparing items. • Area—Includes 2D Area and 3D Area chart types. They are similar to line charts except that the area underneath the line is filled with color. Area charts emphasize the magnitude of change over time. • Scatter (XY)—Includes Scatter chart types of just markers, just lines, or combined markers and lines. They show the relationships among numeric values in several data series or can be use to plot two groups of numbers as one series of x,y coordinates. • Stock—Used to illustrate the fluctuation of the data, such as stocks or temperatures. • Surface—Useful for finding the optimum combinations between two sets of data.
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 • Doughnut—Similar to a pie chart in that it shows how an item is proportional to the whole, but unlike a pie chart, can include more than one series. • Bubble—Used to plot data points with the size of a bubble suggesting its relationship to the other bubbles. • Radar—Useful for comparing the total values of several data series. Most of the chart types have three basic patterns available: • Clustered—In a clustered chart, the markers are plotted side by side, making it easier to compare markers. The downside is that it is more difficult to tell if the data is increasing or decreasing in comparison to the next cluster. When viewing the chart types, clustered chart types show a light blue marker next to dark blue marker. • Stacked—In a stacked chart, the markers are plotted on top of each other, making it easier to see how the sum of data changes, but making it more difficult to see how a specific series changes over time. When viewing the chart types, stacked charts show a dark blue marker on top of a light blue marker. The stacks are of differing heights. • 100% Stacked—In a 100% stacked chart, the markers are plotted on top of each other. All stacks are scaled to have a height of 100%, allowing you to see which data points make the largest percentage of each stack. When viewing the chart types, stacked charts show a dark blue marker on top of a light blue marker. The stacks are of the same heights.
 
 TELL ME MORE
 
 Media 11.1—The Importance of Choosing the Right
 
 Chart Type To listen to a free audio recording about choosing the right type of chart, log on to my.safaribooksonline.com/9780132182287/media.
 
 Creating a Chart To create a chart, select a cell in your contiguous dataset and go to Insert, Charts. You can either make a chart selection from the drop-downs, or click the dialog pop-up in the lower-right corner of the group to open the Create Chart dialog shown in Figure 11.2.
 
 SHOW ME
 
 Media 11.2—Creating a Chart Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 C re a t i n g a C h a r t
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 Figure 11.2 Use the Create Chart dialog pop-up (circled) to bring up a dialog showing all the available chart types.
 
 LET ME TRY IT
 
 Creating a Chart To create a chart, follow these steps: 1. Ensure the dataset abides by the rules in the “Preparing Data” section. 2. Select a cell in the dataset. 3. Go to Insert, Charts and select any chart type. Unless you already know the prerequisites for stock and bubble charts, do not select any of those. 4. Excel will add the chart to the sheet. Excel will decide whether to use the rows or columns as headers based on which there are more of. For example, if there are more columns, the rows will be used for the series, with the row headers in the legend and the column headers as the category labels across the horizontal axis (except for pie, bubble, donut, and radar charts).
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 Chart Styles Chart Tools, Design, Chart Styles offers many predefined styles to choose from, ranging in colors, outlines, and dimension. Click the desired style and your chart will update. If none of the predefined styles suits you, go to Chart Tools, Layout, and from the chart elements drop-down at the top of the Current Selection group, select Chart Area or Plot Area, and then click Format Selection. The Format Selection dialog appears, from which you can apply formatting to the selected area. Each series in a chart can be designed individually by selecting the desired series from the chart elements drop-down and then clicking Format Selection. Changes made while the Format Selection dialog is open are applied automatically, but you can click the Undo button in the Quick Access toolbar while the dialog is still open to undo the change.
 
 LET ME TRY IT
 
 Manually Modifying the Look of a Chart To manually modify the chart area, plot area, or series of a chart, follow these steps: 1. Select the desired area to modify by going to Chart Tools, Layout, Current Selection, and selecting Chart Area, Plot Area, or a series from the chart elements drop-down. If a series is selected, the markers of that series will have selection circles around them. 2. From the Current Selection group, click Format Selection. 3. The selected area/series will update automatically as changes are made. Click the Undo button in the Quick Access toolbar to reverse the last change. 4. If you need to make changes to other areas or series, select the area/series from the chart elements drop-down, as shown in Figure 11.3. There is no need to close the Format Selection dialog. 5. Click Close.
 
 C re a t i n g a C h a r t
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 Figure 11.3 Make selections from the chart elements drop-down while the Format Selection dialog is still open to quickly move between the elements you want to change.
 
 Chart Layouts From Chart Tools, Design, Chart Layouts up to 12 chart layouts are available, depending on the type of chart selected. These predefined layouts offer combinations of the chart elements: legend, chart title, axis title, data labels, and data table. Unlike other selection drop-downs, the active chart does not automatically update as you move your cursor over the options. You will need to make a selection by clicking the item before the chart updates. If none of the predefined combinations is what you want, you can manually modify each element, as shown in the following sections.
 
 Adding a Chart Title To add a chart title, go to Chart Tools, Layout, Labels, Chart Title. Click in the title box added to the chart to change the text, or use the formatting tools on the Home tab to change the font as desired. You can also move the title’s box around the chart. There are more formatting options, such as Word Art options, available under More Title Options, found under the Chart Title drop-down or on the Format tab under Chart Tools.
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 Adding a Chart Title To add a title to the selected chart, follow these steps: 1. Go to Chart Tools, Layout, Labels, Chart Title. 2. Select one of the predefined chart locations.
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 3. Select the default text and type in your title. 4. Select the title’s box. The box lines will become solid, showing the box is selected, instead of its contents. 5. Go to Home, Font, and select a different font style from the font style dropdown. You can also make other selections, such as font size, bold, and so on. 6. To make changes to the box itself, such as a border or fill, with the box still selected, go to Chart Tools, Format, Shape Styles, and select an effect to apply to the box. 7. To move the title, place your cursor along the box edge until it turns into four arrows, as shown in Figure 11.4. At this point, hold down the mouse button and drag the box to a new location.
 
 Figure 11.4 Design and place your own chart title using the Chart Title option.
 
 Adding an Axis Title To add an axis title, go to Chart Tools, Layout, Labels, Axis Titles, and select whether you want to add the title to the horizontal or vertical axis. The Vertical Axis Title can be a Rotated Title, Vertical Title, or Horizontal Title. The Horizontal Title can be placed only horizontally along the axis. Click in the title box added to the chart to change the text, or use the formatting tools on the Home tab to change the font as desired. You can also move the title’s box around the chart. More formatting options, such as Word Art options, are available under the more options selections for each axis or on the Format tab under Chart Tools.
 
 Adding or Moving the Chart Legend Go to Chart Tools, Layout, Labels, Legend to see the predefined options for locating the legend. It can be manually sized by clicking and dragging any circle in the corner of its selection frame or the squares on the edge.
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 To relocate the legend, place your cursor on its frame until it turns into a four-arrow cursor, then click and drag it to a new location. If you want the legend to overlap the chart, go to Chart Tools, Layout, Current Selection, Format Selection, and from the dialog that appears, on the Legend Options tab, deselect Show the Legend Without Overlapping the Chart.
 
 Moving or Resizing a Chart To resize a selected chart, place the cursor at any of the four corners or midway along any of the edges of the frame. When the cursor changes to a two-sided arrow, click and drag the chart to the desired size. To move a chart elsewhere on the same sheet, click anywhere in the Chart Area and drag the chart to the new location. To relocate the chart to another sheet, select the chart and go to Chart Tools, Design, Location, Move Chart. From the dialog that appears, select the new sheet from the Object In drop-down. A chart sheet is a special type of sheet in Excel used to display only charts. To relocate the chart to its own chart sheet, select the chart and go to Chart Tools, Design, Location, Move Chart. From the dialog that appears, select the New Sheet option. Charts on a chart sheet cannot be resized, except by zooming in and out on the sheet.
 
 Changing a Chart’s Type You don’t have to re-create a chart from scratch if you want to change the chart type. Just select the chart, go to Insert Charts, and select a new chart type in the same way you created the original. Any formatting that can transfer over will be included in the new chart type.
 
 LET ME TRY IT
 
 Changing an Existing Chart’s Type To change the chart type in an existing chart, follow these steps: 1. Right-click over the chart. 2. Select Change Chart Type. 3. Select a new chart type from the Change Chart Type dialog. 4. Click OK.
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 Mixing Chart Types Some of the chart types can be used together in a single chart, as shown in Figure 11.5. For example, one series can be a bar chart and another series a line chart. To combine chart types, select the series you want to change and either use your preferred insert chart method or right-click the series and select Change Series Chart Type.
 
 Figure 11.5 Combine chart types, such as columns and lines, to create a more meaningful chart.
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 Creating a Chart with Multiple Chart Types To create a single chart consisting of multiple chart types, follow these steps: 1. Select a cell in the dataset. 2. Go to Insert, Charts and select one of the chart types you want to appear in the chart. Excel will add the new chart to the sheet. 3. Select a data series to change by going to Chart Tools, Layout, Current Selection, and selecting the data series from the Chart Elements. 4. Go to Insert, Charts and select the new chart type to apply to the selected series. 5. Repeat steps 3 and 4 for any other series to change.
 
 S h ow i n g N u m b e r s o f D i f fe re n t S c a l e
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 Showing Numbers of Different Scale If the data to chart consists of a series with numbers of vastly different scales, it may be nearly impossible to see all the series in the chart, as shown in Figure 11.6. In this figure charting Revenue and Profit, the Revenue is in thousands whereas the Profits are less than 10 (remember 39% is also 3.9) and are not visible in the chart.
 
 Figure 11.6 The different scales of the data make it almost impossible to see the Profit series.
 
 To correct this, the Profit needs to be plotted against a second vertical axis. A chart can have two scales, one for each vertical axis. A series can be assigned to the secondary axis through the Format Data Series dialog, as shown in Figure 11.7.
 
 Figure 11.7 The Revenue columns are plotted to the left vertical axis, whereas the Profit line is plotted to the secondary axis on the right. Note that the dialog may be slightly different for different chart types.
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 SHOW ME
 
 Media 11.3—Assigning a Series to the Secondary Axis Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Chart Data of Vastly Different Scales To assign a series to the secondary axis, allowing for a different scale, follow these steps: 1. Select the data series to assign to the secondary axis by going to Chart Tools, Layout, Current Selection and selecting the data series from the Chart Elements. 2. Click Format Selection. 3. In the Series Options category, choose Secondary Axis in the Plot Series On frame. A second vertical axis with a scale suitable to the data series will be added to the chart, as shown in Figure 11.7.
 
 Updating Chart Data Unless the source data is a Table, the chart won’t automatically update as new data is added to the source. To manually update the data source of a chart, do one of the following: • Go to Chart Tools, Design, Data, Select Data, or right-click the chart and choose Select Data. Update the Chart Data Range in the Select Data Source dialog, shown in Figure 11.8. • When the chart is selected, the data source is highlighted with a colored border. The borders can be manually modified, changing the source range, by clicking and dragging to include the new rows. If using this method, be careful to not move the range when trying to expand it. In addition to the two previous methods, the existing series on a chart can be updated by copying the new data and pasting it into the chart.
 
 Sw i tc h i n g R ows a n d Co l u m n s
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 Figure 11.8 Update the source data range to include the new series in the chart.
 
 LET ME TRY IT
 
 Pasting New Data onto Existing Series To update existing series with new data using the copy/paste method, follow these steps: 1. Ensure that the new data has a header similar to the existing data. It is especially important that a heading entered as a Date is still a Date and not Text. 2. Select the new data, including the header. 3. Right-click over the selection and choose Copy. 4. Select the chart. 5. Go to Home, Clipboard, Paste. The chart will update with the new data.
 
 Switching Rows and Columns Excel does its best in figuring out what you want a chart to look like, but it can make mistakes. If the data source looks like the one in Figure 11.9, you would get a chart like the left one. But instead of reorganizing the data, use the Switch Row/Column button in the Select Data dialog to switch the range used for the series and the range used for the category labels, creating the chart on the right.
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 Figure 11.9 Instead of reorganizing the data, use the Switch Row/Column button on the Select Data Source dialog to correct the series of the chart.
 
 Trendlines Use a trendline to predict trends in the data or how data will progress if the data continues at the same pace, as shown in Figure 11.10. To add a trend to the selected chart, go to Chart Tools, Layout, Analysis and select a trend from the Trendline drop-down. To create a forecasting trendline, choose More Trendline Options.
 
 Figure 11.10 Use the More Trendline Options of the Trendline drop-down to create a trendline that predicts the future.
 
 You can choose from four predefined trendlines in the drop-down: • Linear Trendline—Adds a linear trendline. • Exponential Trendline—Adds an exponential trendline. • Linear Forecast Trendline—Adds a linear trendline based on a two-period forecast. • Two Period Moving Average—Adds a Two-Period Moving Average Trendline.
 
 Tre n d l i n e s
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 If the predefined trendlines do not fit your requirements, you can design your own through the Format Trendline dialog, using one of the following Trend/Regression Types: • Exponential—A curved line used when values rise or fall at constantly increasing rates. Cannot be used if the data contains zero or negative values. • Linear—A best fit straight line, usually showing that something is increasing or decreasing at a steady rate. • Logarithmic—A best fit curved line used when the rate of change of the data increases or decreases quickly and then levels out. • Polynomial—A curved line used when data fluctuates. Enter the Order to determine the number of fluctuations in the data. • Power—A curved line used to compare measurements that increase at a specific rate. Cannot be used if the data contains zero or negative values. • Moving Average—Smoothes out fluctuations in the data by averaging a specific number of data points and using that average as a point in the line. More than one trendline may be added to a chart by making different selections from the drop-down. To modify an existing trendline, you will need to select it from the Chart Elements drop-down and choose Format Selection.
 
 LET ME TRY IT
 
 Adding a Forecasting Trendline To add a forecasting trendline to an existing chart, follow these steps: 1. Select the chart. 2. Go to Chart Tools, Layout, Analysis, Trendlines, and choose More Trendline Options. 3. In the Trendline Options category, in the Trend/Regression Type frame, select the type of trendline to add to the chart. 4. In the Forecast frame, enter the number of periods to forecast in the Forward field. 5. In the Line Style category, select a dashed line from the Dashed Type dropdown so the trendline will stand out from a normal series.
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 Stock Charts There are four types of stock charts that you can create using historical stock data. Each type has specific requirements for included columns and their order. If the order of the data is not met, the chart will not be created. The charts and their required columns and order are as follows: • High-Low-Close—Requires four columns of data: date, high, low, close. • Open-High-Low-Close—Requires five columns of data: date, open, high, low, close. • Volume-High-Low-Close—Requires five columns of data: date, volume, high, low, close. • Volume-Open-High-Low-Close—Requires six columns of data: date, volume, open, high, low, close. After the data is in the correct column order, the chart can be selected from the Other Charts drop-down, as shown in Figure 11.11.
 
 Figure 11.11 The column order for a stock chart must match the ToolTip exactly.
 
 LET ME TRY IT
 
 Creating a Stock Chart To create a stock chart, follow these steps: 1. Decide which stock chart you want by going to Insert, Charts, Other Charts and moving the cursor over each stock chart. Note the required columns and their order for the desired chart.
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 2. Ensure that the columns in the dataset are in the correct order. If not, refer to “Rearranging Columns” in Chapter 7, “Sorting.” 3. Sort the data by date, oldest to newest. 4. Select a cell in the dataset. 5. Return to the drop-down of stock charts and this time click the desired chart.
 
 Bubble Charts You may want to use a bubble chart because they are unusual, but there is a practical reason for using one. With a bubble chart, you can display a relationship among three variables. The x,y coordinates represent two variables and the size of the bubble is the third. In Figure 11.12, Miles and Age are charted along the x and y axes, respectively. The Price becomes the size of the bubble at the intersection of the x,y coordinate.
 
 Figure 11.12 The size of the bubble at the intersection represents the relative price.
 
 Pie Chart Issue: Small Slices When creating a pie chart, you may end up with slices that are very difficult to see. Two possible ways of dealing with this are to rotate the pie or create a Bar of Pie chart.
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 Rotating the Pie Rotating the pie works best if the chart is 3D. By rotating the chart so the smaller slices are toward the front, they are easier to see, as shown in Figure 11.13. To rotate the pie: 1. Select the chart. 2. Go to Chart Tools, Layout, Current Selection, and select the series from the chart elements drop-down. 3. Select Format Selection. 4. From the Series Options category, in the Angle of First Slice frame, move the slider to the right, toward Full Rotation. The chart will update when you let go of the mouse button, so you can see how far you need to move the slider. 5. When the chart is rotated satisfactorily, click Close.
 
 Figure 11.13 Rotate the pie chart to place the smaller pie slices toward the front, making them easier to see.
 
 Create a Bar of Pie Chart Bar of Pie is one of the options listed under Insert, Chart, Pie. It’s used to explode out the smaller pie slices into a stacked bar chart, as shown in Figure 11.14, making the smaller slices more visible. Excel will create a new slice called Other, which is a grouping of the slices now in the bar. But the default explosion may not be adequate to your needs. This can be changed by going into the Format Data Series dialog and changing the number of values included in the bar.
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 Figure 11.14 Use a Bar of Pie chart to group smaller slices into a stacked bar chart, making the smaller slices more visible.
 
 LET ME TRY IT
 
 Change to a Bar of Pie Chart To change an existing pie chart to a bar of pie chart and modify the number of slices used in the stacked bar in the chart, follow these steps: 1. Right-click over the chart. 2. Select Change Chart Type. 3. In the Change Chart Type dialog, go to Pie and select Bar of Pie. 4. Click OK. The chart will change to a bar of pie chart. If you’re happy with the default selection for the number of slices moved to the stacked bar, you’re done. Otherwise, continue to step 5 to change the number of slices used in the bar. 5. With the chart still selected, go to Chart Tools, Layout, Current Selection, and select the series from the Chart Elements drop-down. 6. Click Format Selection. 7. From the Series Options category, change the number of values in the Second Plot Contains the Last x Values field. As the value is changed using the spin buttons, the chart will update. 8. When satisfied with the chart, click Close.
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 Sparklines A sparkline is a tiny chart inside of a cell. It can be placed right next to the data it’s charting. And because the sparkline is in the background of the cell, you can still enter text in that cell. There are three types of sparklines available: Line, Column and Win/Loss. Different colors can be applied to them and various settings affect how the sparkline will be designed. To add a sparkline to your data, select either where you want the sparkline to go or the dataset (not including the headers) and go to Insert Sparklines. Fill in the fields of the Create Sparklines dialog and the sparklines will be added to the sheet.
 
 SHOW ME
 
 Media 11.4—Creating Sparklines Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Creating Sparklines To create sparklines for a dataset, follow these steps: 1. Select the range where you want the sparklines to be placed. 2. Go to Insert, Sparklines, and select the desired sparkline type. 3. In the Create Sparklines dialog that appears, place your cursor in the Data Range field. 4. Highlight the data range on the sheet, making sure not to include any row or column headers. 5. Verify the Location Range. It should be the same range you selected in step 1. 6. Click OK. The sparklines will be added to the cells.
 
 Adding Points to a Sparkline After you’ve created a sparkline, you can choose to show the High Point, Low Point, Negative Points, First Point, Last Point, and Markers (line charts only), as shown in the first two examples in Figure 11.15. To add points to a sparkline, select the sparkline and then go to Sparkline Tools, Design, Show, and select the desired
 
 Sparklines
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 points. Each point can be assigned its own color by going to the Marker Color drop-down in the Style group.
 
 Figure 11.15 Use Sparklines to add in-cell charts to your data.
 
 Spacing Markers in a Sparkline The fourth chart in Figure 11.15 uses the Date Axis Type option to space the columns out in respect to the date of the dataset. Note the space in the sparkline between the first and second columns. This is parallel to the date difference between the first two columns of data. The setting is available in the sparklines Axis drop-down.
 
 The date range must include real dates. For example, Jan, Feb, Mar, and the like won’t work because these are not actual dates, but if the actual dates are 1/1/10, 2/1/10, 3/1/10 and they are simply formatted to just show the month, they will work to space out the data in the sparkline.
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 Spacing Sparklines Based on Date To space out sparklines based on the dates in the dataset, follow these steps. If you’ve already created the sparklines, skip to step 7: 1. Select the range where you want the sparklines to be placed. 2. Go to Insert, Sparklines, and select the desired sparkline type. 3. In the Create Sparklines dialog that appears, place your cursor in the Data Range field. 4. Highlight the data range on the sheet, making sure not to include any row or column headers. 5. Verify the Location Range. It should be the same range you selected in step 1. 6. Click OK. The sparklines will be added to the cells, in the default configuration close together. You will begin spacing them out in the next step. 7. Select a cell in the sparkline group. 8. Go to Sparkline Tools, Design, Group, Axis, and select Date Axis Type from the drop-down. 9. The Sparkline Date Range dialog appears. Select the date range to apply to the sparklines. 10. Click OK. The sparklines will update to accommodate the spacing in the selected date range.
 
 Delete Sparklines You cannot simply highlight a sparkline and delete it. Instead, to delete a sparkline, go to Sparkline Tools, Design, Group, Clear, and choose either Clear Selected Sparklines or Clear Selected Sparkline Groups.
 
 Saving a Chart as a Template If you have a chart design you want to apply to multiple charts, you can save the design as a template. All the settings for colors, fonts, effects, and chart elements are saved and can be applied to other charts. Because the template is saved as an external file, you can share it with other users.
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 To create the template, build and customize a chart as necessary. Then select the chart and go to Chart Tools, Design, Type, Save as Template. Give the template a name and click Save. The template is now available in the Templates option of the Insert Chart dialog.
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 Creating a Chart Using a User-Created Template To use a custom template to create a chart, follow these steps: 1. Select a cell in the dataset. 2. Go to Insert, Charts, and from any of the drop-downs, select All Chart Types to open the Insert Chart dialog. 3. In the Insert Chart dialog, choose Templates. 4. Select the desired template. 5. Click OK. The chart will be created with the saved settings from the template.
 
 This page intentionally left blank
 
 This chapter will show you how to insert SmartArt, WordArt and Pictures onto your sheets.
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 SmartArt, WordArt, and Pictures You can add a little pizzazz to your workbooks by using graphic text and images. This chapter introduces you to SmartArt, which combines graphics and text to depict ideas, WordArt to twist colorful text, and the Picture tools you can use to manipulate imported images.
 
 SmartArt SmartArt is a collection of similar shapes, arranged to imply a process, groups, or a hierarchy. You can add text to SmartArt shapes, and for some shapes, include a small picture or logo. Excel 2010 has more than 130 available diagrams, grouped into eight categories of SmartArt: • List—Designs for nonsequential lists of information. • Process—Designs for sequential lists of steps. • Cycle—Designs for steps that repeat. • Hierarchy—Designs for organization charts, decision trees, and other hierarchical relationships. • Relationship—Designs for showing the relationships between items. • Matrix—Designs to show four quadrants of a list. • Pyramid—Designs to show overlapping, proportional, containment, or interconnected relationships. • Picture—Designs for use with pictures in either sequential or nonsequential layouts. The picture tools can be used to adjust the imported images.
 
 You can’t insert SmartArt in Excel Starter, but you can edit the text; editing options are available by right-clicking a component and selecting Format Shape.
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 SmartArt diagrams are removed when you open a workbook in the Excel Web App. In legacy versions of Excel, SmartArt will be turned into Pictures.
 
 Inserting SmartArt To insert a SmartArt diagram, go to Insert, SmartArt, and select the desired layout. Excel places the diagram in the middle of the screen with the Text pane to the left, as shown in Figure 12.1. When you’re done entering text, click any cell on the sheet and the Text pane will disappear.
 
 Figure 12.1 Use the Text pane to insert and organize the text in the SmartArt.
 
 Do not click the x in the upper-right corner of the Text pane to close it or the next time you place SmartArt, the Text pane will not automatically appear. If this happens, you can manually open the Text pane by going to SmartArt Tools, Design, Create Graphic, and selecting Text Pane.
 
 You should keep a few things in mind concerning the Text pane: • Click a placeholder to enter the text. • Navigate between bulleted items by using the mouse or arrow keys. • The Tab key will not work to move between the placeholders. Instead, use the Tab key to demote an item. • Press Enter to add a new item beneath the currently selected item. • Deleting a bullet will promote the ones beneath it if they are of a lower level.
 
 Inserting SmartArt Images
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 SHOW ME
 
 Media 12.1—Inserting SmartArt Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Inserting SmartArt To insert a SmartArt layout and enter text, follow these steps: 1. Go to Insert, SmartArt, and select the desired layout. 2. In the Text pane, select a placeholder and enter the desired text. 3. Use the mouse to select the next placeholder or use the down-arrow key to move to the next placeholder for entering text. • To insert a new bullet, press the Enter key. • To demote an item to the next level, press the Tab key. • To add a new graphic, select the last bullet, press the Enter key to insert a new bullet, and then click Promote, found under Tools, Design, Create Graphic, as many times as necessary to make the bullet a level 1 item. 4. Repeat step 3 as many times as necessary. 5. When you are done entering information, click any cell on the sheet.
 
 Inserting SmartArt Images This section covers the specifics of working with images in SmartArt. If this is the first time you’ve entered SmartArt, refer to “Inserting SmartArt” for instruction on entering text, adding new graphics, and promoting or demoting the bulleted items.
 
 Some SmartArt layouts include image placeholders, as shown in Figure 12.2. To insert an image, click the image placeholder and browse to the desired image. When an image in the SmartArt is selected, the Picture Tools tab becomes visible and you can use any of the picture tools on the image. • To change the image, select it and go to Picture Tools, Format, Change Picture.
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 • You cannot delete the accompanying text placeholder, but if you do not need it, enter a space in the field.
 
 Figure 12.2 Use images in SmartArt to create a business organization chart.
 
 The picture tools are reviewed in the later section “Inserting Pictures.”
 
 SHOW ME
 
 Media 12.2—Inserting SmartArt That Includes Images Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Inserting SmartArt with Images To insert a SmartArt layout that includes images, follow these steps: 1. Go to Insert, SmartArt, and select a layout that includes image placeholders. 2. Click the image placeholder and the Insert Picture dialog opens. Browse to the desired image and click Insert. 3. Use the options on the Picture Tools tab to make any required changes to the image.
 
 Inserting SmartArt Images
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 4. If you do not want any text in the image’s accompanying text placeholder, enter a space in the text’s placeholder. 5. Repeat steps 2 through 4 as many time as required.
 
 Selecting SmartArt Selecting SmartArt must be done carefully. If you have the incorrect frame selected, you will move the component instead of the entire SmartArt frame. You can tell if a component is selected because the frame around it will become visible. Only the frame around the entire SmartArt diagram is visible when you’ve selected the entire diagram. Also, nothing will be selected in the Text pane when the entire diagram is selected. If a component is selected, move your cursor over the frame until it turns into four arrows, then click on the frame and the entire diagram will be selected. When the frame is selected, you can move it to a new location, resize it, or delete it. • When moving or resizing the diagram, the Text pane will momentarily disappear. • To move the diagram, place the cursor on the frame until it turns into four arrows; then click and drag it to a new location. • To resize the diagram, place the cursor in any corner or place it in the center of any edge until it turns into a double arrow. You can then click and drag the diagram to a new size.
 
 Adding and Deleting Shapes Use Add Shape to add a new shape to the SmartArt diagram. The new shape will be added above the selected shape or at the bottom if the entire diagram is selected. To delete a shape, select it so you see the frame around it and press the Delete key.
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 Adding a Shape in the Middle of the Diagram To add a new component shape in the middle of the diagram, follow these steps: 1. Select the component where you want the new shape. 2. Go to SmartArt Tools, Design, Create Graphic, and select Add Shape.
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 3. The component selected in step 1 will be moved down and the new shape inserted in its location. 4. If the new shape is not in the correct location, select level 1 of the component and go to SmartArt Tools, Design, Create Graphic, and choose Move Up or Move Down.
 
 Reorder Components To move a component to a new location, use Move Up and Move Down found under SmartArt Tools, Design, Create Graphic. Move Up and Move Down refer to the order of the items as shown in the Text pane, not their actual configuration in the diagram. To move an item to a new component, it must be cut from its current location and pasted to the new location. • Any customized formatting of a component will move with the component. • Each level can be moved individually, with any sublevels moving with their parent level. • A level can be moved only within its group, it cannot be moved beyond its group. So if an item is level 2, it cannot be moved past its level 1 parent.
 
 LET ME TRY IT
 
 Reordering Components in a Diagram To change the order of components, follow these steps: 1. In the Text pane, place your cursor in the text of the level to be moved. Any children of the selected level will move with the parent. So if you’re moving an entire component, select level 1. If a level 2 item includes level 3 items, place your cursor at level 2 and the level 3 items will also move. 2. Go to SmartArt Tools, Design, Create Graphic, and choose Move Up to move the select item up the Text pane or Move Down to move the item down the Text pane. 3. If an item needs to be moved to an entirely different component group, highlight the text in the Text pane. 4. Press Ctrl+X to cut the text out of the Text pane. 5. Place your cursor in the new location for the text. 6. Press Ctrl+V to paste the text to the new location.
 
 Inserting SmartArt Images
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 Formatting the Selected Layout The text formatting options found in the Font group of the Home tab can be applied to any selected item in SmartArt. If you select a component, the formatting will be applied to all text entries in the component. If you select a single word, the formatting will apply to just that word. The exception to this formatting is font size. Selecting a single item in a component, such as just one word in a sentence, will have unexpected results, as shown in Figure 12.3. But you can change the font size of all the text in a selected component.
 
 Figure 12.3 Changing the font size of “layout” to 54 changed the rest of the sentence’s font size from 11 to 18.
 
 Changing the Selected Layout You can change the layout of the current diagram to a new layout by going to the Layouts group of the SmartTools, Design tab. The drop-down will show the available layouts of the current diagrams category, but you can access all the categories and their layouts by selecting the More Layouts option at the bottom of the dropdown. This will open the Choose a SmartArt Graphic dialog with all available categories and layouts. Existing levels and text will transfer over to the new layout.
 
 Changing an Individual Component You can change the shapes of individual components in a diagram by selecting the component and going to SmartTools, Format, Shapes, Change Shape, and selecting a new shape in the drop-down. Every component in the diagram can be replaced, as shown in Figure 12.4.
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 Figure 12.4 You can replace every shape in a diagram to create your own custom SmartArt.
 
 Linking a Cell to Smart Art Converted SmartArt diagrams will be removed when you open a workbook in the Excel Web App.
 
 You can’t actually link SmartArt text to a cell, but you can create the layout in SmartArt, convert it to shapes, and then replace the text with formulas linking the component to a cell. This allows the text in the layout to update automatically when the cell’s text updates. There are two reasons why it’s important to make sure the SmartArt is designed perfectly before converting it. First, after you convert it, it’s no longer SmartArt and you will not have access to the SmartArt tools to make changes. The second reason is that it is much easier to select the correct frames when they have text in them already.
 
 SHOW ME
 
 Media 12.3—Linking SmartArt to Cells Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Linking SmartArt to Cells To link SmartArt to a cell, follow these steps: 1. Set up the sheet as needed, including the cells with dynamic text that you will link the SmartArt components to. 2. Completely design the SmartArt, including the placement of sample text. 3. Select the diagram. 4. Go to SmartArt Tools, Design, Reset, Convert to Shapes. This will convert the SmartArt to individual shapes. 5. Go to Drawing Tools, Format, Arrange, Selection Pane. The Selection pane opens on the right side of the window. 6. Many components in SmartArt consist of layers of shapes, which are all now visible in the Selection pane. Select one of the components called Freeform. The corresponding shape will be selected on the sheet. If this is not the desired shape, select another in the Selection pane until the shape you want is highlighted. Freeform is usually the shape used to hold text. 7. After the desired shape is selected, place your cursor in the formula bar, type an equal sign and then the cell address of the cell you want to link the shape to, as shown in Figure 12.5. 8. Repeat steps 6 and 7 until all components are linked.
 
 Figure 12.5 Insert the formula in the formula bar to link the shape to a cell.
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 Inserting WordArt WordArt is removed when you open a workbook in the Excel Web App. In Excel Starter and legacy versions of Excel, WordArt may not appear as designed.
 
 WordArt allows you to design text beyond the capabilities of the normal font settings on the Home tab, as shown in Figure 12.6. After inserting the WordArt, go to the Drawing Tools, Format tab to access the various tools for modifying the color and shape.
 
 Figure 12.6 Use WordArt to bend and twist text.
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 Inserting and Formatting WordArt To insert WordArt and customize it, follow these steps: 1. Go to Insert, Text, WordArt, and select a text style from the drop-down. The WordArt will be added to the active sheet. 2. Excel adds generic text in the preset WordArt. Select the default text and type your own text. 3. To change the font style, select the text and choose a new font style from the Font group of the Home tab.
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 4. To add effects to the WordArt, such as the curve in Figure 12.6, go to Drawing Tools, Format, WordArt Styles, Text Effects. An option from Transform was used in the figure.
 
 Inserting Pictures After you’ve inserted a picture onto a sheet, the picture tools become available, which you can use to crop and add many effects to the image.
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 Inserting a Picture To insert a picture, follow these steps: 1. Select the cell where you want the top-left corner of the picture to be. 2. Go to Insert, Illustrations, Picture. 3. Select the image to import and click Insert.
 
 Resizing and Cropping Pictures Cropped images are removed when you open a workbook in the Excel Web App.
 
 To resize the selected image, click and drag one of the handles along the edge or in the corners of the picture. For more specific sizing, enter the size in the Shape Height or Shape Width fields of the Size group on the Picture Tools, Format tab. You can manually crop an image or crop it to a specific shape, as shown in Figure 12.7. To crop the selected image, go to Picture Tools, Format, Size, and select an option from the Crop drop-down. If you later decide you’ve made a mistake, go to Picture Tools, Format, Adjust, Reset Picture, Reset Picture & Size, and the image will return to its original state. The Crop option is for a manual crop. On the image, black cropping handles appear that you can use to outline the area to crop. The part of the picture you are cropping away will appear grayed out.
 
 266
 
 Chapter 12
 
 |
 
 S m a r t A r t , Wo rd A r t , a n d Pi c t u re s
 
 Figure 12.7 Use the cropping tools to crop the image to a particular object or place the image in a shape.
 
 LET ME TRY IT Choose Crop to Shape to crop the image to one of the shapes available in the drop-down. The image will be recut to the selected shape. To nudge the image within the shape, right-click the image and select Format Picture. From the Format Picture dialog, go to the Crop category and under the Picture Position options, change the values in the Offset X and Offset Y fields. Adjusting the Offset X value will move the image left or right in the shape; Adjusting the Offset Y value will move the image up or down in the shape.
 
 Cropping a Picture to a Shape To crop an inserted picture to a shape, follow these steps: 1. Select the picture to crop. 2. Go to Picture Tools, Format, Size, and from the Crop drop-down, select Crop to Shape and select the desired shape. 3. If the image needs to be moved within the shape, right-click the image and select Format Picture. 4. Go to the Crop category. 5. Under the Picture Position options, adjust the Offset X and Offset Y values as needed until the image is placed properly in the shape.
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 Corrections, Color, and Artistic Effects You can correct the brightness and contrast, change a color image to a black-andwhite image, or apply artistic effects to the selected image through the options in the Adjust group of the Picture Tools, Format tab. As you select an option in a dropdown, the image automatically adjusts, providing a preview of the option. Click the option to accept the change.
 
 TELL ME MORE
 
 Media 12.4—Applying Styles
 
 To listen to a free audio recording about the various picture styles, log on to my. safaribooksonline.com/9780132182287/media.
 
 Corrections The Corrections drop-down consists of options to Sharpen and Soften the image and to adjust Brightness and Contrast. If none of the predefined options are what you want, you can manually make the adjustments by selecting Picture Corrections Options, which will open the Format Picture dialog to the Picture Corrections category. Changes made in the dialog will apply automatically to the image. To undo a change, click the Undo button in the Quick Access toolbar.
 
 Color The Color drop-down includes options for adjusting Color Saturation, Color Tone, or recoloring the image. The More Variations option at the bottom of the dropdown is part of the Recolor group. The Set Transparent Color allows you to select a pixel in the image, and all pixels of the same color will become transparent, showing whatever is behind the image. For more control of saturation, tone, and recolor options, select Picture Color Options, which opens the Format Picture dialog to the Picture Color category. Changes made in the dialog will apply automatically to the image. To undo a change, click the Undo button in the Quick Access toolbar.
 
 Artistic Effects Artistic effects include Glow Edges, Film Grain, Light Screen, and many other effects that will change the way an image looks, as shown in Figure 12.8. After you select an effect, you can fine-tune it through the Artistic Effects category of the Format Picture dialog. The fine-tuning options differ depending on the effect chosen. Changes made in the dialog will apply automatically to the image. To undo a change, click the Undo button in the Quick Access toolbar.
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 Figure 12.8 The Pencil Grayscale effect was used to change a photograph into an image that looks like a sketch.
 
 Arranging Pictures The Arrange group of the Picture Tools, Format tab consists of several options for arranging imported images: • Bring Forward—Brings the selected image forward, placing it on top of other images it is stacked with. Includes Bring to Front, which places the selected image as the topmost image. • Send Backward—Send the selected image backward, placing it below other images it is stacked with. Includes Send to Back, which places the selected image behind all other images. • Selection Pane—Opens a side pane that lists all the shapes on the active sheet. You can use this pane to select a specific shape. • Align—Includes various alignment options, as shown in Figure 12.9, to quickly line up the selected images. • Group—Includes the options to group and ungroup the selected images. Grouping images allows you to move them together without losing their alignment or order. If selective images were grouped together at one point
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 and then ungrouped, Regroup will re-create the group without your having to reselect all the images. • Rotate—Rotates or flips the selected image.
 
 Figure 12.9 Align Left lines up the selected images based on the left edge of the topmost image.
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 Aligning Selective Images To align selective images, follow these steps: 1. Place the images approximately how you want them. For example, if you want to align the images left, place them in a vertical layout. If you want to line them up by their centers, place them in a horizontal layout. Each command’s icon provides an example of how the images should be laid out. 2. Select the images by holding down the Ctrl key and clicking each image in turn. 3. Go to Picture Tools, Format, Arrange, and select the desired alignment from the Align drop-down.
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 Reducing a Picture’s File Size Importing a picture into a workbook can dramatically increase the file size. The Compress Pictures option offers multiple options for compressing images based on how you will be using the workbook, as shown in Figure 12.10. You can further reduce the file size by selecting the Delete Cropped Areas of Pictures option, but this means that you will be unable to return the image to its original state.
 
 Figure 12.10 The Compress Pictures dialog offers multiple options for how much the image resolution should be reduced based on how you will be using the workbook.
 
 You don’t need to be a programmer to record macros or create UDFs. This chapter will teach you how to get the most out of the macro recorder and how to create custom functions.
 
 13
 
 Macros and UDFs VBA macros enable you to automate any process in Excel. The macro recorder is provided to help create macros, but there are undocumented rules that must be followed to have the macro recorder work successfully. This chapter teaches you how to successfully record a simple macro that can deal with datasets of any size. It also introduces you to user-defined functions (UDF), which are useful when a builtin function doesn’t exist for your needs.
 
 To really get beyond the macro recorder and write your own code, check out VBA and Macros for Microsoft Excel 2010 by Bill Jelen and Tracy Syrstad from Que Publishing (ISBN 0789743140).
 
 Enabling VBA Security Security settings can be set for all workbooks or for specific, trusted locations. Workbooks stored in a folder that is marked as a trusted location will automatically have its macros enabled. Macro settings are found under File, Options, Trust Center, Trust Center Settings, Macro Settings. The four macro setting options are • Disable All Macros Without Notification—Prevents all macros from running. With this setting, only macros in the Trusted Locations folders can run. • Disable All Macros with Notification—The recommended setting. A message is displayed in the Message Area that macros have been disabled. You can choose to enable the content by clicking that option, as shown in Figure 13.1. • Disable All Macros Except Digitally Signed Macros—Requires you to obtain a digital signing tool from VeriSign or another provider. Appropriate if you are going to be selling add-ins to others, but a bit of a hassle if you just want to write macros for your own use.
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 • Enable All Macros (Not Recommended: Potentially Dangerous Code Can Run)—Although this option requires the least amount of hassle, it opens your computer to attacks from malicious Melissa-like viruses. Microsoft suggests that you do not use this setting. The recommended macro setting is Disable All Content with Notification. With this setting, if you open a workbook that contains macros, you’ll see a Security Warning in the area just above the formula bar, as shown in Figure 13.1. Assuming you were expecting macros in this workbook, click Enable Content.
 
 Figure 13.1 The Disable Macros with Notification settings gives you control over whether to allow macros to run.
 
 If you do not want to enable macros for the current workbook, dismiss the Security Warning by clicking the X at the far right of the message bar. If you forget to enable the macros and attempt to run a macro, a message informs you that you cannot run the macro because all macros have been disabled. You will need to close the workbook and reopen it to access the message bar again and enable the macros. After you enable macros for a workbook stored on a local hard drive and then save the workbook, Excel will remember that you previously enabled macros in this workbook. The next time you open this workbook, macros will be automatically enabled.
 
 TELL ME MORE
 
 Media 13.1—Creating a Trusted Location
 
 To listen to a free audio recording about creating a trusted location for your workbooks, log on to my.safaribooksonline.com/9780132182287/media.
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 Developer Tab By default, the Developer tab is hidden in Excel. The Developer tab contains useful tools, such as buttons for recording macros and adding controls to sheets. To access it, do the following: 1. Go to File, Options, Customize Ribbon. 2. In the right list box, select the Developer tab, which is near from the bottom. 3. Click OK to return to Excel. Excel displays the Developer tab shown in Figure 13.2.
 
 Figure 13.2 You’ll need the Developer tab to access tools specific to macros.
 
 The buttons in the Code group on the Developer tab are used for recording and playing back macros: • Visual Basic—Opens the Visual Basic Editor (VB Editor or VBE). • Macros—Displays the Macro dialog, where you can choose to run or edit a macro from the list of macros. • Record Macro—Begins the process of recording a macro. • Use Relative Reference—Toggles between using relative or absolute recording. With relative recording, Excel will record that you move down three cells. With absolute recording, Excel will record that you selected cell A4. • Macro Security—Shortcut to access the Trust Center, where you can choose to allow or disallow macros to run on this computer.
 
 Introduction to the Visual Basic Editor Click the Visual Basic button in the Code group of the Developer tab. This will open the VB Editor, shown in Figure 13.3, which is the interface used for writing and editing macros. On the left side is the Project Explorer, which lists all the workbooks
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 and add-ins and their components. On the right side is the Code pane where you view and edit the macros you create.
 
 Project Explorer
 
 Code Pane
 
 Figure 13.3 The Project Explorer on the left side of the screen is the primary method of navigating through the components of the workbook in the editor.
 
 Project Explorer The Project Explorer lists any open workbooks and add-ins that are loaded, as shown in Figure 13.3. If you click the + icon next to the VBA Project, you will see a folder with Microsoft Excel objects. There can also be folders for forms, class modules, and standard modules. Each folder includes one or more such components. If the Project Explorer is not visible, select View, Project Explorer from the menu. A module is a component that in the Project Explorer where you enter code. A userform, or form, is a popup window, for example a window that asks you to type in more information, which also includes code. Right-clicking a component, such as Module1, and selecting View Code or just double-clicking the desired component brings up any code in the module in the Code pane. The exception is userforms, where double-clicking displays the userform in Design view.
 
 Inserting Modules A project consists of sheet modules for each sheet in the workbook and a single ThisWorkbook module. Code specific to a sheet, such as controls or sheet events, is placed on the corresponding sheet. Workbook events, code that runs automatically when something happens, for example when the workbook is opened or text is entered in a cell, are placed in the ThisWorkbook module. The code you record and the UDFs you create will be placed in standard modules.
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 Inserting a Standard Module To insert a standard module, follow these steps: 1. Right-click the project you need to insert the module into. 2. From the context menu, select Insert, Module. 3. The module is placed in the Modules folder.
 
 Understanding How the Macro Recorder Works This section is about the difference between recording a macro that will run successfully on a new dataset and one that will make you cry in frustration when it fails on a new dataset. You’ll rarely be able to record 100 percent of your macros and have them work on different datasets, but with the tips in the following subsections, you’ll greatly improve your chances. The macro recorder is very literal, especially with the default settings. For example, if you have cell A1 selected, then begin the macro recorder and use the mouse to select your entire dataset in range A1:B10, this is what will be recorded: Range(“A1:B10”).Select If the next time you run the macro the dataset is A1:B20, your macro won’t run on all the rows. There are two things you need to change to make the recorded macro work properly. First, don’t use the mouse when selecting ranges. Second, don’t use the default settings of the macro recorder.
 
 SHOW ME
 
 Media 13.2—Getting the Most Out of the Macro Recorder by Using the Keyboard Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 Navigating While Recording To get the most out of the macro recorder, you should use the keyboard shortcuts to navigate the sheet, not the mouse. The reason is that some of the keyboard shortcuts translate to commands instead of specific cell selections. For example, if you record pressing Ctrl+down-arrow to jump to the last row in a column, you will get
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 Selection.End(xlDown).Select If your dataset changes in size the next time you run the macro, the preceding line of code will be much more useful than if you’d recorded the macro by using the mouse.
 
 Relative References in Macro Recording The second rule to successful macro recording is to know when to turn relative referencing on and off. By default, it is off, which has it uses, but you’ll often want it on.
 
 For more information on relative referencing, refer to “Relative Versus Absolute Formulas” in Chapter 5, “Using Formulas.”
 
 You can turn Relative Referencing on and off as needed while recording a macro.
 
 When relative referencing is off, the macro records specific cell addresses. Imagine you have a list of addresses similar to Figure 13.4. Each address is exactly three rows, and a blank row separates each address. To transpose an address to a single row, you would follow these steps:
 
 Figure 13.4 Transposing this long list of addresses to multiple columns and rows would make it easier to use them in a mail merge.
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 1. Start in cell A1. 2. Press the down-arrow key. 3. Press Ctrl+X to cut the address. 4. Press the up-arrow key and then the right-arrow key (to move to cell A2, remember, use the keyboard to navigate). 5. Press Ctrl+V to paste the address next to the name. 6. Press the left-arrow key once and the down-arrow key twice to move to the cell containing the city, state and ZIP Code. 7. Press Ctrl+X to cut the city. 8. Press the up-arrow key twice and the right-arrow key twice to move to the right of the street cell. 9. Press Ctrl+V to paste the city. 10. Press the left-arrow key twice and the down-arrow key once to move to the new blank row just beneath the name. 11. Hold down the Shift key while pressing the down-arrow key twice to select the three blank cells. 12. Press Ctrl+- to bring up the Delete dialog. 13. Press R to select the Entire Row option and then press Enter to accept the command. If you record these steps with relative referencing off, you will get code that is cell specific, as shown in the text box in Figure 13.5. The results of running this code repeatedly on the data from Figure 13.4 is shown in Figure 13.5. A couple of repetitions of the code overwrites the first address line, ruining the record. If this example was your first recorded macro, you might despair, as many before you have, at the uselessness of the recorder. But there is a way to make it work, and that’s to turn on the Use Relative References option found in the Code group on the Developer tab. Performing the same steps with relative referencing on returns the results in Figure 13.6. As the active (or selected) cell moves down the column, the correct fields are cut and pasted to the proper row and column.
 
 SHOW ME
 
 Media 13.3—Recording a Macro Using Relative Referencing Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
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 Figure 13.5 Recording the macro with relative referencing off recorded the specific cell address for processing the first address, making the code useless for subsequent addresses.
 
 Figure 13.6 Turn on the relative reference option while recording to record your movements instead of the specific cell addresses.
 
 Avoid the AutoSum Button If you use the AutoSum button while recording a macro, Excel will record the actual formula entered in the cell in R1C1 notation. It doesn’t record that you wanted it to select the range above or to the left of the formula. It’s just not that flexible. So, instead of using the AutoSum button, manually type in the formula mixing relative and absolute referencing.
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 For more information on relative referencing, refer to “Relative Versus Absolute Formulas” in Chapter 5, “Using Formulas.”
 
 For example, if you want to sum G2:G13, the AutoSum function will create the formula =SUM(G2:G13), or in R1C1 notation, =SUM(R[-12]C:R[-1]C). When viewed in R1C1 notation, you see how fixed the formula is. Although it will work in any column that it’s placed in, it specifically includes the cells 12 cells above (row 2) and directly above (row 13) the formula cell. The problem is if you add more rows, then the first cell is no longer 12 rows above—it’s more. The solution is to type in the formula manually, fixing the row for the first argument, as shown in Figure 13.7.
 
 Figure 13.7 Instead of using the AutoSum button, type in SUM formulas manually, making sure to fix the row of the first argument.
 
 Recording a Macro To begin recording a macro, select Record Macro from the Code group of the Developer tab. Before recording begins, Excel displays the Record Macro dialog box shown in Figure 13.8.
 
 LET ME TRY IT
 
 Filling in the Record Macro Dialog To begin recording a macro and fill in the record macro dialog, follow these steps: 1. Go to Developer, Code, Record Macro. The Record Macro dialog appears.
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 Figure 13.8 Provide details for the macro you’re about to record.
 
 2. In the Macro Name field, type a name for the macro, making sure not to include any spaces. Use a meaningful name for the macro, such as FormatReport. 3. The Shortcut Key field is optional. If you type J in this field, and then press Ctrl+J, this macro runs. Note that most of the lowercase shortcuts from Ctrl+a through Ctrl+z already have a use in Excel. Rather than being limited to the unassigned Ctrl+j, you can hold down the Shift key and type Shift+A through Shift+Z in the shortcut box. This will assign the macro to Ctrl+Shift+A. 4. From the Store Macro In drop-down, choose where you want to save the macro: Personal Macro Workbook, New Workbook, This Workbook. It is recommended that you store macros related to a particular workbook in This Workbook. The Personal Macro Workbook (Personal.xlsb) is not a visible workbook; it’s created if you choose to save the recording in the Personal Macro Workbook. This workbook is used to save a macro in a workbook that will open automatically when you start Excel, thereby allowing you to use the macro. After Excel is started, the workbook is hidden. 5. Enter a description of the macro in the optional Description field. This description is added as a comment to the beginning of your macro. 6. Click OK and record your macro. When you are finished recording the macro, click the Stop Recording icon in the Developer tab.
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 Running a Macro If you assign a shortcut key to your macro, you can play the macro by pressing the key combination. Macros can also be assigned to the Ribbon, the Quick Access toolbar, forms controls, drawing objects, or you can run them from the Macros button in the Code group on the Developer tab.
 
 Running a Macro from the Ribbon You can add an icon to a new group on the Ribbon to run a macro. This is appropriate for macros stored in the Personal Macro Workbook.
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 Adding a Macro Button to the Ribbon Follow these steps to add a macro button to the Ribbon: 1. Go to File, Options, Customize Ribbon. 2. In the right list box, choose the tab name where you want to add the macro button. 3. Click the New Group button below the right list box. Excel adds a new entry called New Group (Custom) to the end of the groups in that ribbon tab. 4. To move the group to the left in the ribbon tab, click the up-arrow icon on the right side of the dialog several times. 5. To rename the group, click the Rename button. Type a new name, such as Report Macros, and click OK. 6. Open the upper-left drop-down and choose Macros from the list. Excel displays a list of available macros in the left list box. 7. Choose a macro from the left list box. 8. Click the Add button in the center of the dialog. Excel moves the macro to the right list box in the selected group. Excel uses a generic VBA icon for all macros, which you can change in step 9. 9. To rename or change the icon used for the macro: a. Select the macro in the right list box. b. Click the Rename button.
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 c. Excel displays a list of possible icons. Choose an icon or type a new name for the macro in the Display Name field, such as Format Report, as shown in Figure 13.9.
 
 Figure 13.9 Create a custom group on the ribbon to add buttons for your macros.
 
 d. Click OK to return to the Excel Options dialog. 10. Click OK to close the dialog. The new button appears on the selected Ribbon tab.
 
 Running a Macro from the Quick Access Toolbar You can add a button to the Quick Access toolbar to run your macro. If your macro is stored in the Personal Macro Workbook, you can have the button permanently displayed in the Quick Access toolbar. If the macro is stored in the current workbook, you can specify that the icon should appear only when the workbook is open.
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 Running a Macro From the Quick Access Toolbar Follow these steps to add a macro button to the Quick Access toolbar: 1. Go to File, Options, Quick Access Toolbar.
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 2. If the macro should be available only when the current workbook is open, open the upper-right drop-down and change For All Documents (Default) to For FileName.xlsm. Any icons associated with the current workbook are displayed at the end of the Quick Access toolbar. 3. Select Macros from the list in the upper-left drop-down. Excel displays a list of available macros in the left list box. 4. Choose a macro from the left list box and click the Add button in the center of the dialog to move the macro to the right list box. Excel uses a generic VBA icon for all macros, which you can change by following steps 5 and 6. 5. To rename and change the icon used for the macro: a. Select the macro in the right list box. b. Click the Modify button. c. Excel displays a list of possible icons. Choose an icon or type a new name for the macro in the Display Name field, such as Format Report, as shown in Figure 13.10. The name will appear as the ToolTip when you place your cursor over the button.
 
 Figure 13.10 Add a button to the Quick Access toolbar to run the macro saved to a specific workbook.
 
 6. Click OK to close the Modify Button dialog. 7. Click OK to close Excel options. The new button appears on the Quick Access toolbar.
 
 Running a Macro from a Form Control, Text Box, or Shape You can create a macro specific to a workbook, store the macro in the workbook, and attach it to a form control or any object on the sheet to run it. Macros can be assigned to any worksheet object such as clip art, a shape, SmartArt graphics, or a text box. To assign a macro to any object, right-click the object and select Assign Macro.
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 Running a Macro from a Button on a Sheet. Follow these steps to attach a macro to a button on a sheet: 1. In the Controls group of the Developer tab, click the Insert button to open its drop-down list. Excel offers 12 form controls and 12 ActiveX controls. 2. Click the Button (Form Control) icon in the upper-left corner in the dropdown. 3. Move your cursor over the worksheet; the cursor changes to a plus sign. 4. To draw a button, click and hold the left mouse button while drawing a box shape. Release the button when finished. 5. Choose the macro from the Assign Macro dialog and click OK. The button is created with generic text such as Button 1. To customize the text or the button’s appearance, refer to steps 6 and 7. 6. To give the button a new caption: a. Right-click over the button and select Edit Text. The cursor within the button will become visible. b. Replace the current caption with your own text. c. When finished, click anywhere outside the button 7. For further text and button formatting options, right-click over the button and select Format Control. 8. Click the button to run the macro.
 
 User-Defined Functions Excel provides many built-in formulas, but sometimes you need a custom formula not offered in the software. You can create functions in VBA that can be used just like Excel’s built-in functions, such as SUM, VLOOKUP, and MATCH, to name a few. After the user-defined function (UDF) is created, a user needs to know only the function name and its arguments. A few things to keep in mind when you create a UDF: • UDFs can only be entered into standard modules. Sheet and ThisWorkbook modules are a special type of module; if you enter the function there, Excel won’t recognize that you are creating a UDF. • A variable is a word used to hold the place of a value, similar to an argument. Variables cannot have any spaces or unusual characters, such as the back-
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 slash (\) or hyphen (-). Make sure any variables you create are unique. For example, if your function is called BMI, you cannot have a variable with the same name. • A variable type describes the variable as string, integer, long, and so on. This tells the program how to treat the variable—for example, integer and long— though both numbers have different limitations. The type also tells the program how much memory to put aside to hold the value. • A simple UDF formula is not that different from a formula you write down on a sheet of paper. For example, if asked how to calculate the final cost of a store item, you would explain that it’s the sale price *(1 + tax rate). Similarly, in a FinalCost UDF, you might enter FinalCost = SalePrice* (1+ TaxRate). • A UDF can only calculate or look up and return information. It cannot insert or delete rows or color cells. The UDF has the same limitations as built-in functions.
 
 Structure of a UDF Like a normal function, a UDF consists of the function name followed by arguments in parentheses. To help you understand this, follow these steps to build a custom function to add two values in the current workbook. It is a function called ADD that will total two numbers in different cells. The function has two arguments: Add(Number1,Number2) Number1 is the first number to add; Number2 is the second number to add. After the UDF has been created, it can be used on a worksheet.
 
 SHOW ME
 
 Media 13.4—Creating a Simple UDF Access this video file through your registered web edition at my.safaribooksonline.com/9780132182287/media.
 
 1. Open the VBE by going to Developer, Code, Visual Basic. 2. Find the current workbook in the Project Explorer window. 3. Right-click over the current workbook and select Insert, Module. A new module will be added to the Modules folder. 4. Double-click the new module to open it in the Code pane. 5. Type the following function into the module’s Code pane, as shown in Figure 13.11.
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 Figure 13.11 A UDF’s code must be entered in a standard module.
 
 Function Add(Number1 As Long, Number2 As Long) As Long Add = Number1 + Number2 End Function
 
 Let’s break this down: • Function name: ADD. • Arguments are placed in parentheses after the name of the function. This example has two arguments: Number1 and Number2. • As Long defines the variable type as a whole number between -2,147,483,648 to 2,147,483,647. Other variable types include • As Integer if you were using a whole number between -32,768 and 32,767. • As Double if you were using decimal values. • As String if you were using text. • ADD =Number1 + Number2: The result of the calculation is returned to the function, ADD Not all the variable types in the function have to be the same. You could have a string argument that returns an integer—for example, FunctionName(argument1 as String) as Long.
 
 When computers were slower and every bit of memory mattered, the difference between Integer and Long was crucial. But with today’s computers, in most cases memory doesn’t matter and Long is becoming preferred over Integer because it doesn’t limit the user as much.
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 How to Use a UDF After the function is created in the code, follow these steps to use it on a sheet: 1. Type any numbers into cells A1 and A2. 2. Select cell A3. 3. Press Shift+F3 to open the Paste Function dialog box (or from the Formulas tab, choose Insert Function). 4. Select the User Defined category. 5. Select the ADD function and click OK. 6. Place your cursor in the first argument box and select cell A1. 7. Place your cursor in the second argument box and select cell A2. 8. Click OK. The function will return the calculated value, as shown in Figure 13.12.
 
 Figure 13.12 Using your UDF on a sheet is no different from using one of Excel’s built-in functions.
 
 Sharing UDFs Where you store a UDF affects how you can share it: • Personal.xlsb—If the UDF is just for your use and won’t be used in a workbook opened on another computer, you can store the UDF in the Personal Workbook. • Workbook—If the UDF needs to be distributed to many people, you can store it in the workbook in which it is being used. • Template—If several workbooks need to be created using the UDF, and the workbooks are distributed to many people, you can store it in a template.
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 • Add-in—If the workbook is to be shared among a select group of people, you can distribute it via an add-in. For more information on add-ins, refer to the VBA book mentioned at the beginning of this chapter.
 
 Using Select Case to Replace Nested IF A really useful application of a UDF is with a Select Case statement. A Select Case statement is similar to a nested IF statement, but much easier to read. Also, since the new 64 nested IF statements allowed in 2010 are not compatible in legacy versions of Excel, using a UDF with Select Case statements ensures compatibility.
 
 For more information on nested IF statements, refer to “Nested IF Statements” in Chapter 6, “Using Functions.”
 
 The statement begins with Select Case and then the variable you want to evaluate. Next, follow the Case statements, which are the possible values of the variable, each including the action you want to take when the variable meets the Case value. You can also include a Case Else, as a catch-all for any variable that doesn’t fall within the predefined cases. The statement ends with End Select. Within the Case statements, you have the option of using comparison operators with the word Is, such as Case Is					    
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